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Preface

The Oracle Retail Price Management User Guide describes the application user interface
and how to navigate through it.

Audience

This document is intended for the users and administrators of Oracle Retail Price
Management. This may include merchandisers, buyers, and business analysts.

Related Documents

For more information, see the following documents in the Oracle Retail Price
Management Release 12.0.10 documentation set:

=  Oracle Retail Price Management Data Model

=  Oracle Retail Price Management Installation Guide
=  Oracle Retail Price Management Release Notes

= Oracle Retail Price Management Operations Guide
*  Oracle Retail Price Management Online Help

Customer Support
To contact Oracle Customer Support, access My Oracle Support at the following URL:

https:/ /metalink.oracle.com

*  When contacting Customer Support, please provide the following:

= Product version and program/module name

= Functional and technical description of the problem (include business impact)
* Detailed step-by-step instructions to re-create

= Exact error message received

= Screen shots of each step you take

Review Patch Documentation

If you are installing the application for the first time, you install either a base release (for
example, 13.0) or a later patch release (for example, 13.0.2). If you are installing a
software version other than the base release, be sure to read the documentation for each
patch release (since the base release) before you begin installation. Patch documentation
can contain critical information related to the base release and code changes that have
been made since the base release.

Oracle Retail Documentation on the Oracle Technology Network

In addition to being packaged with each product release (on the base or patch level), all
Oracle Retail documentation is available on the following Web site (with the exception of
the Data Model which is only available with the release packaged code):

http:/ /www.oracle.com/technology/documentation/oracle_retail.html

Documentation should be available on this Web site within a month after a product
release. Note that documentation is always available with the packaged code on the
release date.

Xi


https://metalink.oracle.com/
http://www.oracle.com/technology/documentation/oracle_retail.html

Conventions

Navigate: This is a navigate statement. It tells you how to get to the start of the procedure
and ends with a screen shot of the starting point and the statement “the Window Name
window opens.”

Note: This is a note. It is used to call out information that is
important, but not necessarily part of the procedure.

This is a code sample
It is used to display examples of code

A hyperlink appears like this.
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Welcome to Oracle Retail Price Management

Oracle Retail Price Management (RPM) is a strategy-based pricing solution that suggests
and assists with pricing decisions. With RPM, you can automate and streamline pricing
strategies across the organization to yield a more predictable and profitable outcome.
RPM provides decision support with pricing-focused business information to validate
and approve pricing and markdown suggestions. The results are higher margins,
increased sales, and strengthened productivity, all while remaining competitive.
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Navigate RPM

Access the Workspace

Log in to RPM

How you access Oracle Retail Price Management depends on how the application is set
up at your location. Contact your system administrator for instructions. Use the exit
procedure when you are done using the application.

Exit RPM

There are several ways that you can log out and close RPM:

= C(Click Logout in the global links area of the header.

= Select Close Window from the File menu.

= Select Exit from the File menu.

= Click the close & button on the title bar.

If any tasks are open, you are prompted to confirm your decision to log out.
View the Workspace

After logging into RPM, you have access to the application window. The primary
elements in the application window are as follows:

User Guide 3



View the Workspace
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The RPM Workspace

The workspace is comprised of all the elements within the application window. You
manage the application and perform tasks within the workspace. Many of the elements
within the workspace can be minimized, maximized, or manually resized. This allows
you to customize the workspace to fit your work habits. Any changes you make are
remembered by the application. The next time you log in, the elements appear as you last

left them.

Element

Purpose

A | Title bar

Located at the top of the window. The title bar displays the product name.
The three buttons at the far right on the title bar allow you to minimize,
restore, maximize, and close the application window.

Header

Located below the title bar. The header provides access to commands that
remain static across all tasks. The menu bar and welcome message appear
here.

Toolbar

Located below the header. The toolbar contains paging control icons.

Workspace

Located next to the task pad and below the toolbar. What appears in the
workspace depends on what you select on the task pad. The workspace is
where you complete the tasks assigned to you.

Task pad

Located on the left side of the application window. From top to bottom,
you can access an application, a task group, and then a task. When you
select a task, the contents of the task are displayed in the workspace.

Note: The Simplified RPM task pad may display a different navigational
menu.
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Resize Elements of the Workspace

Element Purpose

F Task bar Located at the bottom of the window. Task buttons, located on the task bar
allow you to switch between open tasks.

G | Status bar Located at the bottom of the window. The status bar lists the status of a
task and gives other information.

H [Pane A sub-section of a window that appears in the work space. Multiple panes
may appear in the workspace when a task is selected.

Task A pane or a group of panes that appear in the workspace, allowing you to

work.

Resize Elements of the Workspace

The benefits of resizing become apparent as you customize the workspace to fit your
work habits. You can hide or minimize elements that do not pertain to the current task.
You can show or maximize the elements that are of greater importance.

The RPM Window

You can resize the RPM window in order to increase or decrease the amount of space it
occupies on your desktop.

To manually resize the window, place the cursor over the edge of the window. When
the cursor changes to a double arrow, press and hold the left mouse button. Move the
cursor until the window is the desired size. Release the left mouse button.

Alerts

=10l 2d

Logout

(= (=] ¢l

Minimize and Maximize the RPM Window

To minimize the window, click the minimize icon (A).

To maximize the window, click the maximize icon (B).

To restore the window to its previous size, click the restore icon (C).

As an alternative method for resizing the window, right click on the RPM button
found on the Microsoft Windows task bar. On the context menu that appears, select
Restore, Minimize, or Maximize.
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Resize Elements of the Workspace

Toolbar
Although the toolbar occupies relatively little space in the window, you can choose to
hide it or show it.
- J[E
Alerts | Logout (=]
H
RPM Toolbar
= To collapse the toolbar (A), click the expand/collapse toolbar icon (B). The icon is
located on the far right side of the header.
= To expand the toolbar, click again on the same icon.
Workspace

The workspace is likely to be the most used element in the application. As such, you may
want to maximize its size. Should you need to access the task pad, restore the content
area to its original size.

= |remM

Foundation

Aggregation Level

View

RPM Workspace

= To expand the workspace (A), click the explode icon (B). The icon is located on the
upper left corner of the content area. The content area expands to the width of the
window. The task pad and the toolbar disappear.

= To restore the window to it’s original size, click again on the same icon. The task pad
and toolbar reappear.
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Resize Elements of the Workspace

Task Pad

The task pad provides access to the tasks assigned to you. Once you are working on a
task, you may want to reduce the size of the task pad. You may want to increase the size
of the task pad in order to see the full names of the task. As you increase or decrease the
width of the task pad, the width of the workspace is resized proportionally.

Note: The Simplified RPM task pad may display a different
navigational menu.

L3R

Alzin Frecon Alerts | Logout @

s |
= |RPM E
Foundation
Link Codes
Zone Structure
Price Guides
Price Changes
tlearances
Promotion Events
Promotions
Promotion Threshold
Promotion Constraints ;|

¥endor Funding Defaults
tonflict Check Results

View Tasks

Price Inquiry

(= System Options.

+ System Dptions Edit

- System Options View
- System Defaults Edit
. System Defaults View

= i

Simplified RPM Task Pad
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Resize Elements of the Workspace

= To maximize the task pad, click the right arrow on the separator bar (A). To
minimize the task pad, click the left arrow.

Tasks

= |rRemM [~
Systenn Optons

Foundation

Aggregation Lewel
fone Stucture

Price Guides

Calendar
Candidate Rules

Price Changes

Clearances

Promotion Events

Promotions

Promotion Threshold

Promotion Constraints A
Vendor Funding Defaults .l"\\\\
Pricing Strategy J
Worksheet

Link Codes

Market Basket Codes

T

(:J System Optons

+ System Dptions Edit

+ System Dpbons Wiew
» System Defaults Edit

+ System Defaults View

oo

RPM Task Pad

Note that the width of the task pad can be:

* Maximized to the width of the application window
* Minimized so that it is no longer visible

= Restored to its previous size

To manually resize the width of the task pad or the length of the work areas within the
task pad, place the cursor over the desired resizer (B). When the cursor changes to a
left/right (or an up/down) arrow, press and hold the left mouse button. Drag the resizer
until the task pad or work area is the desired size. Release the mouse button.
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Resize Elements of the Workspace

Pane

One or more panes appear in the workspace when you select a task on the task pad. You
can collapse a pane so that it does not distract you from the panes you want to work in.
Only the title bar of the container is displayed after you collapse it. When you are ready
to work in the collapsed container, you can then return it to its regular size.

5 Create Price Change

P -
{ O..EE_‘:E Change List A |
——
Price Change B " &
10 Link Code Ttem Item Descript Ttem Level Diff ID Diff ID Descr| Location Location Des¢ Location Typd

Filkay by lEI | Filkay by.'lzl | Filkey by:lzl | Filkey by:lzl | Fitkay by lEI | Filkay by.'lzl | Filkey by:lzl | Filkey by:lzl | Fitkay by lEI | Filkay by.'lzl

4] | »
= = |
| l/ Mew |
I@,Price Change Maintenance A |
RPM Pane

To collapse a pane (A), click the collapse icon (B).
To expand a pane, click the expand icon (C).
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Look up Field Level Data

Look up Field Level Data

The basic method for entering data in a text field is to type the text in the field. Some
fields are restricted, however, as to the type of data that may be entered. The options for
entering or selecting data depend on the type of data that may be required or permitted
in the field. For example, some fields permit only numeric data, while others permit only
alphabetic or alphanumeric data. Some fields require a date to be entered in a specific
format. Some fields permit only one value, while others permit multiple values.

Calendars, drop-down lists, lists of values, and transfer boxes provide you with access to
preformatted, predefined values. Instructions for using these tools are provided below.

Drop-Down List

Some fields are restricted to a predefined list of values. You access a drop-down list from
which you can pick the desired value.

Itern Level gleRIONS

Tran Level

Farent Level
Ciffl Level
Diffz Level
Ciffz Level
Wrar by - b EDiH"% Level

Ciff Type Level
I

ce Change Indic{ Conf

Drop-Down List
1. Click on the drop-down arrow (A) next to a field. A list of predefined values appears.

2. Scroll through the list until the desired value appears. Select the value. The field is
automatically filled in with the selected value.
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Look up Field Level Data

List of Values

When a drop-down list has many values, you can typically access them from the list of
values (LOV) button.

%S Create Price Guide

I/C-—_) Price Guide Create

* Name
&3 Dezcription
Cepartrment

& Currency

Price Guide Type |Corp0rate

=
|

B+
A
UsD H [Us pollar

List of Values

I ||
Code Description I
| Fitker by: B Flibar by hd
ADP Andarran Peseta E
AED UAE Crirham
AFa Afghani -
ALL Lzk
AMD Arrnenian Dram
AMG Metherlands Antillian Guilder
A Kwanza
ARE Argentine Pesa
ATS Schilling
AUD Australian Dollar
ANG Aruban Guilder
AZM Azerbaijanian Manat
BAM Cuonvertible Marks
BRL Barbadas Dollar
BLT Taka
BEF Belgian Franc
BiGL Lew
B Bulgarian Law
BHD Bahraini Dinar -
F C D 1-183 of 183
| Cancel || Select |:
TR
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Look up Field Level Data

1. Click the LOV & button next to a text field (A). The list of values opens. The number
of values in the list and the total number of values appears at the bottom (D) of the
LOV.

=  Click the page icon (C) to open the Paging Configuration window and adjust the
page size and page links.

Paging Configuration §|
“izible Page Links

Paging Configuration Window

2. To find a value, use one or a combination of the following methods:
= Scroll through the list.

* Enter a partial value in the Filter by text box (B) and press Enter. Select the
desired value from the results.

=  Select the down arrow next to the Filter by text box (B) and use the Advanced
Filter option. Enter conditions in the Advanced Filter and click OK.

=  Enter the wildcard (%) and letters before or after it in the Filter by text box (B) to
limit values.

3. Select the value and click Select. The field is automatically filled in with the selected
value.
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Look up Field Level Data

Multi-Select List of Values

Some lists of value allow you to select more than one value. Multi-select LOV &+ button
allows a user to select multiple rows in a single block by using the Shift and Control keys.
The functionality is similar to the select functionality of other Windows applications.

I &%

1D Description

Fitkay by EI | Filkar by IEI

f f 4]
ice ige

SIMREG1 Externally generated Price Change

test test .
AREADIFFAA Area Diff Aute Approve Price Change

Joes Code Joes Drescription

RegCodeMaw newbesc =
“F 1-16 of 16

il [l
I |

1D Descripton

Fitkay by IEI | Fitkay by EI

Cancel | | Select

Multi-Select List of Values

Open the Multi-Select LOV

Click the LOV E button next to a text field, or click the down arrow. The list of values
opens.

Select Continuous Information
1. Select a row.

2. Press Shift and click on another row to select all the rows in between, inclusively.

Select Non-Continuous Information
1. Select a row.

2. Control click on rows to select or clear the individual rows clicked on (depending on

whether they are currently selected) while leaving the other selected rows still
selected.

Add the Values

1. Click the down arrow to add the value to the selected area.

2. Click the up arrow to remove a value from the selected area.
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Search For and Filter Records

Search For and Filter Records

You search for records when none are displayed. By entering search criteria, you indicate
which records must be displayed for your use. Filtering, on the other hand, allows you to
reduce the number of records (or values) displayed. Again, you enter criteria indicating
which of the currently displayed records must remain visible. The unwanted records are
hidden from view. In either case, you are restricting the number of records (or values)
displayed to a more manageable and useful number.

Filter Records in a Table
Column-level filtering is available in tables that have drop-down lists.
= To use a simple filter:

a. Enter a partial string in the active cell. For example: Enter D or d to retrieve all
records that begin with D, such as Department.

Merchandise Level | Merchandise ID

Departrnant Bl d (RS- *

Clear Filker E
| clear all Filters
| Advarnced Filter...

A

Departrnent

Cepartrment -

Simple Filter
b. Press Enter. The records that match the filter criterion are displayed in the table.

c. To show all records again, click on the down arrow in the active cell and select
Clear Filter.

=  To use the advanced filter tool:

a. Click the down arrow in the active cell and select Advanced Filter. The
Advanced Filter window opens.

Advanced Filter f'5_<|

Show rows where

Merchandise Level |is equal to

[~]
| [l
[=]

|(nnnej

| Cancel || (1] 4 |

Advanced Filter

b. Select a relational operator in the first list box. Then select a value in the second
list box.
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Search For and Filter Records

c. If another condition is necessary, select a logical operator (And or Or). Then
select the second relational operator and value.

d. Click OK. The records that match the conditions are displayed in the table.

To show all records again, click on the down arrow in the active cell and select
Clear Filter.

= To reuse a filter:
a. Click the down arrow in the active cell.
b. Scroll through the list of recent filters; then select the desired filter.

c. To show all records again, click on the down arrow in the active cell and select
Clear Filter.
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System Options

The system options workspace allows you to configure RPM to maximize the system for
your company. System options allow you to customize various parameters, defaults, and
constants that are used throughout the system. Normally, these elements are set when
RPM is installed by the system or database administrator. They tend to remain fixed
unless a business practice is changed which necessitates a change in RPM. System
options are the values used in your system that define the overall configuration of the
system.

System Defaults

The System Defaults Edit workspace allows you to configure RPM to maximize the
system for your company. Select the values that should be should be initially displayed
when a user enters the workspace. This helps the user save time as they do not have to
select the appropriate value each time they complete a task. The values entered will
appear in other areas of the application.

Aggregation Levels

The Aggregation Level Settings workspace allows you to define system parameters that
vary for price strategies and price worksheet. When a department is created in the
merchandising system, Oracle Retail Price Management assigns the default value for
each parameter to the default or default level defined in the system. You may choose to
define the aggregation level at a different parameter than the default. When a price
strategy exists for a department, parameters are disabled and cannot be changed.

System Options Definitions

System Option Definition

Sales Calculation Method The method used by the merchandise extract program to
populate the Projected Sales column in the worksheet.

Multiple Item /Loc Promotions When selected, an item/location can exist on more than
one promotion (and more than one component within
the promotion).

Update Item Attributes When selected, the merchandise extract program should
update certain item attributes during each extract that
occurs during a worksheet review period.

Price Change/Promotion Overlaps When selected, indicates an item/location can have a
price change occur during the middle of an active
promotion.

Cost Calculation Method The way cost is determined for the zone. Choose

Highest Location Cost or Average Location Cost.

Clearance/Promotion Overlaps When selected, indicates an item/location can be on
clearance and promotion at the same time.
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System Options Definitions

System Option

Definition

Recognize WHs as Locations

When selected, indicates warehouses can be assigned to
regular and clearance price zones. They cannot be
assigned to promotion price zones.

Allow Complex Promotions

When selected, indicates all promotion types are
available.

Open Zone Use

When selected, indicates a zone can be used across
different types of pricing, regardless of zone type.

Exact Deal /Funded Promotion Dates

When selected, indicates that the dates of a deal
associated with a vendor funded promotion must match
the promotion component dates exactly. When selected,
only deals with the same begin and end dates as the
promotion component being created will appear in the
deal

Purge Reset Clearance Months

The number of months RPM will retain clearance price
events that have reset before purging them.

Default Out of Stock Days

The number of days that should be added to an items
clearance effective date in order to calculate the Out of
Stock date. The default is applied to generate the out of
stock date when the clearance is first created.

# of Days Reject Held The number of days after the effective date of a rejected
price change or clearance that it is purged from the
system.

Default Reset Date When selected, indicates a reset date should be

defaulted when a clearance is created. The reset date is
defaulted to one day greater than the out of stock date.

Promotion # Days Rejects Held

The number of days, set in system options, after the end
date (or start date for promotions with no end date) of a
rejected promotion that it is purged from the system.

Price Change Processing Days

The number of days, set in system options, between the
creation date of a price change and the first date it can
become effective. It allows the retailer to insure that
price changes are created with enough advance timing
that stores and other process areas can react.

Promotion History Months

The number of months, set in system options, after a
promotion is completed that is purged. This parameter
is also used to purge cancelled promotions.

Ends in Digits for Zero Decimal

The number of digit fields, set in system options, that are

Currencies available in the Ends In definition area. This field is used
for currencies that do not contain a place after the
decimal point. For currencies that contain places after
the decimal point, the digit fields that are available.

Event ID Required When selected, a promotion event must be assigned to

the promotion.

External Prices Allowed

When selected, RPM will accept pricing events created
in other systems.
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System Options Definitions

System Option

Definition

Zone/Parent Ranging

When selected, RPM should perform ranging checks for
price changes, promotions, and clearances that are
created at a higher level than transaction/location. If the
indicator is set to yes, the system will not let you create a
price change at the parent or zone level if none of the
transaction item /location combinations are ranged. If
the indicator is set to no, the system will let you create a
price change at the parent or zone level even if none of
the transaction item/location combinations are ranged.

Apply Promo Change Type 1st

Allows you to indicate, in system options, which type of
promotion change type should be applied first.

Location Move Lead Time

The number of days, set in system options, required
before a location can be moved between zones in RPM.

Location Move Purge Days

The number of days RPM will retain location moves that
have either successfully completed or are the same
number of days past the scheduled effective date but
have had no action taken on them.

Dynamic Area Differentials

When selected, allows the worksheet to dynamically
update secondary locations based on changes to the
primary location.

Allow Buy Get Cycles

When Selected allows Buy Get Promotions to contain
multiple identical items to be in the buy and get lists. It
also allows items to be on the buy list of one promotion
and the get list of another. The Point Of Sale system
used must be able to manage cycles for this option to
work as intended.

Display Promotion Header Markup %

When selected, the total markup percentage for the
promotion will appear on the promotion header.

Background Conflict Check

When selected, conflict checking of worksheets, price
changes, promotions, and clearances occur in the
background, or when the system is idle.

Display Full Promotion Column Detail

When selected, only a portion of the columns in the table
are populated. If the user wants to review the details for
the remaining columns, the user can do so by selecting
rows and requesting the additional data.

Display Full Price Change/Clearance
Column Detail

When selected, only a portion of the columns in the table
are populated. If the user wants to review the details for
the remaining columns, the user can do so by selecting
row(s) and requesting the additional data.

Future Retail Seed Days Before VDate

The number of days, set in system options, required for
a newly ranged item/location that is inheriting an active
promotion.

Filter Price Change/Clearance Results

Defines weather the Markup columns appear on Price
Change and Clearance windows. Having the system
calculate and display this field may slow performance.
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System Option

Definition

Display Conflicts Only

When selected, only conflicts appear on the conflict
review screen. If cleared # Days event displayed before
VDate (effective date) and # Days event displayed after
VDate must be specified.

# Days event displayed before VDate

The number of days before an effective date (VDate) that
a pricing event appears in the conflict review window.

# Days event displayed after VDate

The number of days after an effective date (VDate) that a
pricing event appears in the conflict review window.

Maximum Search Results

Limits the number of search rows returned:
=  Price Change record search max

= (Clearance record search max

=  Promotions record search max

If the number of rows for the search criteria exceeds the
value entered in the new option(s), RPM returns records
only up to that established value.

Edit System Options

Navigate: From Task Pad, select System Options > System Options Edit. The workspace

opens.

1. Update any enabled fields as necessary.

2. Click Save to commit any changes and close the workspace.

20 Oracle Retail Price Management




View System Options

View System Options

Navigate: From Tasks, select System Options > System Options View. The System

Options View workspace opens.

(il
@ Optons
* Sales Calculation Methad |Srnoothed Auerage Sales|z|
" bbapl Remllee Premaiens
" Updefio B fslouies
* price Change/Promaotion Ouwerlaps
|Auerage Location Cost E

System Options View Workspace
Click Close to exit the workspace.

e

User Guide 21



System Defaults

System Defaults

System Defaults Definitions

System Default

Definition

Options

Item Level The level of an item in an item group. *= Parent Item
=  Parent Item/Diff
*  Transaction Level Item
Pricing Strategy The pricing strategy is the default =  Area Differential
strategy type displayed for the user »  Clearance
when entering the Pricing Strategy .
*  Competitive
workspace.
* Margin
*  Maintain Margin
Diff Type The category that a diff belongs. Valid diff types from the Merchandising
System.
Type The type is the default price change type | =  Change by Amount
displayed when creating a price change. | . Change by Percent
=  Fixed Price
Currency The primary currency used in RPM. See LOV & button on System Default

screen for code and description.

Maintain Margin Strategy
Method

Defines the default method used when
creating a maintain margin pricing
strategy.

*  Market Basket Margin

= Current Margin

Default Price
Change/Clearance List
View

Defines weather the Markup columns
appear on Price Change and Clearance
windows. Having the system calculate
and display this field may slow
performance.

=  Standard Column View

*  Markup Column View

Ignore Constraint Handling

Defines whether or not promotion
constraints will be taken into account
when conflict checking is performed in
the worksheet.

Select/Clear checkbox
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Edit System Defaults

Navigate: From Task Pad, select System Options > System Defaults Edit. The System
Defaults Edit workspace opens.

%5 System Defaults Edit

I'/(_J Defaults
¥ Itern Level |— Select -
* Pricing Strategy |C|earance
Diff Type |C0|0r
* Type |Change By Armount
Maintain Margin Strategy Method |— Selact -

Default Price Change/Clearance List View |Standard Calurnn View

Ignore Constraints

b} 4

Cancel Saue

System Defaults Edit Workspace
1. Update enabled fields as necessary.
2. Click Save to commit any changes and close the workspace.

View System Defaults

Navigate: From Task Pad, select System Options > System Defaults View. The System
Defaults View workspace opens.

75 System Defaults Yiew
I/CJ Defaults
4 | »

System Defaults View Workspace
Click Close to exit the workspace.
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Aggregation Levels

Maintain Aggregation Level Settings

Navigate: From the Task Pad, select Aggregation Level > Maintain Aggregation Levels.
The Aggregation Level Settings workspace opens.

%3 aggregation Level Settings

I"(—T Aggregation Level Settings |

1111| *Grocery Mon ... | Bepartment Department

Current-Hew

2222| *peli Department Department

Current-Hew

&000| ¥*Health&Reauty | Department Department

Currant-Hew

6100| General Merch.., | Department Department

(4
1 Department Nanj Lovrest Definablj Worksheet Leve| Historical Sales | Regular Clearance Promotion Include WH Invel Include On orde: Pri(:ChingEAn4
22| DW working dept| Departmeant Departmeant Week Current-Hew Z
TT77| Retail Dept Departmant Departmant Week O O O | O Current-Hew
TT7E| Cost Dept Departmant Departmant Wezk O O O O O Current-Hew
3457|jap dept Subclass Subclass Weak O O O O O Current-MHew
20| Merch Extract .| Department Department Week O O O O O Current-Hew
1234 Glassware Subclass Department O O O O O Current-Hew
T000| DOC Test Dept | Department Department O O O O O Currant-Hew
7001| DOC Test Dep...| Class Class O O O O O Current-Hew
13| SLH Test Dep... | Department Departmeant O | | O O Current-Hew
5004 *Women Appa... | Department Departmant O O O O O Current-Hew
1104| *Test Depart.. | Department Departmant | | O | | Current-Hew
1704| *Candidate Ru...| Department Departmeant O O O O O Current-Mew  |—1
2000 djm_dept1 Department Department O O O O O Current-Mew
TTT| *Dairy Department Department O O O O O Current-Mew
| | | | |
m| | | | m|
| | | | |
| 0 | | |

Current-Hew [

Cancel Done

Aggregation Level Settings workspace

1. Select the record you want to update.

2. Click in the field that you want to change.

Lowest Definable Level: Select the lowest level of the merchandise hierarchy for
which a price strategy can be defined.

Worksheet Level: Select the level of the merchandise hierarchy at which
worksheets will be generated.

Historical Sales: Select the sales period RPM should represent as historical on
the worksheet.

Regular: Select the check box to indicate that regular sales should be included as
part of historical sales in the price worksheet.

Clearance: Select the check box to indicate that clearance sales should be
included as part of historical sales in on the price worksheet.

Promotion: Select the check box to indicate that promotional sales should be
included as part of historical sales in on the price worksheet.

Include WH Inventory: Select the check box to indicate that warehouse
inventory should be included in the calculations for sell through and price
change impact in the price worksheet.

Include On Order In Sell Thru: Select the check box to indicate that inventory
ordered is included in the sell through calculations on the price worksheet.

Price Change Amount Calc: Select the method of calculating the price change
amount on the price worksheet.

— New-Current: The current price is subtracted from the new price.

— Current-New: The new price is subtracted from the current price
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= Past Retail Change Highlight Days: Enter the number of days previous retail
changes will cause the Last Price Change column of the pricing worksheet to be
highlighted.

= Past Cost Change Highlight Days: Enter the number of days previous cost
changes will cause the Last Cost Change column on the pricing worksheet.

= Pending Cost Change Window Days: Enter the number of days into the future
the system should look for pending cost changes.

= Pending Cost Change Highlight Days: Enter the number of days into the near
future the system should look for pending cost changes. The Pending Cost
Change column on the worksheet will be highlighted if a cost change falls within
the Pending Cost Change Highlight Days.

Note: Pending Cost Change Highlight Days must be less
than or equal to Pending Cost Change Window Days.

Click Done to save any changes and close the workspace.
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Retrieve an Item Price

Pricing

Use the Price Inquiry workspace to look up the price of an item for a selected date and
location. The following information appears in the Price Inquiry Results table:

Column Description

Item ID/Description The transaction or parent level items found based on the
selected criteria.

Diff ID The differentiators for the parent item if Parent Item/Diff
type is selected.

Location/Description The selected locations, zones, or zone groups depending on

selected criteria.

Primary Zone

Selected if the zone is within the primary zone group.

Date The selected date. The date the item/location price is valid
far.

Regular Retail The regular price of the item/location for the specified date.

Regular Retail UOM The unit of measure of the regular item/location.

Regular Multi-Units

The regular multi-units of the item/location.

Regular Multi-Units Retail

The regular multi-unit price of the item/location.

Regular Multi-Units Retail UOM

The unit of measure of the regular item/location multi-unit.

Clearance Retail

The clearance price of the item/location for the specified
date.

Clearance Retail UOM

The unit of measure of the clearance item/location.

Promotional Retail

The promotional price of the item/location for the specified
date.

Promotional Retail UOM

The unit of measure of the promotional item/location.

Complex Promotion

Selected if the item/location is included on a complex
promotion.
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Retrieve an Item Price

Regular retail and multi-unit prices are calculated as follows:

Location
hierarchy

Transaction Level ltem

Parent Item

Parent Item/Diff

Location

Transaction level price at
the location.

Average of prices for all
transaction level items
under parent at the
location.

Average of prices for all
transaction level items
under parent/diff at the
location.

Zone

Average of transaction
level prices for all
locations in the zone.

Average of prices for all
transaction level items
under parent at all the
locations in the zone.

Average of prices for all
transaction level item
sunder parent/diff at the
locations in the zone.

Primary Zone

Primary zone price.

Average of prices for all
transaction level items
under parent in the
primary zone.

Average of prices for all
transaction level items
under parent/diff in the
primary zone.

Note: "Price" refers to Regular Retail or Regular Multi-Units Retail.

Clearance and promotion prices are calculated as follows:

Location
hierarchy

Transaction Level Item

Parent Item

Parent Item/Diff

Location

Transaction level price at
the location.

Average of prices for all
transaction level items
under parent at the
location.

Average of prices for all
transaction level items
under parent/diff at the
location.

Zone

Average of transaction
level prices for all
locations in the zone.

Average of prices for all
transaction level items
under parent at all the
locations in the zone.

Average of prices for all
transaction level item
sunder parent/diff at the
locations in the zone.

Note: "Price" refers to Clearance Retail or Promotional Retail.
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Retrieve an Item Price

Retrieve an Item Price

Navigate: From Task Pad, select Price Inquiry > Retrieve Item Price. The Price Inquiry

workspace opens.

E—j Price Inquiry

I/CJ Price Inquiry | :I
Filter
| |
Ttern Level 'Transaction Level Tterm lEI
8
Clear | | Fetrieve Price |
Price Inquiry Results " @;
Item ID Ttem Descripf Diff ID Location Location Desq Primary Zone| Date Regular Retai| Regular WOM | Regular Multi
| Filker by.‘lzl | Filtar by.‘lzl | Filker by.‘lzl | Filtar by.‘lzl | Filker by.‘lzl | Filter by.‘lzl | Filker by.‘lzl | Filter by.‘lzl | Filker by.‘lzl | Filtar by.‘lzl
-

Price Inquiry workspace

Note: RPM supports International Organization for
Standardization (ISO) currency code only.

1. Enter criteria as necessary to restrict the search to the price changes you want to

maintain.

Field Criteria

= (lass

= Department

=  Subclass

= Item Type
= Item Level
= Diff Type
= Jtem

= Diff

Merchandise | Select criteria in the following fields to search for prices in a specific
Level merchandise level:
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Field Criteria

Zone/Location | Select Zone Groups, Zones, and Locations to search for prices from specific
zones or locations.

Date Select the date you need to retrieve a price for.

2. Click Retrieve Price. Your results appear in the Price Inquiry Results table.

Price Inquiry Results " &
Item ID Diff 1D Location Location Desd Primary Zone| Date Regular Retail Regular WOM | Regular Multi| Regular Mu

| Filter by E | Filker by:E | Filker by:E | Fitker by:E | Fitker by:E | Fitker by:E | Filtar by:E | Filtar by:E | Filter by E | Filker by:l:
2444 g Z1 D 08/10/2005 $200.00| EA z
100256126 =l Z1 D 08/10/2005 $6.88| EA

1001324196 =l Z1 D 08/10/2005 $220.00% EA

100134145 =l Z1 D 08/10/2005 f10z.20% EA

100256142 2 21 D 0g/10/2005 $5.25| EA

100134161 g Z1 D 081 0/2003 $200.00| EA

1001324170 =l Z1 D 08/10/2005 $200.00| EA

100256011 =l Z1 D 08/10/2005 $6.88| EA

10013241532 g Z1 D 08/10/2005 $200.00| EA

1001241828 =l Z1 D 08/10/2005 $200.00| EA _
1001324209 =l Z1 D 08/10/2005 $248.00% EA

1001324137 =l Z1 D 08/10/2005 +200.00| EA

100256089 g 21 D 081 0/2005 $5.85 EA

100134250 2 Z1 D 081 0/2005 $1,000.00| EA

100236020 g 21 D 08/10/20035 $6.28 EA

100134233 g Z1 D 08/10/2005 $192.80% EA

100134129 g Z1 D 08/10/2005 $200.00| EA

100256193 =l Z1 D 08/10/2005 $6.88| EA

100256062 =l Z1 D 08/10/2005 $6.88| EA -
< | IED

Price Inquiry Results table

Export Price Inquiry Results

1. Select the row you want to export by clicking the box j to the left of the row. Press
and hold the Ctrl key while selecting to select multiple rows.

2. Click the Export [®] button. The Save window opens.
Save r?|

Save In: |D Termnp Izl EE

3 wards.0 (1 {cAS22E73-1BB7-11D8-9D6A-00010240CEIS)

D {DD?SlbD6-803d-lld4-9790-00:04f82eb39} % ItermPricell
D {46891FF9-F43A-4AE6-BSF2-5C3FD4CC4BSl}
D JE8249BEE-BF14-1107-28E8-00500A21757E}
D {F148F0AS-6813-1106-AFFRE-00R0ODO1420300
D {aSbal4en-7384-11d4-bae?-00409631a2c8}
D {a8833100-1481-11d4-9731-00:04f82eb39}
D {abda9912-5d0D-lld4-bae?-936?ca09?955}
4 [»

Files of Type: [* czv E

Save Cancel

File Marne:

Save window
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o o Mo

Select a location to save the file to from the Save In drop-down.
Enter a name for the file in the File Name field.
Click Save. The file is saved.

Open the file in the program of your choice such as a spreadsheet or word processor.
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Price Guides

A price guide allows you to create a uniform price strategy. You can use them to
maintain consistent price points. You can determine if the prices in a guide should be
rounded in the same manner or if they should all end in the same digits.

Price guides can be set up at the corporate level or at the department level. A corporate
level price guide is created and maintained at the corporate level, but can be referenced
by many departments. If any changes are made to a corporate price guide, all
departments that are linked to the corporate guide will reflect the updated changes. A
department-level price guide is created and maintained at the department level.

After price guides are defined, they can be used when setting up pricing strategies, price
changes, clearances, and promotions. Price guides are also used when creating the
primary zone group for a merchandise level. When a price guide is attached to a primary
zone group definition, it will be applied to the initial prices proposed by RPM during the
initial price setting process in RMS (if the proposed price falls within one of the defined
intervals on the guide).

Create a Price Guide

Navigate: From the Task Pad, select Price Guides > Create Price Guide. The Create Price
Guide workspace opens.

%3 create Price Guide

I'(J Price Guide Create

Price Guide Type [corporate =l

* Curvenc, v Juso & us pallar

Add Details |

cancel_|[_save tRepeat ][ _Done

Create Price Guide Workspace

In the Price Guide Type field, select the type of price guide you are creating.
In the Name field, enter the name of the price guide.
In the Description field, enter a description of the price guide.

In the Department field, enter the ID of the department, or click the LOV & button
and select a department.

o Dbd =

Note: This field is available only if you selected Department
in the Price Guide Type field.

In the Currency field, select the currency for the price guide.
Click Add Details. The Price Guide Details Create pane opens.
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I(: Price Guide Details Create

[E4

From

To

New Retail

5.00|

5.45)

5.00( &

5,50

5.9

5.50f

£.00|

£.43)

£.00]

£,50]

6,99

50|

7.00|

749

7.00|

7.50|

7.99|

7.50]

200

2.45)

2.00|

250

2,50

8,99

2,95

2,50

2,50

10,00

10,43

10,00|

10,50/

10,99

10,50 ¥|

From: I:l To: I:l

New Retail: I:l

Add

[ ] pelete mtervals | [ [ validate mtersals |

Price Guide Details Create Pane

Add Price Intervals Individually

1.
2.

Start Price:

End Prics:

Al

Autofill

Mew Retail Ends In: [ |[ ]

In the From field, enter the low price of the interval.

In the To field, enter the high price of the interval.

Note: The value in the From field must be lower than the
value in the To field.

3. Inthe New Retail field, enter the price that all values in the interval adjust to.
4. Click Add. The information is added to the table.

Add Multiple Price Intervals

1. In the Start Price field, enter the low price of the block of intervals.

2. Inthe End Price field, enter the high price of the block of intervals.

3. In the Increment field, enter the amount each interval should increase by.
4

In the New Retail Based On field, select how the new retail price should be
determined:

*  From Price: The new price will be set to the same value as the value in the From
column on the list of intervals.

= To Price: The new price will be set to the same value as the value in the To
column on the list of intervals.

= Average Price: The new retail will be set to the average value of values in the
From and To columns on the list of intervals.

5. Click Autofill. The information is added to the table.

Note: If the End Price is not divisible by the value in the
Increment field, RPM will suggest the last valid price in the
range. Click Yes to accept the price and continue, or No to
cancel the process.

User Guide 33



Price Guides

Define Ends in Values
1. Select the intervals you want to add an ends in value.
2. Inthe New Retail Ends In field, enter the digits the price ends in.

Note: The number of fields available are determined at
system set up. If your currency uses decimals the number of
fields corresponds to the number of decimals used in the
currency. If you currency does not use decimals, the number
of digits is determined at system set up.

3. Click Apply. The New Retail field on the selected intervals in the table is updated
with the Ends In Digits specified by the user.

Complete the Price Guide
Click Done to save any changes and close the workspace.

Copy a Price Guide

Navigate: From the Task Pad, select Price Guides > Copy Price Guide. The Copy Price
Guide workspace opens.

%3 Copy Price Guide

/(=) Pricing Guides Origin
(€

(@ Corporate Pricing Guides

() Department Pricing Guides B

I-"(-" Pricing Guides Destination

(@) Carporate Pricing Guides

() Department Pricing Guides B

I(: Create Copy Price Guide |

Guides (-4
Guide Type ‘ Name Description | Dept. | Currency Linked ‘

Filter by ] [ tcer by =]

Corparate

Jodi's Znd copy Jodi's 2nd copy usp

HL-corporate HL-corparate uso

fan foo uso

SLH quide test quide uso

DW Corp Guide Prices so low we call it crazy .. usp

in's corporate i usD

alofalole
TIT(EIE(E|E

4 |

cancel || Save + Repeat || Deone |

Copy Price Guide Workspace
1. In the Price Guides Origin pane, select the price guide type of the price guide you are
copying.
= If you select Department Pricing Guides, enter the department ID in the field to
the right, or click the LOV &l button and select a department.

Note: Price guides that match the criteria entered appear in
the Create Copy Price Guide container.

2. In the Price Guides Destination pane, select the price guide type of the price guide
you are creating.

= If you select Department Pricing Guides, enter the department ID in the field to
the right, or click the LOV &l button and select a department.

3. In the Create Copy Price Guide container, select the price guide you want to copy.
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4. Click Copy. The Pricing Guide Copy Details pane opens.

I@ Pricing Guide Copy Details

* Hame | |
¥ Dascripti | |
prion @
*
Currency uso % us Dollar
I —
-
From To New Retail
1.00 5.00 4.99 L l:l

* New Retail Basad On: n
__AutoFill

Frar: | | Tao: | | Mew Retail: I:l Add Mew Retail Ends In:
I
.

Pricing Guide Copy Details Pane

Walidate Intervals

5. Maintain the price guide as necessary.

6. Click Done to save any changes and close the workspace.

Link a Price Guide

Navigate: From the Task Pad, select Price Guides > Link Price Guide. The Link Price
Guide workspace opens.

%3 Link Price Guide

@ Department To Link |

Departrnent 7000 B +poc Test Dept

@ Price Guides List |

Guides e
Name Description Cunrency Linked

Jodi's 2nd copy Jodi's 2nd copy UsD x|
HL-corporate HL-corporate UsD g

foo foo uso

SLH guide test guide usD

corin's corporate hi UsD @

Jodi's Corp Price G.., | Jodi's Corparate Pr.| USD | g

cancel || Save + Repest || Dore |

Link Price Guide Workspace
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1. In the Department field, enter the ID of the department you want to link to a
corporate price guide.

2. In the Price Guides List container, select the corporate price guide you want to link

to.

3. Click Link. A red X appears in the Linked column, indicating the corporate price
guide has been linked.

4. Click Done to save any changes close the workspace.

Maintain a Price Guide

Navigate: From the Task Pad select, Price Guides > Maintain Price Guide. The Price
Guides Maintenance workspace opens.

%3 Price Guides Maintenance

(@ pricing Guides List

Guides

I,

Guide Type | Name Description Dept. ‘ Currency Linkad |
Fiiker by: =l Filter By =l |
Department Corin's Rockin PG Sweetness 2001 - *Meat uso 3
Departmant Huh? What? 1704 - *Candidate Rules Dep | USD
Department. PG for PC & Clear Testing PG for PC 2 Clear Testing 1704 - *Candidate Rules Dep | USD
Department PG Diff cur (AUD) AUD 1704 - *Candidate Rules Dep | ALD
Corporate Jodi's 2nd copy Jodi's Znd copy UsD 7]

X -

o] |

cancel |[_save +Repeat |[_pone |

Price Guides Maintenance Workspace

1. Select the price guide you want to edit.

Note: Linked department price guides cannot be

edited. They can only be viewed. The details of a linked
department price guide are owned at the corporate level, so
changes must be made to the corporate price guide.

2. Click Edit. The Price Guide Maintenance Details pane opens.
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(@ Price Guide Maintenance Details

* Hame

¥ Description

[12 nam

[stest 1e daseription sa

To

New Retail

100,00

100,00}

105,00

105.00f

110,00

110,00}

115,00

125,00

115.00f

125.00f

120,00

130,00

135,00

135.00f

140,00

140,00f

145,00

145.00f

Fram: l:l Ta:
‘ [ oslete ntarals | [E validsts rtervals ‘

Price Guide Maintenance Details Pane

Edit the enabled fields as necessary.

Update the intervals as necessary.

* Add price intervals individually.

* Add multiple price intervals.

= Define the ends in price.

To delete an interval:

Start Price:
End Price:

Increment:

New Retail Based On: [ salect-  |7]
Autafill

Il

Hew Retsil: l:l Hew Retail Ends In: l:”:l

a. Select the intervals you want to delete.

b. Click Delete Intervals. The intervals are removed from the table.
To verify the intervals are sequential:

a. Click Verify Intervals. If non-sequential intervals exist, an error message
appears.

Click OK. The non-sequential values are highlighted in red.

Correct the intervals as necessary.

Add price intervals individually.

Delete an interval.

Click Done to save any changes and close the workspace.

User Guide 37



Candidate Rules

Candidate Rules

The pricing office of your organization determines the optimum strategies for using RPM
in your business. After these strategies are decided, you can define the candidate rules
and set up the following parameters:

=  Candidate rules
= Variables for candidate rules

You use candidate rules to search the database for items that need to be highlighted for
pricing review. Candidate rules determine which item/locations will have retail prices
proposed in clearance worksheets. In other types of worksheets they provide a way to
identify and track specific items during the worksheet review process.

Candidate rules are defined at the corporate level. You can modify any of the candidate
rule parameters. Some rules have variable values. These values are assigned and can be
modified at the department level.

Note: Rules that have variables defined are run only against
items in Departments where a value has been assigned to the
variable. If there is no variable value for a Department, the
candidate rule will not run against items from that
Department.

There are two types of candidate rules: Inclusion and Exclusion. Exclusion rules are
always run first and identify items that will not be included in the worksheet review.
Inclusion rules can contain a variable for Department level differences in the value to be
searched against. Items that meet an inclusion candidate rule are flagged on the
worksheet. Items that meet an exclusion candidate rule do not appear on the worksheet.

Note: Candidate rules are run against the worksheet when it
is first created. They are not run again if the worksheet is
updated.
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Set up a Candidate Rule and Define a Variable for the Rule
Navigate: From the Task Pad, select Candidate Rules > Create Candidate Rules. The

Create Candidate Rule workspace opens.

B create Candidate Rule

ICJ Create Candidate Rule
rCandidate Rule Maintenance
* Narne || |
Description | |@
Type -é- Inclusion
{ : ! Excluzion
Status () Inactive
(@) Active
Condition Definition
Field Operator Wariable Walue
i e e— R —
rConditions
Cancel || Save + Repeat || Done I

Create Candidate Rule Workspace

1. In the Name field, enter the name of the candidate rule.

2. In the Description field, enter a description of the candidate rule. This description can

be up to 250 characters.

3. Inthe Type, select the kind of candidate rule that you are creating.

4. In the Status field, select the active status of the rule. Only active rules are run during

a review period.

5. In the Field column, select the field to which the candidate rule is applied.

In the Operator field, select the relationship that the Field item has to the Value or

Variable Name.

Note: All options may not be available for some field types.

Operator Relationship

= Equal to

< Less Than

> Greater Than

<= Less than or equal to
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Operator Relationship

>= Greater than or equal to

Not equal to

7. In the Value field, enter the ID of value or click the LOV & button and select a value.

Note: If you enter a Value, the rule runs against all
Departments that use this value in the rule. If you enter a
Variable, you can assign the value of the Variable by
Department.

Assign a Variable Value
1. Select the Variable check box.
2. If the Variable is a new variable, select the New check box.

3. In the Value field, enter the name if it is a new variable or click the LOV & button
and select an existing variable.

Complete the Candidate Rule
1. Enter additional conditions as necessary.

2. Click Add. The condition opens in the conditions area.

Note: A single rule can have multiple conditions. If multiple
conditions exist for a rule, an item must meet all of the
conditions in order for the rule to be met.

3. Click Done to save any changes and close the window.
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Maintain Rule Variables by Variable or by Department

Navigate: From the Task Pad, select Candidate Rules > Maintain Rule Variables. The

Rule Variable Maintenance workspace opens.

%3 Rule Yariable Maintenance

IP Rule Variable Maintenance
Method By Wariable =
Rule Wariable Maintenance By Yariable " &
Department | Description Yariable ¥alue |
Cancel Il Save + Repeat I | Done

Rule Variable Maintenance Workspace
1. In the Method field, select how you want to update the rule variables

2.

variable.

the rule is run against items in the department.

To update the values for multiple departments:

a. Multi-select the departments you want to update

b. In the Value field below the Rule Variable Maintenance By Variable table, enter
the value to be associated with the variable when the rule is run against items in

the department.
c. Click Apply.

Click Done to save any changes and close the workspace.

In the Variable/Department field, select the value you want to use to update the rule

In the Variable Value field, enter the value to be associated with the variable when
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Delete a Candidate Rule Variable

Note: If the variable is attached to a candidate rule, you must
delete the candidate rule before you can delete the variable.
To delete the candidate rule, see the Delete a candidate rule
procedure.

In the Department field, enter the Department number or click (LOV) and select
from the list of values.

Click View. A list of the defined variables with their assigned values appears.
Select the radio button for the candidate rule variable that you want to remove.

Click Delete. A message appears, “This variable will be deleted for all Departments.
Do you want to continue?”

Click OK. The variable is removed from the list.

Note: To leave the window without making changes, click
Cancel.

Update a Candidate Rule Variable

Note: Rules that have variables defined are run only against
items in Departments where a value has been assigned to the
variable. If there is no variable value for a Department, the
candidate rule will not run against items from that
Department.

In the Department field, enter the Department number or click (LOV) and select
from the list of values.

Click View. A list of the defined variables with their assigned values appear.

Note: To apply the same variable to more than one
Department, select the desired Departments from the list.
For more information on selecting multiple items from a list,
see the Select multiple options from a list procedure.

In the Value field for the candidate rule variable that you want to edit, enter the
appropriate value.

Click Save. The information is saved.

Note: To leave the window without making changes, click
Cancel.
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Maintain a Candidate Rule

Navigate: From the Task Pad, select Candidate Rules > Maintain Candidate Rules. The
Maintain Candidate Rules workspace opens.

%9 Maintain Candidate Rules

Candidate Rule List |l

Name Text Yariable Type Status |

SLL Second Retest test Projected Sales < [FU.., @ Inclusion Active Z

SLL Retest 4198 Candida,., [Sell Through = 0.2;: T, @ Inclusion Active

Test Candidate Rules Department = 1818 Clas.. Inclusion Active

Cept 2 Cepartment = 2 Inclusion Active

Test 2 Seasan Code = Sprin.., @ Inclusion Active

Test 3 Market Basket Code = 00.., Inclusion Active -

Cept 1704 Cepartment = 1704 Inclusion Active ]
Cancel || Save + Repeat || Done I

Maintain Candidate Rules Workspace

1.
2

Select the candidate rule you want to change.

Click Edit. The Candidate Rule Maintenance workspace opens with information
about the selected candidate rule.

Change information in any of the fields, as necessary.

Note: See the Set up a candidate rule and define a variable
for the rule procedure for additional information.

If you want to use the value as a variable:

a. Check the box in front of Use value as variable.

b. Enter or Click & (LOV) to display a list of existing values.
c. Select an appropriate value from the list.

If you want to edit only the Condition portion of a rule:

Note: To add a new Condition to a rule without changing
any existing Conditions, follow steps c-d below.

a. In the Conditions box, select the Condition that you want to change.

b. Click Edit. The components of the selected condition display in the Field,
Operator, and Values or Variable Name fields.

User Guide 43



Candidate Rules

c. Enter the appropriate information in the Field, Operator, and Values or Variable
Name fields.

d. To include the new or updated Condition without removing the existing
Condition, click Add.

Or

To substitute the existing Condition with the one you just created or edited, click
Replace.

6. To return to the Candidate Rules window, click Cancel. All information that you did
not save in the Candidate Rule Maintenance window is lost.

7. To delete a condition, select the condition in the Conditions box.
Click Delete. The condition is removed.

9. To apply all of the changes that you made in this window, click Save. You are
returned to the Candidate Rules window.

Delete a Candidate Rule

Navigate: From the Task Pad, select Candidate Rules > Maintain Candidate Rules. The
Maintain Candidate Rules workspace opens with all of the current candidate rules listed.

B5 Maintain Candidate Rules

|'@ |
tandidate Rule List |l
Name Text Yariable Type Status |
SLL Second Retest test Projected Sales < [FU.., @ Inclusion Active Z
SLL Retest 4198 Candida,., [Sell Through = 0.2;: T, @ Inclusion Active
Test Candidate Rules Department = 1818 Clas.. Inclusion Active
Cept 2 Cepartment = 2 Inclusion Active
Test 2 Seasan Code = Sprin.., @ Inclusion Active
Test 3 Market Basket Code = 00.., Inclusion Active -
Cept 1704 Cepartment = 1704 Inclusion Active ]

Cancel || Save + Repeat || Done I

Maintain Candidate Rules Workspace
1. Select the candidate rule you want to delete.

2. Click Delete. A message appears, “Are you sure you want to delete the selected
rule?”

3. Click OK to delete the rule. The rule is removed from the list.
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Note: Variables are not deleted if you delete a rule that has a
condition with variables and values assigned at the
Department level. This feature allows you to use the
existing variables and assigned values when you create a
new rule. To delete the variables, see the Delete a candidate
rule variable procedure.
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Zone Structures

Zone structures allow you to group locations that are priced the same. Additionally, you
identify the types of pricing the zone is used for; Regular, Promotional, or Clearance.
There are several components that you need to define in order to use zone structures.

Zone Groups

Zone groups are a collection of zones. You can define multiple zone groups that are
suited to your business. After you define the zone group, you can define the zones in the
zone group. A location (store or warehouse) can only exist once in a given zone group.
Multiple currencies may exist within a zone group.

Zones

A zone is a group of locations that are priced the same within a zone group. Locations
within a zone must have the same currency. Not all locations must be assigned to a zone.

Primary Zone Groups

The primary zone group is used to determine how items are initially priced in the
merchandising system. When you create a primary zone group, you identify the
merchandise hierarchy level, the zone group, the markup percent, the markup type, and
the price guide. The merchandise hierarchy assigned to a new item in merchandising
system will determine the primary zone group definition in RPM used to initially price
the item. Based on the information associated with the primary zone group and the cost
of the item, as entered in the merchandising system, prices will be proposed.
Additionally, price changes that are created against a zone in the primary zone group are
stored at the zone level. These price changes can be displayed in the Price Inquiry
window.

Create a Zone Group

Navigate: From the Task Pad, select Zone Structure > Create Zone Group. The Create
Zone Group workspace opens.

B9 Create Zone Group

I(—‘ Create Zone Group
Zone Group ID Zane Group Hame Type Like Group
Era— =
Zone ID Zone Name Currency
NE | = el

Zone ID ‘ Name | Currency Location Count Base ‘

save  |[ Locations || Delete \|

Create Zone Group Workspace

1. In the Zone Group ID field, edit the generated Zone Group ID field as necessary.
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Note: The Zone Group ID field appears with the next
available number. If you choose to update the field, you
must choose a unique ID.

In the Zone Group Name field, enter a description of the zone group.

In the Type field, enter the type of pricing this zone group is used for, or click the
LOV E button and select a type.

4. Click Next. Your zone group is created.

Add Zones to a Zone Group
1. Inthe Zone ID field, edit the generated Zone Group ID field as necessary.

Note: The Zone ID field appears with the next available
number. If you choose to update the field, you must choose a
unique ID.

In the Zone Name field, enter a description of the zone.

In the Currency field, enter the currency for the zone, or click the LOV & button and
select a currency.

Click Apply. Your zone is added to the table.

Add the appropriate number of zones for your zone group.

Add Locations to a Zone
1. Selecta zone.
2. Click Locations. The Price Zone — Location Assignment pane opens.

(& Price Zone - Location Assignment

Tep [ =l
| &
Location ‘ Name | Location Type New Zone New Zone Name Effective Date Status

|

Price Zone — Location Assignment Pane
3. In the first field, select the type of location you want to add to the zone.

In the Value field, enter the ID of the location or location group, or click the LOV
button and select a location or location group.

5. Click Apply to add the location or location group to the list of locations.
6. Click Save to commit any changes.
Click Done to save any changes and close the workspace.
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Copy an Existing Zone Group
1. In the Zone Group ID field, edit the generated Zone Group ID field as necessary.

Note: The Zone Group ID field appears with the next
available number. If you choose to update the field, you
must choose a unique ID.

In the Zone Group Name field, enter a description of the zone group.

In the Type field, enter the pricing strategy that the zone group will use, or click the
LOV & button and select a type.

Select the Like Group check box.
Click Next. The Like Group container opens.

6. Enter the ID of the zone group that you want to copy, or click the LOV & button and
select a group.

7. Click Done to save any changes and close the workspace.

Note: To edit the newly created Zone Group, see the
"Maintain a Zone Group" procedure.

Maintain a Zone Group

Navigate: From the Task Pad, select Zone Structure > Maintain Zone Group. The
Maintain Zone Group workspace opens.

%5 Maintain Zone Group

I(D Price Zone Group List

&%,

Zone Group 10 Name Type Location Count

119| DW currenc Y Reqular

130[ SLH Regular

131[DW USD Regular

124 Jodi's 1221 78 Reqular

199[26-0009 Clearance; Regular Prometien

393( 1221 Warehouzes Reqular

o I S S P

402| corin test Reqular

Sancel || Save + Repeat |[ Dane

Maintain Zone Group Workspace
1. Filter for the records as necessary:
a. In the Location, Currency, and Type fields, enter the criteria you want to filter
for.

b. Click the filter ] button. Zone groups that match your criteria appear in the
table below.

Note: Click the ¥ clear filter button to remove the filter
criteria. All zone groups appear in the table below.

2. To delete a zone group:
a. Select a zone group.
b. Click Delete. The zone group, zones, and locations are removed.
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Edit Zones
1. Select a zone group.
2. Click Edit. The Maintain Zone Group pane opens.
“’(—‘ Maintain Zone Group
*feooss | B
e [ 18 corensy [ 1@
foer ] | ) E
12,
Zone ID | Name ‘ Currency ‘ Location Count | Base
533‘ FRAMCAS |CAD | D‘
381‘ Al | uso | 2‘ .
‘ save  |[ Locations |[  Delete \‘
Maintain Zone Group Pane
3. After the Zone has been added to the Zone Group the currency cannot be changed.
The zone with the incorrect currency can be deleted and then re-created with the
correct currency.
Note: If there are no locations in the zone the currency field
is editable. If locations exist in the zone than the currency
field is NOT editable.
Add zones to the zone group.
5. To delete a zone:

a. Selecta zone.

b. Click Delete. The zone is removed from the list of zones.

Note: You must first delete all locations from the zone before
you can delete it.

Edit Locations
1.
2.

Select a zone.

Click Locations. The Price Zone — Location Assignment pane opens.

() Price zone - Location Assignment

Tupe [stare =]
Location ‘ Name | Location Type New Zone New Zone Name Effective Date Status

Price Zone - Locations Assignment Pane
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3. Add locations to the zone.

Note: When you add a location to a zone that was previously
saved, a location move is scheduled. Go to the "Maintain
Location Move" procedure to view the location move.

4. To delete a location from a zone.
a. Select a location.

b. Click Delete. The location is removed from the list of locations.

Note: When you delete a location from a zone a location
move is scheduled. Go to the "Maintain Location Move"
procedure to view the location move.

Complete the Zone Edits
Click Done to save any changes close the workspace.

Create a Primary Zone Group

Navigate: From the Task Pad, select Zone Structure > Maintain Primary Zone Group. The
Maintain Primary Zone Group workspace opens.

%5 Maintain Primary Zone Group
. ]
(@ zone Retail Definition List |
Zone Retail Definition List Il
Dept. Dept Description | Class Class Description | Subclass Subclass Descripti| Reqular Price Zond Regular Price Zond Initial Price Setti Markup Type
Retail Markup
22 Dl working dept 12 HL-ragular 20%| Retail Markup
1 Corin's Departm,., 13 Corin's 26 50%| Retail Markup
1221 Kitchenuare 12 HL-ragular 100%| Retail Markup
7000 DOC Tast Dapt 402 corin tast 50%| Retail Markup
4367 Womens shoes 12 HL-regular 15| Retail Markup
7001 DOC Test Dept. 2 131 DW USD: 25%)| Retail Markup |
pelete |[ Edit  |[ add ||
=
cancel || Save + Repeat |[ pore |

Maintain Primary Zone Group Workspace
1. Click Add. The Zone Retail Definition Maintenance pane opens.

(@ zone Retail Definition Maintenance

Merchandise Lavel Requlsr Price Zone Group

. e —
8

Initisl Price Settings

Markup % l:l ®) Retail Markup () Cost Markup

| ooty ||
Zone Retail Definition Maintenance Pane

2. In the Department field, enter the ID of the department, or click the LOV B button
and select a department.
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9.

In the Class field, enter the ID of the class, or click the LOV & button and select a
class.

In the Subclass field, enter the ID of the subclass, or click the LOV & button and
select a subclass.

Note: You must select the merchandise hierarchy levels
above class and subclass before you can identify class and
subclass. Class and subclass are not required. You can define
a primary zone group at the Department level.

In the Zone Group field, enter the ID of the zone group you want to associate with
the selected merchandise hierarchy level, or click the LOV & button and select a zone

group.

Note: Regular price zone groups are the only type of zone
groups that can be attached to a primary zone group.

In the Initial Price Settings container:

a. In the Markup % field, enter the percent of markup that is applied to the cost of
the item.

b. Select either Retail Markup or Cost Markup to indicate how the markup is
calculated.

To add a price guide, click Price Guides. The Price Guide Definition window opens.

Price Guide Definition

Zone Currency Price Guide

| Cancel || =114 |

Price Guide Definition Window

For each currency, enter a price guide ID, or click the LOV [l button and select a
price guide.

Note: Only price guides that are associated with the
department selected in the Zone Retail Definition
Maintenance container appear. For each currency, you can
select a price guide, if a price guide has been set up for the
currency and department.

Click OK to save any changes and close the window.

10. Click Apply to add your changes to the table.

11. Click Done to save any changes and close the workspace.
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Maintain a Primary Zone Group

Navigate: From the Zone Structure menu, select Maintain Primary Zone Groups. The
Maintain Primary Zone Group workspace opens.

%5 Maintain Primary Zone Group

I@ Zone Retail Definition List

Zone Retail Definition List Il
Dept. Dept Description | Class Class Description | Subclass Subclass Descripti| Reqular Price Zond Regular Price Zond Initial Price Setti Markup Type
Dl working dept 12 HL-ragular 20%| Retail Markup
Corin's Departm,., 13 Corin's 26 50%| Retail Markup
1221 Kitchenuare 12 HL-ragular 100%| Retail Markup
7000 DOC Tast Dapt 402 corin tast 50%| Retail Markup
4367 Womens shoes 12 HL-regular 15| Retail Markup
7001 DOC Test Dept. 2 131 Dw UsD 259 | Retail Markup -]
pelete [ Edit |[_Add ||
=
cancel || Save + Repeat |[ pore |

Maintain Primary Zone Group Workspace

1.

4.

Click Edit. The Zone Retail Definition Maintenance pane opens.

I@ Zone Retail Definition Maintenance

Merchandize Level Regulsr Price Zone Group
. e —

Initisl Price Settings

Markup % l:l ®) Retail Markup () Cost Markup

| o]
Zone Retail Definition Maintenance Pane

Edit the enabled fields as necessary.

Click Apply.

Click Done to save any changes and close the workspace.

Delete a Primary Zone Group

1.

2
3.
4

Select a primary zone group.

Click Delete. A message appears, “All selected rows will be Deleted.”
Click Yes. The primary zone group is removed from the table.

Click Done to save any changes and close the workspace.
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Codes

The foundation area allows you to maintain reason codes and link codes. Reason codes
are used to explain the rationale for clearances and price changes. Link codes are used to
associate items to each other at a location and price them exactly the same.

Link Codes

The maintain link codes area allows you to assign link codes to a transaction level
item/location. The items can be associated to the code through the merchandise
hierarchy, at the item level, or through item attributes such as diff or diff type. Locations
can be associated to the code through the zone group or zone or by entering the location
directly.

Market Basket Codes

The maintain market basket codes area allows you to assign market baskets codes to an
item/zone. The items can be associated to the code through the merchandise hierarchy,
at the item level, or through item attributes such as diff or diff type.

Create a Code

Navigate: From the Task Pad, select Foundation > Code Maintenance. The Code
Maintenance workspace opens.

I'/C; Code Maintenance |

Code Maintenance " @;
Type Code Description 5IM |
Link Code il biea o]
Reqular Price e Acé ':'

Link Code Code Lala

Reqular Price ReglodeMaw newDasc ':'

Link Code Link 12 T

Link Code SD-1704 Single Dept LT

Link Code M-Dept Multi Dept-1704-1254-1221

Link Code Farant-LC Farent Link Code

Link Code MZ-50 Multiple Zone

Link Code LS for WH Link Code for WH testing

Link Code Crrop It nly On the left side L
Link Code Hodi Zone Hodi Zone

Feqular Price Code3333 Farmland Milk (O}

Reqular Price Code 46 Andy Dufresne

Link Code Fizza Code used for all frozen pizzas

Link Code what If Link Code for What If stories

Regular Price Code 2 &l Code

Clearance Price Code Clear Surnmer Everything Clearance

Clearance Price Code Blue Code Blue Sale??? ) -

vew [ osiete ||

Code Maintenance Workspace

1. Click New. The next line on the table is enabled.

2. In the Type field, select the type of code you are creating.
3. In the Code field, enter a unique identifier for the code.
4

In the Description field, enter a description of the code.
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5. In the SIM field, select the radio button to indicate that the reason code is used

exclusively by Store Inventory Management (SIM).

Note: Only one reason code for price changes and clearances

can be assigned as a SIM reason code.

6. Click Done to save any changes and close the workspace.

Edit a Code

Navigate: From the Task Pad, select Foundation > Code Maintenance. The Code

Maintenance workspace opens.

I'@ Code Maintenance

Code Maintenance " y;
Type Code Description 5IM |
Link Code il biea o]
Reqular Price e Acé I

Link Code Code Lala

Reqular Price ReglodeMaw newDasc I

Link Code Link 12 T

Link Code SD-1704 Single Dept LT

Link Code M-Dept Multi Dept-1704-1254-1221

Link Code Farant-LC Farent Link Code

Link Code MZ-50 Multiple Zone

Link Code LS for WH Link Code for WH testing

Link Code Crrop It nly On the left side L
Link Code Hodi Zone Hodi Zone

Reqular Price Code3333 Farmland Milk

Reqular Price Code 46 Andy Dufresne

Link Code Fizza Code used for all frozen pizzas

Link Code what If Link Code for What If stories

Regular Price Code 2 &l Code

Clearance Price Code Clear Surnmer Everything Clearance

Clzarance Price Code Blue Code Blue Sale?r? -

vew [ osiete ||

Code Maintenance Workspace
1. Select the field you want to edit.
2. Make necessary changes.

3. In the SIM field, select the radio button to indicate that the reason code is used

exclusively by Store Inventory Management (SIM).

Note: Only one reason code for price changes and clearances
can be assigned as a SIM reason code. You are prompted to
confirm your choice to change the SIM reason code.

Click Save + Repeat to commit your changes.

5. Click Done to save any changes and close the workspace.
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Delete a Code

Navigate: From the Task Pad, select Foundation > Code Maintenance. The Code

Maintenance workspace opens.

I@ Code Maintenance

Code Maintenance " d
Type Code Descripton SIM |
Link Code izl bia ]
Reqular Price ET-1 ET=1

Link Code Code Lala

Regular Price RegTodeMeaw newlesc

Link Code Link 12 m

Link Code SC-1704 Single Dept LT

Link Code M-Crept Multi Dept-1704-1234-1221

Link Code Farant-LT Farent Link Code

Link Code MZ-50 Multiple Zone

Link Code LT for WH Link Code for WH testing

Link Code Crrop It Only On the left side L
Link Cade Dadi Zane Hadi Zane

Regular Price Code3333 Farmland Milk

Regular Price Code 46 Andy Dufresne

Link Code Pizza Code used for all frozen pizzas

Link Cade lthat If Link Code far What If staries

Regular Price Code 2 &l Code

Clearance Price Code Clear Sumnmer Everything Clearance

Clearance Price Code Blue Code Blue Sale??? -

new [ osiete ||

Code Maintenance Workspace

1. Select the record you want to delete.

2. Click Delete. The record is removed from the table.

3. C(lick Done to close the window.

Note: You cannot delete a reason or link code that is in use.
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Maintain Link Codes

Search for a Link Code

Navigate: From the Task Pad, select Link Codes > Maintain Link Codes. The Maintain
Link Codes workspace opens.

75 Maintain Link Codes

(@ tink codes search

rLink Code
8 B
5 i —
Itern Type  [item [~ Link code I:I B+
Ttern Level I'I'ransaction Level Itern lzl
N E—
8

Maintain Link Codes Workspace

1. Enter criteria as necessary to restrict the search to the link codes you want to
maintain.

2. Click Search. Your results appear in the Maintain Link Codes table.
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I@ Maintain Link Codes

rLink Code

Itern Type

Itermn Level

8
8

Location

|Item

lzl Link Code

|Transacti0n Lewvel Itern

=]

|

[ 18

[ 18

prem =
8
I

Item Item Description | Parent Item Parent Item Desc Location Location Descripti Link Code Link Code Descrip
Filter by Izl | Filtar by lzl | Filter by lzl | Fifter by lzl | Filter by lzl | Filter by Izl | Filter by lzl | Filter by lzl
100000008 Test Item 100.., 3 Western Physic.. | Prakazh b Prakazh CodeZ2 —
100000008 Test Itemn 100.., 4 Western Physic.. | Prakazh b Prakazh CodeZ2
100000008 Test Item 100.., 5 Western Physic.. | Prakazh b Prakazh CodeZ2
100000008 Test Item 100.., [ Western Physic.. | Prakazh b Prakazh CodeZ2
100000008 Test Itemn 100.., 7 Western Physic.. | Prakazh b Prakazh CodeZ2
100000008 Test Itemn 100.., 22 stare Lo 1 T Link Code 1
100000016 Test Item 100.., 3 Western Physic.. | Prakazh b Prakazh CodeZ2
100000016 Test Itemn 100.., 4 Western Physic.. | Prakazh b Prakazh CodeZ2
100000016 Test Itemn 100.., 5 Western Physic.. | Prakazh b Prakazh CodeZ2
100000016 Test Itemn 100.., [ Western Physic.. | Prakazh b Prakazh CodeZ2
100000016 Test Item 100.., 7 Western Physic.. | Prakazh b Prakazh CodeZ2
10000001 & Test Itern 100.., 23 store? LC 2 T Link Code 2
100000024 Test Itemn 100.., 8 Western Physic.. | Prakazh b Prakazh CodeZ2

Maintain Link Codes Table

Maintain or Override a Link Code

1. Search for and retrieve the link codes you want to maintain. Your results appear in
the Maintain Link Codes table.

Note: You must enter a department. Subsequent
merchandise levels are enabled as you add the level above.
You may enter more than one department, in which case

you cannot enter class or subclass.

2. Select the locations for the link code:

= Zone Group: Enter the ID of the zone group that contains the zones the link code
should apply to, or click the LOV B button and select a zone group.

= Zone: Enter the ID of the zone that contains the locations the link code should
apply to, or click the LOV H button and select a zone.

= Location: Enter the ID of the location the link code should apply to, or click the
LOV B button and select a location.

3. Select the item type for the link code from the Item Type drop-down.

= Jtem: Select an item or for the link code.

a.

b.

In the Item Level drop-down, select Parent Item, Parent Item/Diff, or
Transaction Level Item.

If enabled, select a diff type from the Diff Type drop-down.
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c. In the Item field, enter the ID of the item(s) you want the link code to apply
to, or click the LOV & button and select an item.

d. If enabled, enter the ID of the diff(s), or click the LOV E button and select a
diff.

= Jtem List: Select an item list for the link code.

Enter the ID of the item list you want the link code to apply to, or click the LOV
button and select an item list.

4. Click Apply. The following may occur:

= A row is added to the table for each transaction level item /location that meets
the selected criteria.

* An existing row changes based on the selected criteria.
5. Click Done to save any changes and close the workspace.

Update Link Codes
1. In the Maintain Link Codes table select the rows you want to edit by clicking the box

:I to the left of the row. Press and hold the Ctrl key while selecting to select multiple
rows. Click Select All to select all the rows.

2. Right click in the link code field. The Link Code dialog opens.

Link Code X
=l
=]
Edited Yalue 1-<h =

| Apply || Cancel |

Link Code Dialog

3. Enter the ID of the link code in the Edited Value field, or click the LOV & button and
select a code.

4. Click OK. Your changes appear in the table.

Delete a Link Code Relationship
1. In the Maintain Link Codes table select the row you want to delete by clicking the

box j to the left of the row. Press and hold the Ctrl key while selecting to select
multiple rows. Click Select All to select all the rows.

Click Delete. You are prompted to confirm your decision.
Click Yes. The link code relationship is deleted.
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Maintain Market Basket Codes

Search for a Market Basket Code

Navigate: From the Task Pad, select Market Basket Codes > Maintain Market Basket
Codes. The Maintain Market Basket Codes workspace opens.

B5 Maintain Market Basket Codes

(@ Market Basket Godes Search

rMarket Basket Code

Clazs %+

Subdass E+

Itern Type |Iten’| E‘
Ttern Level ITransaction Level Iterm lzl
Diff Type - Selact - |
N —] T

Diiff

8-
=
Cornpetitive Market Basket Code I:I 8+

Margin Market Basket Code

Zone

+

Maintain Market Basket Codes Workspace

1.
to maintain.

2.

Enter criteria as necessary to restrict the search to the market basket codes you want

Click Search. Your results appear in the Maintain Market Basket Codes table.

I@ Maintain Market Basket Codes

Market Basket Code

Class §+
Subclass E+
Itern Type  [ltem

Itern Level  [Transaction Level Itern

Diff Type - Select -
N E—]
Diff

|
Fermove Margin Market Basket Code
Margin Market Basket Code

Remove Cormpetitive Market Basket Code D

Competitive Market Bazket Code

JHE

Zone

O
L I8
L |8

8
B8+

Maintain Market Basket Codes Table

I
Item Item Description | ParentItem | Parent Item Description | Zone Group Zone Margin Market Basket Code | Margin Marke
Fiteer by |7 ||[Fter - [ || Fier 8- [ ||| iteer 8y [ l|[eer by [ ||| Fter £y [+ ]|[ Fotear 8y [ |[ Fter 8y
ioonoo4050 LH Sweatars:Br...| 100004025 LH Sweatars 1 1 ool MBC 1 Z
100004050 | LH Sweaters:Br...| 100004025 | LH Sweaters 1 2 o001 MBC 1
100004050 | LH Sweaters:Br...| 100004025 | LH Sweaters 1 3 001 MBC 1
100004068 | LH Sweaters:Br...| 100004025 | LH Sweaters 1 1 o001 MBC 1
100004068 | LH Sweaters:Br...| 100004025 | LH Sweaters 1 2 o1 MBC 1
100004068 | LH Sweaters:Br...| 100004025 | LH Sweaters 1 3 o001 MBC 1
100004076 | LH SweatersiBr., [ 100004025 | LH Sweaters 1 1 oo1 MBC 1
100004076 | LH SweatersiBr,., [ 100004025 | LH Sweaters 1 2 oo1 MBC 1
100004076 | LH SweatersiBr., [ 100004025 | LH Sweaters 1 3 oo1 MBC 1
ioooo40s4 LH Sweaters:Br...| 1000040235 LH Sweaters 1 1 ool MBC 1
ioooo4024 LH SweatersiBr..| 100004025 LH Sweaters 1 2 ool MBC 1
ioooo4024 LH SweatersiBr.. | 100004025 LH Sweaters 1 2 ool MBC 1
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Maintain Market Basket Codes

1. Search for and retrieve the market basket codes you want to maintain. Your results
appear in the Maintain Market Basket Codes table.

I
Item Item Description | Parent Item | Parent Item Description | Zone Group Zone Margin Market Basket Code | Margin Marke
Fitber by | ||| Fitrer by lzl |F.I'J'ter by lzl | Filrer by : lzl |F.l!ter by | ||| Fikber by lzl | Filtey by lzl | Filkar by
100004050 | LH Sweaters:Br.., [ 100004025 | LH Sweaters 1 1 oo1 MBC 1 z
100004050 LH Sweaters:Br.. | 100004025 LH Sweatars 1 2 oot MBC 1
100004050 LH Sweaters:Br.. | 100004025 LH Sweatars 1 E oot MBC 1
100004068 LH Sweaters:Br.. | 100004025 LH Sweatars 1 1 oot MBC 1
100004068 LH Sweaters:Br.. | 100004025 LH Sweatars 1 2 oot MBLC 1
100004068 LH Sweaters:Br.. | 100004025 LH Sweatars 1 3 oot MBC 1
100004076 LH Sweaters:Br.. | 100004025 LH Sweatars 1 1 oot MBC 1
100004076 LH Sweaters:Br.. | 100004025 LH Sweatars 1 2 oot MBC 1
100004076 LH Sweaters:Br.. | 100004025 LH Sweatars 1 3 ool MBC 1
100004024 LH Sweaters:Br.. | 100004025 LH Sweatars i i ool MBC 1
100004024 LH Sweaters:Br.. | 100004025 LH Sweatars 1 2 ool MBC 1
100004024 LH Sweaters:Br.. | 100004025 LH Sweatars i E ool MBC 1
1000200632 Parant_tern-1:.. | 100020055 Parant_tam-1 1 i ool MBC 1
1000200632 Parant_tern-1:.. | 100020055 Parant_tam-1 i i ool MBC 1
100020071 Parent_tern-1t.. | 100020055 Parent_tern-1 1 i ool MBC 1
100020071 Parent_tern-1i.. | 1000320055 Parent_tern-1 i i ool MBC 1
100020020 Parent_tern-1i.. | 1000320055 Parent_tern-1 1 i ool MBC 1
100020020 Parent_tern-1:.. | 1000320055 Parent_tern-1 1 i ool MBC 1
100020092 Parent_tern-1i.. | 1000320055 Parent_tern-1 i i ool MBC 1 -
q] | IED
Filter
N m— 1

Maintain Market Codes Table

2. Enter the ID of the merchandise level you want to apply the market basket to, or click
the LOV B button and select the appropriate merchandise level.

Note: You must enter a department. Subsequent
merchandise levels are enabled as you add the level above.
You may enter more than one department, in which case
you cannot enter class or subclass.

3. Select the zones for the market basket:

= Zone Group: Enter the ID of the zone group that contains the zones the market
basket should apply to, or click the LOV B button and select a zone group.

= Zone: Enter the ID of the zone the market basket should apply to, or click the
LOV & button and select a zone.

4. Select the item type for the market basket code from the Item Type drop-down.
= Item: Select an item for the market basket code.

a. In the Item Level drop-down, select Parent Item, Parent Item /Diff, or
Transaction Level Item.

If enabled, select a diff type from the Diff Type drop-down.

In the Item field, enter the ID of the item(s) you want the market basket
code(s) to apply to, or click the LOV B button and select an item.

d. If enabled, enter the ID of the diff, or click the LOV B button and select a
diff.
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8.

= Jtem List: Select an item list for the market basket code.

Enter the ID of the item list you want the market basket code(s) to apply to, or
click the LOV B button and select an item list.
In the Margin Market Basket Code field, enter the ID of the code, or click the LOV B
button and select the code.
Or
Select the Remove Margin Market Basket Code checkbox to disassociate the margin
market basket code from the item(s)/zone(s) that meet the selected criteria.
In the Competitive Market Basket Code field, enter the ID of the code, or click the
LOV & button and select the code.
Or
Select the Remove Competitive Market Basket Code checkbox to disassociate the
competitive market basket code from the item(s)/zone(s) that meet the selected
criteria.
Click Apply. The following may occur:

= A row is added to the table for each transaction level item /location that meets
the selected criteria.

* An existing row changes based on the selected criteria.

Click Done to save any changes and close the workspace.

Update Market Basket Codes

1.

In the Maintain Market Basket Codes table select the row you want to edit by clicking

the box :l to the left of the row. Press and hold the Ctrl key while selecting to select
multiple rows. Click Select All to select all the rows.

I
Them Item Description | Parent Ttem Parent Item Description | fone Group fone Margin Market Baskel
Fitter by | ||| Fitker by || Fiker by | | Fitker by W Fitber by | TN Fitber by | ||| Fitber by
1001326001 tast 115 Se4 oos lz‘
100154058
100154074 | Parent & DiffiLa..| 100154066 | Parent & Diff 115 215 005
100154074 Parent & DiffiLa..[ 100154066 Parent & Diff 115 477 oos
100154074 Parent & DiffiLa..| 100154066 Parent & Diff 115 486 aons -
< I IED
Filter
. =0 |
Location l:l % I!I !l

Maintain Market Basket Codes Table
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2. Right click in the field you wish to edit:
= Margin Market Basket Code - The Margin Market Basket Code dialog opens.

Margin Market Basket Code El
8
=

Edited Yalue oos

| Apply || Cancel |

Margin Market Basket Code Dialog
* Competitive Market Basket Code - The Competitive Market Basket Code dialog
opens.

Competitive Market Basket Code g|
8
=

Edited Yalue ooz

| Apply || Cancel |

Competitive Market Basket Code Dialog
3. Enter the ID of the Market Basket Code in the Edited Value field, or click the LOV

button and select a code.

Or
Clear the field to disassociate the market basket code from the selected record.

4. Click OK. Your changes appear in the table.
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Delete a Market Basket Code Relationship
1. In the Maintain Market Basket Codes table select the row you want to delete by

clicking the box j to the left of the row. Press and hold the Ctrl key while selecting
to select multiple rows. Click Select All to select all the rows.

I
Item Item Description | Parent Item | Parent Item Description | Zone Group Zone Margin Market Basket Code | Margin Marke
Fitber by | ||| Fitrer by lzl |F.I'J'ter by lzl | Filrer by : lzl |F.l!ter by | ||| Fikber by lzl | Filtey by lzl | Filkar by
100004050 LH Sweaters:Br.. | 100004025 LH Sweatars 1 i oot MBC 1 z
100004050 LH Sweaters:Br.. | 100004025 LH Sweatars 1 2 oot MBC 1
100004050 LH Sweaters:Br.. | 100004025 LH Sweatars 1 E oot MBC 1
100004062 LH Sweaters:Br.. | 100004025 LH Sweatars i i ool MBC 1
100004062 LH Sweaters:Br.. | 100004025 LH Sweatars 1 2 ool MBC 1
100004062 LH Sweaters:Br.. | 100004025 LH Sweatars i E ool MBC 1
100004076 LH Sweaters:Br.. | 100004025 LH Sweatars 1 i ool MBC 1
100004076 LH Sweaters:Br.. | 100004025 LH Sweaters i 2 ool MBC 1
100004076 LH SweatersiBr.. | 100004025 LH Sweaters 1 2 ool MBC 1
100004024 LH Sweaters:Br.. | 100004025 LH Sweaters 1 i ool MBC 1
100004024 LH SweatersiBr.. | 100004025 LH Sweaters i 2 ool MBC 1
100004024 LH Sweaters:Br.. | 100004025 LH Sweaters i 3 ool MBC 1
100030063 Parent_tern-1:.. | 100030055 Parent_termn-1 i i ool MBC 1
100030063 Parent_tern-1:.. | 100030055 Parant_tem-1 i i ool MBC 1
100030071 Parent_tern-1:.. | 100030055 Parent_termn-1 1 i ool MBC 1
100030071 Parent_tem-1:.. | 1000300355 Parent_tem-1 i i ool MBC 1
100030050 Parent_tem-1:.. | 10003003535 Parent_tem-1 1 i ool MBC 1
100030050 Parent_tem-1:.. | 1000300355 Parent_tem-1 1 i ool MBC 1
100030033 Parent_tem-1:.. | 1000300355 Parent_tem-1 i i ool MBC 1 -
{] [ ElD
Filter
e — EE

Maintain Market Basket Codes Table
2. Click Delete. You are prompted to confirm your decision.
3. Click Yes. The market basket code relationship is deleted.
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Calendars

Calendars are used to define review periods for your pricing strategies. A review period
is the amount of time you have to act on pricing events generated in the worksheet before
they expire.

After you create a calendar, you can maintain the different aspects of that calendar. You
can modify the name, description or end date of the calendar. You can also change the
rules and exceptions for future review periods.

Create a Calendar

Navigate: From the Task Pad, select Calendar > Create Calendar. The Create Calendar
workspace opens.

%5 create Calendar

(@ calendar setup

* Narne | ‘

Description | |@
Calendar Setup [ Review Period Setup
* Start Date l:lﬁ Rules Eoth  [7]
*End Date l:lE Exception Fraquency
O .
R Prried Bureizm I:l Mew Calendar to Assign to Strategies When Calendar Expires

cancel |[_save +Repeat |[_pone

Create Calendar Workspace
1. In the Calendar Setup pane, in the Name field, enter a name for the calendar.

2. In the Description field, you can enter a description for the Calendar. Click the G
button to open an editing window.

Set Up the Calendar

1. In the Calendar Setup area, in the Start Date field, enter the date the calendar
becomes active, or click the calendar E button and select a date.

In the End Date field, enter the date the calendar is no longer active.
In the Review Period Duration field, enter the length of the review period in days.

In the Days Between Review Periods field, enter the number of days between review
periods.
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Note: The last review period duration plus the days between
review periods must exactly reach the end date of the
calendar. If this is not the case, the system can automatically

adjust the end date, or you can chose to modify the Review

Period Duration, Days Between Review Periods or End Date

fields yourself.

Set Up Review Periods
1. In the Review Period Setup area, from the Rules drop-down, select the type of rules

to apply for the review period.

Inclusion - Items that meet inclusion candidate rules will be highlighted in the

worksheet.

Exclusion - Items that meet exclusion candidate rules will be excluded from the

worksheet.

Both - Both inclusion and exclusion candidate rules are applied for the review

period.

None - No rules are applied for the review period.

2. In the Exception Frequency field, enter the frequency, in review periods, that RPM

should process exceptions from the merchandising system.

Enter 1 for every review period.

Enter 2 for every other review period.

Enter 3 for every third review period.

Enter 0 if you never want RPM to process exceptions.

3. Click Calculate Review Periods. The review periods are calculated and the Review

Period Details pane opens.

(B Review Period Details

Review Period Details

It

Start Date

End Date

Exception

01/01/2005)

01/01/2005)

01/02/2005

01/02/2005)

01/03f2005

01/03/2005

01/04/2005

01/04/2005

01/05f2005

01/05/2005

01/06f2005

O1/0&/2005

01/07/2005

0107 2005

01/08f2005

01/08/2005

01/09/2005,

01/09/2005

01/10/2005,

01/10/2005,

01/11f2005

01/11/2005

01/12f2005

01f12/z005

01/13f2005)

01/13/2005

A= == == == e = e e e | E
slEIEIENENEEN W] &
;I}}iiii??iiiiim
i [« | [ e | | e I

1 EEE R R E | E | E

Review Period Details Pane

4. In the Review Period Details pane, in the Rules and Exceptions fields, edit as

necessary for each review period.

Complete the Calendar

Click Done at the bottom of the workspace. The new calendar is added and the Maintain
Calendar workspace closes.
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Maintain a Calendar

Navigate: From the Task Pad, select Calendar > Maintain Calendar. The Maintain
Calendar workspace opens.

%3 Maintain Calendar

@ |
Calendar List |
Name Description Start Date End Date Review Period Duration | Days Between Review Pd Expired I
corin devac test 11/19f2004 11/20/2004 1 1 E
Daily Calendar 10f08/2004 10/09/2005, 1 o (]

Demo Calendar Weekly Calendar 11/12/2004 02/10/2005 5 2 O
Starts 11/24 11/24/2004 11232004 5 il ] ||
Update Ttem Attribute 10f19/2004 10/17/2005 3 1 [l
Testweekly schedule | Testschedule 10/25/2004 12/28/2004 5 2 (]
Future calendar 05/23/2005 09/25/2005 2 1 O =

[osieee [ car ]|

cancel |[ save + Repest |[ pone

Maintain Calendar Workspace
1. Select the calendar you want to maintain from the Calendar List pane.

2. Click Edit. The Calendar Detail and Review Period Details panes are displayed and
the fields that can be changed are enabled.

|@ Review Period Details

01/13f2005) 01/13/2005| [Both

Review Period Details Il
Start Date End Date Rules Exception I

01/01/2005 01/01/2005) —

01/02f2005 01/02/2005)

01/03/2005| 01/03/z005| [oth  [7]

01/04/2005 010472005

01/05/2005 01/05/2005 [oth  [¥]

01/06/2005 01/08/2005 [Both -

01/07/2005 01/07/z005| [Both -

01/08/2005 01/03/2005) Both  |¥)

01/03/2005 01/0%/2005

01/10/2005 01/10/2005

01/11f2005 o1/11/z005) oth [

01/12f2005, 01/12/2005| [Both

i

Review Period Details Pane
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5.

I‘P calendar Details

*
bErma |2|JD5 Calendar |

Description | |@
talendar Setup Review Period Setup
Mew Galendar to Assign to Strategies When Galendar Expires
el E— ®

Calendar Detail Pane

Edit the enabled fields as necessary.
=  (Calendar Detail
— End Date: Select the end date for the calendar.

— New Calendar to Assign to Strategies when Calendar expires: Select the
calendar that replaces the current calendar after the end date.

= Review Period Details
— Rules: Select Inclusion, Exclusion, Both, or None.

— Exceptions: Select if exceptions, from the merchandising system, should be
processed during the review period.
Click Calculate Review Periods. If edits are made to the calendar detail, you must
press the Calculate Review Periods button.

Click Done.

Delete a Calendar

1.

2
3.
4

Select the calendar you want to delete from the list.

Click Delete. You are prompted to confirm your decision.
Click Yes. The calendar is deleted.

Click Done to close the window.
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Maintain Location Move

Location Moves allows you to smoothly move a location from one zone to another within
a zone group. The process allows a location to keep all location level pricing events while
it transfers from the old zones pricing strategies to those of the new zone, while at the
same time inheriting the pricing events of the new zone. Keep the following in mind
when scheduling location moves:

= A location does not automatically inherit the price of the new zone. Pricing events
scheduled after the move date in the new zone, will be applied to the new location.

=  Only location level promotions will follow a location into a new zone. Promotions
from the old or new zone that span the move date must be stopped before
scheduling a location move.

Request a Location Move

Navigate: From the Task Pad, select Zone Structure > Maintain Location Move. The
Maintain Location Move workspace opens.

%3 Maintain Location Move

(@ Location Move List ‘

Location Move List (-4

d & Location (3] | Location Nan Location Typ| Zone Group (3 Old Zone (2] | Old Zone Nan New Zone (3)| New Zone Naf Scheduled D4 Status Conflict Move Resul

171 12345678  |TestStroel.. |Store 521 For testing .. [ 08/01/2002|Scheduled =

178 12345672 [TestStroel.., [Store 521 For testing .. [ 08/01/2002|Failed

172 124 testing 124 |Store 521 For testing .. [ 08/01/2002|Scheduled

177 124 testing 124 |Store 521 For testing .. [ D8/01/2002|Failed Failed [—1

180 138 138 Stare 521 For testing ... [ 08/01/2002|Scheduled |

181 138 138 Stare 521 For testing ... [ 0B/01/2002|Failed

i 161 IStar 1 Eortesting . | 0s/01/200 heduled

(@ Maintain Location Move |

Maintain Location Move Workspace
1. Click New. The Zone Group Field is enabled on the Maintain Location Move pane.

(© Maintain Location Mova

8 8
8

Maintain Location Move Pane

2. In the Zone Group field, enter the zone group of the location you need to move, or
click the LOV E button and select a zone group.

3. In the Zone field, enter zone of the location you need to move, or click the LOV
button and select a zone.

4. In the Location field, enter the location you need to move, or click the LOV & button
and select a Location.

5. In the New Zone field, enter the zone to move the location to, or click the LOV
button and select the new zone.

68 Oracle Retail Price Management



Maintain Location Move

6. In the Effective Date field, enter the date the location should move zones, or click the
calendar & button and select a date.

Note: The Effective Date you can set depends on the number
of days set in the system option Location Move Lead Time.
The earliest date a location move can be created is today’s
date plus the location move lead time.

7. Click Apply. The location move request appears with a status of Worksheet on the
Location Move list.

Schedule a Location Move
1. Select a location move with a status of Worksheet.
2. Select Schedule from the Action drop-down.

3. Click Update. If no conflicts are found, the location move request is changed to a
status of Scheduled and it becomes locked and uneditable. The location will be
moved on the effective date.

Note: An alert is given when conflict checking is complete.

Reset a Failed Location Move
1. Select a location move with a status of Failed.
2. Select Worksheet from the Action drop-down.

3. Click Update. The failed location move is changed back to a worksheet location
move request.

4. Fix the conflict that caused the location move to fail and reschedule it.

View Conflicts

In the Conflict column, click the failed link. The conflict window opens with the conflict
information displayed.

There are three types of conflicts:

= Promotion - A promotion from the old or new zone spans the effective date of the
move.

= Schedule - There is a location move already scheduled for the location.

=  Price Strategy - The location or old zone is attached to a price strategy.

View Move Results

If RPM created any exceptions or exclusions in order for the location to be moved
successfully, those items are viewable in the move results column.

In the Move Results column, click the completed link. The conflict review window opens
with move results information displayed.
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Delete a Location Move

Note: Only location moves in Worksheet status can be
deleted.

Select a location move with a status of Worksheet.

2. Click Delete. A dialog appears asking "The selected Location Move Request will be
deleted. Canceling this task will not return these records. Do you wish to continue?"

3. Click Yes to delete the location move.
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Maintain Pricing Strategies

Pricing strategies allow you to define how prices are proposed when pricing worksheets
are generated. You can define pricing strategies at the department, class, or subclass level
to identify the items that are affected by the strategy. The lowest merchandise level you
can define for a price strategy is determined by the aggregation levels defined for the
department. An item/location can be on multiple regular pricing strategies as long as the
review periods within the calendar assigned do not overlap (clearance, competitive, or
margin) and one maintain margin pricing strategy which can overlap with a (clearance,
competitive, or margin) strategy.

After you have created a price strategy, you can maintain different aspects of the price
strategy.

Note: Updates to pricing strategies affect only future
worksheets. Current worksheets will not be updated.

Area Differential Pricing

Area differential pricing allows you to set prices for items at a particular zone or zone
group differently than another zone or zone group. The price differential is based on the
rules you define. Area differentials can be used when you create a price change to ensure
consistent pricing. These price changes are generated by selecting Price Changes for Area
Differentials within the Price Change task pad dialog. These price changes are generated
by selecting Price Changes for Area Differentials within the Price Change task pad
dialog. Differential pricing cannot be applied to other pricing events, such as clearances
or promotions.

When creating an area differential:

* You first establish a primary area, by defining the merchandise hierarchy and zone
hierarchy for the primary area.

* Next, select the zones that fall within the secondary area.

= Then define how prices for the items in the hierarchy will differ in the secondary
areas from the prices in the primary area. You can choose to price the item higher or
lower by percent, or set the price to the same as the primary area.

*  You can choose to exclude certain items in the merchandise hierarchy from the
secondary area differential prices.

* You can choose to create and associate a competitive pricing strategy with the
secondary area differential.

Area differentials are applied when price changes are created manually in the Price
Change Dialog or from the Create Price Changes for Area Differentials dialog. They are
also created in the worksheet if there are item/zone combinations brought into the
worksheet that are part of the primary area on an area differential strategy. When
competitive information is associated with an area differential the worksheet chooses the
lower of the retails proposed by the strategies.
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Note: See Create Price Changes for Area Differentials for
information about creating and applying price changes.

If you set up the secondary area to be auto-approved, secondary area price changes are
conflict checked, and if no conflict exists, created in approved status. If conflicts exist, the
secondary area price change is created in worksheet status. If you set up the secondary
are to not be auto-approved, secondary area price changes are created in worksheet
status. The Change the status of a price change topic provides additional information
about status changes and conflict checking.

Create an Area Differential

Navigate: From Task Pad, select Pricing Strategy > Create Pricing Strategy. The Create
Pricing Strategy workspace opens.

%5 Create Pricing Strategy

I-(_: Strategy Maintenance ‘

Tepe [ select - =]

cancel |[_save + Repeat ][ _Dons

Create Pricing Strategy Workspace
1. In the Type field, select Area Differential.
2. Click Next. Additional fields appear.

I(:' Strategy Maintenance

| Cefine Secondary Areas ||

Strategy Maintenance pane
3. Enter the ID of the merchandise level you want to apply the area differential to, or
click the LOV &l button and select the appropriate merchandise level.

Note: You must enter a department. Subsequent
merchandise levels are enabled as you add the level above, if
the definition of the department in the aggregation level
dialog allows it.

4. Select the zones that define the primary area:
= Zone Group: Enter the ID of the zone group that contains the locations to add to
the area differential price strategy, or click the LOV &l button and select a zone
group.
= Zone: Enter the ID of the zone to add to the area differential price strategy, or
click the LOV = button and select a zone.
5. Click Define Secondary Areas. The Area Differential Strategy Details pane opens.
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(@ Area Differential stategy Details \

Zone Id Zone Name Differential Percent Auto Approve Price Guide |

m
Ll

i

gancel || save + Repeat [[ Done

Area Differential Strategy Details Pane

Define Secondary Areas

1.
2.

Click New to enable the fields.

In the Price Zone field, enter the ID of the zone that you want to add to the secondary
area of the area differential price strategy, or click the LOV & button and select a
zone.

In the Price Guides field, enter the ID of the price guide you want to apply to the
differential pricing, or click the LOV & button and select a price guide.

Note: Only price guides associated with the selected
departments can be selected.

In the Differential field, select how the price differs from the primary area:

= Price Higher: The items at the specified secondary area are priced higher by the
percentage entered in the Percent field.

= Price Lower: The items at the specified secondary area are priced lower by the
percentage entered in the Percent field.

= Price Equal: The items at the specified secondary area are priced the same as the
items in the primary area.

In the Percent field, enter the percent by which the secondary area price is different

from the primary area price.

Select the Auto Approve check box to indicate price changes for the area differential

should be created in Approved status.

Exclude Items From the Area Differential

Note: Expand the Item Exclusion section of the Area
Differentials pane to complete the procedure.

Enter or select criteria ID of the items you want to exclude.

Click Add. The information is added to the item exclusion table.

To remove an item from the item exclusion table:

a. Select an item.

b. Click Remove. The item is removed from the item exclusion table.
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Complete the Area Differential
1. Click Apply. Any changes are added to the table
2. Click Done to save your changes and close the window.

Edit an Area Differential Price Strategy
Navigate: From Task Pad, select Pricing Strategy > Maintain Pricing Strategy. The
Maintain Pricing Strategy workspace opens.

1. In the Pricing Strategy Search pane, enter criteria as needed to find the pricing
strategy you want to edit.

I'/G‘ Pricing Strategy Search

Price Strateqy Id | Type Area Differential %+ Area Differential

Clazs .+ Zone .+

Subclass .+
Calendar Status |- Select - E‘

| [ciser | Lsearen ||
Pricing Strategy Search Pane

2. Click Search. The results of your search are listed in the Pricing Strategies List pane.

I@ Pricing Strategies List |

Pricing Strategies List | &
Price Strategy Department If Department | Class Id Class Subclass Id | Subclass Zone Group | Zone Group Id Zone £
Fitber by | ||| Fitter by | ||| Fitber bp:| TN Filber by:| T N| Fitber by | ®||| Fitker by | ®||| Fitker by:| T ||| Fitker by:| T ||| Fitter by | T ||| Fitter by T A

1942 S51|QA2 Dept

2001 50(QAl Dept

2022 50(QAl Dept

1061 50(QAl Dept s0|qal Class 50{QA1 SubCla..

1062 11|iscqa_inteqr.. 1|iscqa_inteqr.. 1|iscqa_inteqr..

1 51|QAz Dept S511|qaz Class S5111[0A2 SubCla.

1943 S1|QAZ Dept S11{QAZ Class SEZZ|QAZ SubCla..,

2023 50(QAl Dept s0|qal Class 50{QA1 SubCla..,

2002 50|QA1 Dept 50|QAL Class 50|QA1 SubCla..,

2003 50(QAl Dept s0|qal Class 50{QA1 SubCla..,

2004 3|test3 1|test3 2|testl

2005 50(QAl Dept s0|qal Class 50{QA1 SubCla..

2041 1414(Activewear 1000|Sports Clath.., 1000(Mens Sparts..,
4 »

| [oetete |[_ear |

Pricing Strategies List Pane

3. From the Pricing Strategies List, select the strategy you want to edit.
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4. Click Edit, or double-click the strategy selected. The Strategy Maintenance pane
opens, and the fields that can be changed are enabled.

I-"Cf_‘ Strategy Maintenance
Discount Percent l:l
Add Row
I &
Markdown Number Discount Percent Days after First
| Edit || Fernove Markdown

Strategy Maintenance Pane
5. Make necessary changes.

Remove a Zone From an Area Differential Strategy
1. Select the zone you want to delete.

2. C(Click Delete. The zone is removed from the table

Exclude Items From the Area Differential

Note: Expand the Item Exclusion section of the Area
Differentials pane to complete the procedure.

1. Enter or select criteria ID of the items you want to exclude.
Click Add. The information is added to the item exclusion table.
To remove an item from the item exclusion table:
a. Select an item.
b. Click Remove. The item is removed from the item exclusion table.

Complete the Area Differential
1. Click Apply. Any changes are added to the table

2. Click Done to save your changes and close the window.
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Clearance Pricing

A clearance pricing strategy allows you to define the method used to markdown items.

Create a Clearance Pricing Strategy
Navigate: From Task Pad, select Pricing Strategy > Create Pricing Strategy. The Create

Pricing Strategy workspace opens.

%5 Create Pricing Strategy

I-'(—" Strategy Maintenance

e

Tepe |- se

cancel_|[_save + Repeat |[_Don=

Create Pricing Strategy Workspace
1. In the Type field, select Clearance.
2. Click Next. Additional strategy fields appear.

I(: Strategy Maintenance

Cefine Stratagy Details

Clearance strategy fields
Enter the ID of the merchandise level you want to apply the strategy to, or click the

LOV & button and select the appropriate merchandise level.

Note: You must enter a department. Subsequent
merchandise levels are enabled as you add the level above, if
the definition of the department in the aggregation level

dialog allows it.

4. Select the zones for the strategy:
Zone Group: Enter the ID of the zone group that contains the locations to add to

the price strategy, or click the LOV & button and select a zone group.
Zone: Enter the ID of the zone to add to the price strategy, or click the LOV

button and select a zone.
In the Price Guides field, enter the ID of the Price Guide field, or click the LOV

5.
button and select a price guide.
Note: Only price guides associated with the selected
departments can be selected.
6. In the Calendar field, enter the ID of the calendar you want to associate with the

strategy, or click the LOV & button and select a calendar.
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In the Suspend field, select the check box to indicate that reviews of the existing
strategy are stopped.

Note: Clear the check box to indicate the review periods
should begin with the next review period.

In the New Calendar field, enter the ID of the calendar you want to associate with the
strategy, or click the LOV E button and select a calendar.

Note: You must select the Suspend check box before you can
add a new calendar.

Click Define Strategy Details. The Clearance Strategy Details pane opens.

|(: tlearance Strategy Details

Markdown Percent  [Regular Price

Clearance Strategies ” &;

Markdowvm Number Discount Percent |

Clearance Strategy Details Pane

Define Clearance Strategy Details

1.

In the Markdown Percent field, select the price from which the clearance price is
calculated.

Click Add Row.
In the Discount Percent field, enter the percent of the markdown.
Click Apply.

Note: If the price from which the clearance price is calculated
is Regular Retail, the Discount Percent fields must increase
with each markdown added.
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Edit a Clearance Price Strategy

Navigate: From Task Pad, select Pricing Strategy > Maintain Pricing Strategy. The

Maintain Pricing Strategy workspace opens.

1. In the Pricing Strategy Search pane, enter criteria as needed to find the pricing

strategy you want to edit.

I@ Pricing Strategy Search

Price Strategy Id |

Clazz l.-F
Subclazs .+
Calendar Status |- Select - E

Type

Zone

B8+

oo Lo ]|

Pricing Strategy Search Pane

2. Click Search. The results of your search are listed in the Pricing Strategies List pane.

I@ Pricing Strategies List

Pricing Strategies List | &
Price Strategy Department If Department | Class Id Class Subclass Id | Subclass Zone Group | Zone Group Id Zone £
Fitber by | ||| Fitter by | ||| Fitber bp:| TN Filber by:| T N| Fitber by | ®||| Fitker by | ®||| Fitker by:| T ||| Fitker by:| T ||| Fitter by | T ||| Fitter by T A

1942 S51|QA2 Dept

2001 50(QAl Dept

2022 50(QAl Dept

1061 50(QAl Dept s0|qal Class 50{QA1 SubCla..

1062 11|iscqa_inteqr.. 1|iscqa_inteqr.. 1|iscqa_inteqr..

1 51|QAz Dept S511|qaz Class S5111[0A2 SubCla.

1943 S1|QAZ Dept S11{QAZ Class SEZZ|QAZ SubCla..,

2023 50(QAl Dept s0|qal Class 50{QA1 SubCla..,

2002 50|QA1 Dept 50|QAL Class 50|QA1 SubCla..,

2003 50(QAl Dept s0|qal Class 50{QA1 SubCla..,

2004 3|test3 1|test3 2|testl

2005 50(QAl Dept s0|qal Class 50{QA1 SubCla..

2041 1414(Activewear 1000|Sports Clath.., 1000(Mens Sparts..,

b

[osiete |[_ear_|

Pricing Strategies List Pane

3. From the Pricing Strategies List, select the strategy you want to edit.

Click Edit, or double-click the strategy selected. The Strategy Maintenance pane
opens, and the fields that can be changed are enabled.
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I/(J Strategy Maintenance |
Discount Percent l:l
I &,
Markdown Number Discount Percent Days after First
| Edit || Fernove Markdown

Strategy Maintenance Pane
5. Make necessary changes.

Edit a Price Guide

Change or enter a price guide name, or click the LOV B button and select the appropriate
price guide if necessary.

Change Calendars

Note: In order to specify a new calendar, the existing
calendar must be suspended.

1. Select the Suspend check box.
2. Enter a calendar name, or click the LOV B button and select a calendar.

Edit a Markdown

1. Select the Markdown number from the Clearance Strategies table.
Click Edit. The Discount Percent field is enabled.

Edit the discount percent.

Click Apply.

Db

Delete a Markdown

1. Select the highest Markdown number from the Clearance Strategies table.
2. Click Remove Markdown.

3. Click Apply.
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Clearance Defaults Pricing

A clearance defaults pricing strategy allows you to set up a strategy for generating
subsequent markdowns after an initial clearance event.

Create a Clearance Defaults Pricing Strategy

Navigate: From Task Pad, select Pricing Strategy > Create Pricing Strategy. The Create
Pricing Strategy workspace opens.

%9 create Pricing Strategy

I(: Strategy Maintenance

Tibe [feea- 3]

cancel |[_save +Repeat |[_Done |

Create Pricing Strategy Workspace
1. In the Type field, select Clearance Defaults.

2. Click Next. Additional strategy fields appear.

I-"(_:' Shrategy Maintenance

| Cefine Strategy Details ||

Clearance Defaults strategy fields
3. Enter the ID of the merchandise level you want to apply the strategy to, or click the
LOV & button and select the appropriate merchandise level.

Note: You must enter a department. Subsequent
merchandise levels are enabled as you add the level above, if

the definition of the department in the aggregation level
dialog allows it.

4. Click Define Strategy Details. The Clearance Defaults Strategy Details pane opens.

I(:' clearance Strategy Details

Discount Percent

Days after First

1

Reset Price this many days after out of stack date Add Row Apply
I &

Markdown Number | Discount Percent Days after First

Clearance Defaults Strategy Details Pane
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Define Clearance Strategy Details

1. Enter the percent of the first markdown after the initial markdown in the Discount
Percent field.

2. Enter how many days after the first markdown that this markdown should be taken
in the Days after First field.

3. Enter when to reset the price to regular price in the Reset Price this many days after
out of stock date field.

4. Click Apply. A row is added to the table.

Add Subsequent Markdowns
1. Click Add Row.

2. Enter a percent in the Discount Percent field.

Note: Subsequent markdown percents must be greater than
the previous.

3. Enter a number of days in the Days after First field.
4. Click Apply. The markdown is added to the table.

7= Clearance Strategy Details
(&

Add Row
ll
Markdown Number Discount Percent Days after First
1 10%|5
2 15910

Clearance Defaults Strategy Details pane with markdowns
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Edit a Clearance Defaults Price Strategy

Navigate: From Task Pad, select Pricing Strategy > Maintain Pricing Strategy. The

Maintain Pricing Strategy workspace opens.

1. In the Pricing Strategy Search pane, enter criteria as needed to find the pricing

strategy you want to edit.

I@ Pricing Strategy Search

Price Strategy Id |

Class l._p

Subclazsz .+
Calendar Status |- Select - E

Tupe

Zone

ICIearance Defaul %+ Clearance Defaul

B

oo Lo ]|

Pricing Strategy Search Pane

2. Click Search. The results of your search are listed in the Pricing Strategies List pane.

I@ Pricing Strategies List

Pricing Strategies List | &
Price Strategy Department If Department | Class Id Class Subclass Id | Subclass Zone Group | Zone Group Id Zone £
Fitber by | ||| Fitter by | ||| Fitber bp:| TN Filber by:| T N| Fitber by | ®||| Fitker by | ®||| Fitker by:| T ||| Fitker by:| T ||| Fitter by | T ||| Fitter by T A

1942 S51|QA2 Dept

2001 50(QAl Dept

2022 50(QAl Dept

1061 50(QAl Dept s0|qal Class 50{QA1 SubCla..

1062 11|iscqa_inteqr.. 1|iscqa_inteqr.. 1|iscqa_inteqr..

1 51|QAz Dept S511|qaz Class S5111[0A2 SubCla.

1943 S1|QAZ Dept S11{QAZ Class SEZZ|QAZ SubCla..,

2023 50(QAl Dept s0|qal Class 50{QA1 SubCla..,

2002 50|QA1 Dept 50|QAL Class 50|QA1 SubCla..,

2003 50(QAl Dept s0|qal Class 50{QA1 SubCla..,

2004 3|test3 1|test3 2|testl

2005 50(QAl Dept s0|qal Class 50{QA1 SubCla..

2041 1414(Activewear 1000|Sports Clath.., 1000(Mens Sparts..,

b

[osiete |[_ear_|

Pricing Strategies List Pane

3. From the Pricing Strategies List, select the strategy you want to edit.

Click Edit, or double-click the strategy selected. The Strategy Maintenance pane
opens, and the fields that can be changed are enabled.
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I@ Strategy Maintenance |
|
a
"
Discount Percent l:l
I
Markdown Number Discount Percent Days after First
| Edit || Fernove Markdown
Strategy Maintenance Pane
5. Make necessary changes.
Add Subsequent Markdowns
1. Select which row you want to add the markdown before.
2. Click Add Row.
3. Enter a percent in the Discount Percent field.
Note: Subsequent markdown percents must be greater than
the previous percents.
Enter a number of days in the Days after First field.
5. Click Apply. The markdown is added to the table.
I@ Clearance Strategy Details
[
Markdown Number Discount Percent Days after First
1 10%|5
2 15910

Clearance Defaults Strategy Details pane with markdowns
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Edit a Markdown

1. Select the Markdown number from the Clearance Strategies table.

2. Click Edit. The Discount Percent and Days after First fields are enabled.
3. Edit the discount percent and days after first values.

4. Click Apply.

Delete a Markdown

1. Select the highest markdown number from the Clearance Strategies table.
2. Click Remove Markdown.

3. Click Apply.
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Competitive Pricing

A competitive pricing strategy allows you to define your pricing strategy for items based

on your primary competitor's prices

Note: All locations in a competitive pricing strategy must
use the same currency.

You can also assign reference competitors to a competitive pricing strategy. This
information allows you to compare the proposed prices to the prices available from other
retailers. If the proposed prices vary from the target percentages defined for the reference
competitors, you are informed so you can adjust the price in the pricing worksheet.

Create a Competitive Pricing Strategy
Navigate: From Task Pad, select Pricing Strategy > Create Pricing Strategy. The Create

Pricing Strategy workspace opens.

%5 Create Pricing Strategy

I-'(—" Strategy Maintenance

Type [ select - =

cancel_|[_save + Repeat |[_Don=

Create Pricing Strategy Workspace
1. In the Type field, select Competitive.
2. Click Next. Additional strategy fields appear.

‘(: Strategy Maintenance

=
-
=
.
=l
O — 5

Define Strateqy Details

Competitive strategy fields
Enter the ID of the merchandise level you want to apply the strategy to, or click the

LOV & button and select the appropriate merchandise level.

Note: You must enter a department. Subsequent
merchandise levels are enabled as you add the level above, if
the definition of the department in the aggregation level

dialog allows it.

4. Select the zones for the strategy:
Zone Group: Enter the ID of the zone group that contains the locations to add to
the price strategy, or click the LOV & button and select a zone group.

Zone: Enter the ID of the zone to add to the price strategy, or click the LOV

button and select a zone.
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5. In the Price Guides field, enter the ID of the Price Guide field, or click the LOV
button and select a price guide.

Note: Only price guides associated with the selected
departments can be selected.

6. In the Calendar field, enter the ID of the calendar you want to associate with the
strategy, or click the LOV E button and select a calendar.

7. In the Suspend field, select the check box to indicate that reviews of the existing
strategy are stopped.

Note: Clear the check box to indicate the review periods
should begin with the next review period.

8. In the New Calendar field, enter the ID of the new calendar you want to associate
with the strategy, or click the LOV & button and select a calendar.

Note: you must select the Suspend check box before you can
add a new calendar.

9. Click Define Strategy Details. The Competitive Strategy Details pane opens.

@ Competitive Strategy Details
L

compete Tipe fraen 7]

- Reference Competitors

Competitor Competitor Store Compete Type Percent

m 0o a P I
[

M [ [0 [0 D

= = = = =

z NEAEAREANE:

= (T | T |7 T

[ [ ] [ [

Competitive Strategy Details Pane

Define Competitive Strategy Details

1. In the Competitor field, enter the ID of the primary competitor or click the LOV
button and select a competitor.

2. In the Competitor Store field, enter the ID of the store that proposed retails are being
compared against.

Note: The currency at the competitor store must be the same
as the zones previously selected.

3. In the Compete Type, select how the price strategy determines the prices:
*  Match: Prices are proposed to be the same as the primary competitor's prices.

= Price Above: Prices are proposed to be a percentage above the primary
competitor's prices.
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=  Price Below: Prices are proposed to be a percentage below the primary
competitor's prices.

= Price by Code: Prices are proposed by the market basket code for the
merchandise hierarchy/zone.

Define Match Strategy Details

1.
2.

Define reference competitors as necessary.

Click Done to save any changes and close the workspace.

Define Price Above or Price Below Strategy Details

1.

In the Compete Percent field, enter the percent above or below the primary
competitor's price that the new price is set at.

Setup the acceptable range:

Note: Acceptable range is the amount by percentage that a
retail price can vary from a primary competitor before a
price change is proposed.

a. In the Acceptable Range From field, enter the bottom of the range.
b. In the Acceptable Range To field, enter the top of the range.
Define reference competitors as necessary.

Click Done to save any changes and close the workspace.

Define Price by Code Strategy Details

1.

In the Code field, select the competitive market basket code you want to use to set
the price.

In the Compete Type, select how the price strategy determines the prices:
*  Match: Prices are proposed to be the same as the primary competitor's prices.

= Price Above: Prices are proposed to be a percentage above the primary
competitor's prices.

=  Price Below: Prices are proposed to be a percentage below the primary
competitor's prices.

In the Compete Percent field, enter the percent above or below the primary
competitor's price that the new price is set at.

Setup the acceptable range:

Note: Acceptable range is the amount by percentage that a
retail price can vary from a primary competitor before a
price change is proposed.

a. Inthe Acceptable Range From field, enter the bottom of the range.
b. In the Acceptable Range To field, enter the top of the range.
Define reference competitors as necessary.

Click Done to save any changes and close the workspace.
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Define Reference Competitors

1. In the Reference Competitors section, enter the ID of the competitor in the
Competitor field, or click the LOV & button and select a competitor.

2. In the Competitor Store field, enter the ID of the store, or click the LOV & button and
select a store.

3. In the Compete Type, select how to compare prices to the reference competitors:

=  Match: A pass or fail indicator appears on the worksheet depending on if the
proposed price matches the referenced competitors price.

= Price Above: A pass or fail indicator appears on the worksheet depending on if
the proposed price is at least the specified percent above the referenced
competitor's price.

= Price Below: A pass or fail indicator appears on the worksheet depending on if
the proposed price is at least the specified percent below the referenced
competitor's price.

4. If you selected Price Above or Price Below, enter the percent above or below the
competitor's price that the new price is compared.

5. Click Done to save any changes and close the workspace.

Create a Competitive Price Strategy Associated with an Area Differential

Note: Expand the Competitor section of the Area
Differentials pane to complete the procedure.

1. In the Competitor field, enter the ID of the competitor or click the LOV E button and
select a competitor.

2. In the Competitor Store field, enter the ID of the store that proposed retails are being
compared against or click the LOV E button and select a store.

Note: The currency at the competitor store must be the same
as the zones previously selected.

3. In the Compete Type, select how the price strategy determines the prices:
=  Match: Prices are proposed to be the same as the competitor's prices.

= Price Above: Prices are proposed to be a percentage above the competitor's
prices.

=  Price Below: Prices are proposed to be a percentage below the competitor's
prices.

= Price by Code: Prices are proposed by the market basket code for the
merchandise hierarchy/zone.

Define Match Strategy Details
1. Define reference competitors as necessary.

2. Click Done to save any changes and close the workspace.
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Define Price Above or Price Below Strategy Details

1.

3.
4.

In the Compete Percent field, enter the percent above or below the competitor's price
that the new price is set at.

Setup the acceptable range:

Note: Acceptable range is the amount by percentage that a
retail price can vary from a competitor before a price change
is proposed.

a. In the Acceptable Range From field, enter the bottom of the range.
b. Inthe Acceptable Range To field, enter the top of the range.
Define reference competitors as necessary.

Click Done to save any changes and close the workspace.

Define Price by Code Strategy Details

1.

In the Code field, select the competitive market basket code you want to use to set
the price.

In the Compete Type, select how the price strategy determines the prices:
*  Match: Prices are proposed to be the same as the competitor's prices.

= Price Above: Prices are proposed to be a percentage above the competitor's
prices.

= Price Below: Prices are proposed to be a percentage below the competitor's
prices.

In the Compete Percent field, enter the percent above or below the competitor's price
that the new price is set at.

Setup the acceptable range:

Note: Acceptable range is the amount by percentage that a
retail price can vary from a competitor before a price change
is proposed.

a. In the Acceptable Range From field, enter the bottom of the range.
b. Inthe Acceptable Range To field, enter the top of the range.
Define reference competitors as necessary.

Click Done to save any changes and close the workspace.

Define Reference Competitors

Note: Expand the Reference Competitor section of the Area
Differentials pane to complete the procedure.

In the Reference Competitors section, enter the ID of the competitor in the
Competitor field, or click the LOV & button and select a competitor.

In the Competitor Store field, enter the ID of the store, or click the LOV E button and
select a store.
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3. In the Compete Type, select how to compare prices to the reference competitors:

Match: A pass or fail indicator appears on the worksheet depending on if the

proposed price matches the referenced competitors price.

Price Above: A pass or fail indicator appears on the worksheet depending on if
the proposed price is at least the specified percent above the referenced

competitor's price.

Price Below: A pass or fail indicator appears on the worksheet depending on if
the proposed price is at least the specified percent below the referenced

competitor's price.

4. If you selected Price Above or Price Below, enter the percent above or below the

competitor's price that the new price is compared.
5. Click Done to save any changes and close the workspace.

Edit a Competitive Pricing Strategy
Navigate: From Task Pad, select Pricing Strategy > Maintain Pricing Strategy. The

Maintain Pricing Strategy workspace opens.

1. In the Pricing Strategy Search pane, enter criteria as needed to find the pricing
strategy you want to edit.

I(:' Pricing 5trategy Search

Price Strategy Id |

Calendar Status |- Selac -

=

Cotear ] Lswaen ||

Pricing Strategy Search Pane

2. Click Search. The results of your search are listed in the Pricing Strategies List pane.

90 Oracle Retail Price Management



Competitive Pricing

@ Pricing Strategies List

Pricing Strategies List | &
Price Strategy Department I{ Department | Class Id Class Subclass Id | Subclass Zone Group | Zone Group Id Zone Z
Fitker by:| || Filber by:| ||| Fitber by | | Fitber by | T| Fitber by | T|| Fitber by | T[] Fitrer by | M| Fitber By | Fitber by ||| Fitver by T || A

1942 51|QA2 Dept

2001 S0/QA1 Dept

2022 S50[Qal Dept

1061 S0/QA1 Dept 50|QAl Class 50/Qa1 SubCla.,

1062 11|izcqa_integr. 1liscqa_inteqgr. 1liscqa_inteqgr.
1 51|QA2 Dept S511|0A2 Class 5111|042 SubCla..

1943 S1|QAZ Dept S511|QAZ Class SEZE|QAZ SubCla..,

2023 S0|QA1 Dept 50|Qal Class 50/Qa1 SubCla.,

2002 50|QAa1 Dept 50|QAl Class 50|QAa1 SubCla..,

2003 S0/QA1 Dept 50|Qal Class 50/Qa1 SubCla.,

2004 3|testd 1|test3 2|testl

2005 S0/QA1 Dept 50|QAl Class 50/Qa1 SubCla.,

2041 1414(Activewear 1000|Sports Clath.., 1000(Mens Sparts..,

b

[osiete |[_cax_]|

Pricing Strategies List Pane
3. From the Pricing Strategies List, select the strategy you want to edit.

4. Click Edit, or double-click the strategy selected. The Strategy Maintenance pane
opens, and the fields that can be changed are enabled.

(G} Strategy Maintenance

Type  |Clearance Defaultle‘

e Cepartrnent
Class

Subclazz

50

S50

50

Discount Percent

Drays after First

B+ [¢21 Dept
B+ o1 class
B+ |24 subclass

[ ]

Resat Price this many days after out of stock date |5 2dd Row
I &
Markdown Number Discount Percent Days after First
| Edit || Fernove Markdown

Strategy Maintenance Pane

5. Make necessary changes.

Edit a Price Guide
Enter the price guide name, or click the LOV B button and select the price guide.
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Change Calendars

Note: In order to specify a new calendar, the existing
calendar must be suspended.

1. Select the Suspend check box.
2. Enter a calendar name, or click the LOV E button and select a calendar

Edit a Competitor

1. In the Competitor field, enter or change the competitor ID, or click the LOV & button
and select the competitor.

2. In the Competitor Store field, enter a competitor store ID, or click the LOV & button
and select the store.

In the Compete Type drop-down, select the compete type.
For Price Above and Price Below compete types, setup the acceptable range:

Note: Acceptable range is the amount by percentage that a
retail price can vary from a competitor before a price change
is proposed.

a. In the Acceptable Range From field, enter the bottom of the range.
b. Inthe Acceptable Range To field, enter the top of the range.

Edit Reference Competitors
Define reference competitors as necessary.

Complete the Competitive Price Strategy
1. Click Save + Repeat to commit your changes.

2. Click Done to save any changes and close the workspace.
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Margin Pricing

A margin pricing strategy allows you to define the pricing strategy for items based on

margin targets.

Create a Margin Pricing Strategy
Navigate: From Task Pad, select Price Strategy > Create Price Strategy. The Create

Pricing Strategy workspace opens.

%9 create Pricing Strategy

I(: Strategy Maintenance

o [

Tepe |- se

cancel || save + Repeat || Done

Create pricing strategy workspace
1. In the Type field, select Margin.
2. Click Next. Additional strategy fields appear.

I(:' Strategy Maintenance

= =
=]

Define Strategy Details

Margin strategy fields
3. Enter the ID of the merchandise level you want to apply the strategy to, or click the

LOV &+ button and select the appropriate merchandise level.

Note: You must enter a department. Subsequent
merchandise levels are enabled as you add the level above, if
the definition of the department in the aggregation level

dialog allows it.

4. Select the zones for the strategy:
Zone Group: Enter the ID of the zone group that contains the locations to add to
the price strategy, or click the LOV & button and select a zone group.

Zone: Enter the ID of the zone to add to the price strategy, or click the LOV &+

button and select a zone.
In the Price Guides field, enter the ID of the Price Guide field, or click the LOV

button and select a price guide.

Note: Only price guides associated with the selected
departments can be selected.
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In the Calendar field, enter the ID of the calendar you want to associate with the
strategy, or click the LOV & button and select a calendar.

In the Suspend field, select the check box to indicate that reviews of the existing
strategy are stopped.

Note: Clear the check box to indicate the review periods
should begin in the next period.

In the New Calendar field, enter the ID of the calendar you want to associate with the
strategy, or click the LOV & button and select a calendar.

Note: you must select the Suspend check box before you can
add a new calendar.

Click Define Strategy Details. The Margin Strategy Details pane opens.

=) Margin Strategy Details
(€

Code n Acceptable Range From l:l

Margin Target l:l Acceptable Range To l:l

Margin Strategy Details (P-4
Code | Margin Target Acceptable Range From | Acceptable Range To |

* Reference Competitors

Carnpatitar Carnpetitar Stora Campate Typs Parcant

N — . e
N —
S — B
S e
S — e

Margin strategy details

Define Margin Strategy Details

1.

In the Code field, select the margin market basket code you want to use to set the
price.

In the Margin Target field, enter the percent of margin you want to earn on the
item/zone.

Setup the acceptable range:

Note: Acceptable range is the amount by percentage that a
margin can vary from the target before a price change is
proposed.

a. In the Acceptable Range From field, enter the bottom of the range.
b. Inthe Acceptable Range To field, enter the top of the range.
Click Apply. An entry is added to the Margin Strategy Details table.
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5. Define reference competitors as necessary.

6. Click Done to save any changes and close the workspace.

Edit a Margin Pricing Strategy

Navigate: From Task Pad, select Pricing Strategy > Maintain Pricing Strategy. The
Maintain Pricing Strategy workspace opens.

1. In the Pricing Strategy Search pane, enter criteria as needed to find the pricing
strategy you want to edit.

I@ Pricing 5trategy Search

Price Strategy Id |

Clazs -+
Subdlass .+

Calendar Status |- Selac -

Calendar

[ |8
[ I8

Mew Calendar

Tupe

Zone

B8+

Coiear ] oo ||

Pricing Strategy Search Pane
2. Click Search. The results of your search are listed in the Pricing Strategies List pane.

I@ Pricing Strategies List

Pricing Strategies List | &
Price Strategy Department If Department | Class Id Class Subclass Id | Subclass Zone Group | Zone Group Id Zone £
Fitber by | ||| Fitter by | ||| Fitber bp:| TN Filber by:| T N| Fitber by | ®||| Fitker by | ®||| Fitker by:| T ||| Fitker by:| T ||| Fitter by | T ||| Fitter by T A

1942 S51|QAz Dept

2001 50(QAl Dept

2022 50(QAl Dept

1061 50(QAl Dept s0|qal Class 50{QA1 SubCla..

1062 11|izcqa_integr. 1liscqa_inteqgr. 1liscqa_inteqgr.

1 51|QAz Dept S511|qaz Class S5111[0A2 SubCla.

1943 S1|QAZ Dept S11{QAZ Class SEZZ|QAZ SubCla..,

2023 50(QAl Dept s0|qal Class 50{QA1 SubCla..,

zo0z 50(QAl Dept s0|qal Class 50{QA1 SubCla..

2003 50(QAl Dept s0|qal Class 50{QA1 SubCla..,

2004 3|test3 1|test3 2|testl

2005 50(QAl Dept s0|qal Class 50{QA1 SubCla..

2041 1414(Activewear 1000|Sports Clath.., 1000(Mens Sparts..,

b

[osiete |[_cax_]|

Pricing Strategies List Pane

3. From the Pricing Strategies List, select the strategy you want to edit.

4. Click Edit, or double-click the strategy selected. The Strategy Maintenance pane
opens, and the fields that can be changed are enabled.
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I@ Strategy Maintenance

8
|
8
Dizcount Percent l:l
I &,
Markdown Number Discount Percent Days after First
| Edit || Remaove Markdown
Strategy Maintenance Pane
5. Make necessary changes.
Edit a Price Guide
Enter the price guide name or click the LOV & button and select the appropriate price
guide.

Change Calendars

Note: In order to specify a new calendar, the existing
calendar must be suspended.

1. Select the Suspend checkbox.
2. Enter a calendar name, or click the LOV & button and select a calendar

Edit Margin Details
1. Select a row in the Margin Strategy Details table.

2. In the Margin Target field, enter the percent of margin you want to earn on the
item/zone.

Note: Acceptable range is the amount by percentage that a
margin can vary from the target before a price change is
proposed.

In the Acceptable Range From field, enter the bottom of the range.
. In the Acceptable Range To field, enter the bottom of the range.
5. Click Apply.

Delete Margin Details
1. Select the margin detail from the Margin Strategy Details table.
2. (Click Delete. The row is removed from the table.
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Edit Reference Competitors
Define reference competitors as necessary.

Complete the Margin Price Strategy
1. Click Save + Repeat to commit your changes.

2. Click Done to save any changes and close the workspace.
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Maintain Margin Pricing
A maintain margin pricing strategy allows you to define the pricing strategy for items
based on future cost changes. The proposed retails can be based on current or market
basket margin percentages. Reference competitors may be assigned for comparison

purposes.

Create a Maintain Margin Pricing Strategy
Navigate: From Task Pad, select Pricing Strategy > Create Pricing Strategy. The Create
Pricing Strategy workspace opens.

B9 Create Pricing Strategy

I-'(: Strategy Maintenance

Type [ Select- =]

Sancel || Save + Repeat |[ Dane

Create Pricing Strategy Workspace
1. In the Type field, select Maintain Margin.

2. Click Next. Additional strategy fields appear.

I(:' Strategy Maintenance

Cefine Strategy Details |

Maintain margin strategy fields
3. Enter the ID of the merchandise level you want to apply the strategy to, or click the

LOV & button and select the appropriate merchandise level.

Note: You must enter a department. Subsequent
merchandise levels are enabled as you add the level above, if
the definition of the department in the aggregation level

dialog allows it.

4. Select the zones for the strategy:
Zone Group: Enter the ID of the zone group that contains the locations to add to
the price strategy, or click the LOV & button and select a zone group.

Zone: Enter the ID of the zone to add to the price strategy, or click the LOV

button and select a zone.
In the Price Guides field, enter the ID of the Price Guide field, or click the LOV

button and select a price guide.

5.

Note: Only price guides associated with the selected
departments can be selected.
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In the Calendar field, enter the ID of the calendar you want to associate with the
strategy, or click the LOV & button and select a calendar.

In the Suspend field, select the check box to indicate that reviews of the existing
strategy are stopped.

Note: Clear the check box to indicate the review periods
should begin in the next period.

In the New Calendar field, enter the ID of the calendar you want to associate with the
strategy, or click the LOV & button and select a calendar.

Note: You must select the Suspend check box before you can
add a new calendar.

Click Define Strategy Details. The Margin Strategy Details pane opens.

I'(_:' Maintain Margin Strategy Details

Auto Approve [ ¥ Cost Change Forward Days “ |

* WMethod () Market Basket Margin

f | Current Margin

* Reference Competitors

Competitor Competitor Store Compete Type Percent

[ 8 S
= 8
S = = praten [
o [ |8 [
e[ 18 B paten [

Maintain margin strategy details

Define Maintain Margin Strategy Details

1.

Select the Auto Approve check box to indicate price changes should be created in
Approved status.

In the Cost Change Forward Days, enter the number of days into the next review
period that the strategy will consider cost changes when proposing price changes.

Note: Cost Change Forward Days should not exceed the
length of a review period.
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3. Select the method for the strategy:

= Market Basket Margin: Select to have the margin for the item's market basket
applied to the item's new cost. The Margin Strategy Details area appears.

I@ Maintain Margin $trategy Details |

Autn Approve [ * cast Change Forward Days | |

* Method (@) |[Mark et Basket Margin

{ i JCurrent Margin

S o S
Margin Strategy Details ("3
Code Margin Target Acceptable Range From Acceptable Range To |

+ Reference Competitors

Cornpetitor Competitor Store Compete Type Percent
N B a3

N = B
o[ 18 |
o[ 18 B ot [3]

[ 1= B pratcn [~

Margin strategy details
= Current Margin: Select to have the current margin applied to the item's new cost.
The current margin fields enable.

I@ Maintain Margin Strategy Details

Aute Approve [ ¥ Cast Change Farward Days
* Method () Market Basket Margin Incraase () Margin %
(®)|Current Margin (") Change by Cost Change Amount
Decrease (7} Margin %

() Change by Cost Change Amount

* Reference Competitors

Carnpetitor Campetitor Store Compete Type Parcant
A 1S m
[ |8 B
] B
s B
S = B .

Current margin increase and decrease fields

Define Market Basket Margin

1. In the Code drop-down, select the margin market basket code you want to use to set
the price.

2. Inthe Margin Target field, enter the percent of margin you want to earn on the
item/zone.

3. Setup the acceptable range:
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Note: Acceptable range is the amount by percentage that a
margin can vary from the target before a price change is
proposed.

a. Inthe Acceptable Range From field, enter the bottom of the range.
b. Inthe Acceptable Range To field, enter the top of the range.

Click Apply. An entry is added to the Maintain Strategy Details table.
Define reference competitors as necessary.

Click Done to save any changes and close the workspace.

Define Current Margin

1.

3.

Select how the strategy will apply an increase in margin to a proposed retail:

= Margin %: Select to have the percent of the cost change added to the basis retail
to determine the proposed retail.

= Change by Cost Change Amount: Select to have the amount of the cost change
added to the basis retail.

Select how the strategy will apply a decrease in margin to a proposed retail:

= Margin %: Select to have the percent of the cost change subtracted from the basis
retail to determine the proposed retail.

= Change by Cost Change Amount: Select to have the amount of the cost change
subtracted from the basis retail.

Click Done to save any changes and close the workspace.

Define Reference Competitors

1.

In the Reference Competitors section, enter the ID of the competitor in the
Competitor field, or click the LOV & button and select a competitor.

In the Competitor Store field, enter the ID of the store, or click the LOV & button and
select a store.

In the Compete Type, select how to compare prices to the reference competitors:

=  Match: A pass or fail indicator appears on the worksheet depending on if the
proposed price matches the referenced competitors price.

= Price Above: A pass or fail indicator appears on the worksheet depending on if
the proposed price is at least the specified percent above the referenced
competitor's price.

=  Price Below: A pass or fail indicator appears on the worksheet depending on if
the proposed price is at least the specified percent below the referenced
competitor's price.

If you selected Price Above or Price Below, enter the percent above or below the

competitor's price that the new price is compared.

Click Done to save any changes and close the workspace.
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Edit a Maintain Margin Pricing Strategy

Navigate: From Task Pad, select Pricing Strategy > Maintain Pricing Strategy. The

Maintain Pricing Strategy workspace opens.

1. In the Pricing Strategy Search pane, enter criteria as needed to find the pricing

strategy you want to edit.

I@ Pricing Strategy Search

Price Strategy Id |

Class l.+

Subclazs .+
Calendar Status |- Select - lzl

Tupe

Zone

Maintain Margin %+ Maintain Margin

B8+

oo Lo ]|

Pricing Strategy Search Pane

2. Click Search. The results of your search are listed in the Pricing Strategies List pane.

I@ Pricing Strategies List

Pricing Strategies List | &
Price Strategy Department If Department | Class Id Class Subclass Id | Subclass Zone Group | Zone Group Id Zone £
Fitber by | ||| Fitter by | ||| Fitber bp:| TN Filber by:| T N| Fitber by | ®||| Fitker by | ®||| Fitker by:| T ||| Fitker by:| T ||| Fitter by | T ||| Fitter by T A

1942 S51|QA2 Dept

2001 50(QAl Dept

2022 50(QAl Dept

1061 50(QAl Dept s0|qal Class 50{QA1 SubCla..

1062 11|iscqa_inteqr.. 1|iscqa_inteqr.. 1|iscqa_inteqr..

1 51|QAz Dept S511|qaz Class S5111[0A2 SubCla.

1943 S1|QAZ Dept S11{QAZ Class SEZZ|QAZ SubCla..,

2023 50(QAl Dept s0|qal Class 50{QA1 SubCla..,

2002 50|QA1 Dept 50|QAL Class 50|QA1 SubCla..,

2003 50(QAl Dept s0|qal Class 50{QA1 SubCla..,

2004 3|test3 1|test3 2|testl

2005 50(QAl Dept s0|qal Class 50{QA1 SubCla..

2041 1414(Activewear 1000|Sports Clath.., 1000(Mens Sparts..,

b

[osiete |[_ear_|

Pricing Strategies List Pane

3. From the Pricing Strategies List, select the strategy you want to edit.

Click Edit, or double-click the strategy selected. The Strategy Maintenance pane
opens, and the fields that can be changed are enabled.
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Maintain Margin Pricing

I@ Strategy Maintenance |
Discount Percent l:l
I &
Markdown Number Discount Percent Days after First
| Edit || Fernove Markdown

Strategy Maintenance Pane
5. Make necessary changes.

Edit a Price Guide
Enter the price guide name, or click the LOV & button and select the price guide.

Change Calendars

Note: In order to specify a new calendar, the existing
calendar must be suspended.

1. Select the Suspend check box.
2. Enter a calendar name, or click the LOV & button and select a calendar

Edit Maintain Margin Details

1. Select the Auto Approve check box to indicate that price changes should be created
in Approved status.

2. In the Cost Change Forward Days, enter the number of days into the next review
period that the strategy will consider cost changes when proposing price changes.

Note: Cost Change Forward Days should not exceed the
length of a review period.
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Maintain Margin Pricing

3. Select the method for the strategy:

= Market Basket Margin: Select to have the margin for the item's market basket
applied to the item's new cost. The Margin Strategy Details area appears.

Auto Approve |:| * Cost Change Forward Days |2 |

* Method (@) |Market Basket Margin

| ! Current Margin

N " T
Margin Strategy Details " @;
Code Margin Target Acceptable Range From Acceptable Range To |

Margin Strategy Details
=  Current Margin: Select to have the current margin applied to the item's new cost.

Edit Market Basket Margin
1. Inthe Code drop-down, select the margin market basket code you want to use to set
the price.

2. In the Margin Target field, enter the percent of margin you want to earn on the
item/zone.

3. Setup the acceptable range:

Note: Acceptable range is the amount by percentage that a
margin can vary from the target before a price change is
proposed.

a. In the Acceptable Range From field, enter the bottom of the range.
b. Inthe Acceptable Range To field, enter the top of the range.

Click Apply. An entry is added to the Maintain Strategy Details table.
Define reference competitors as necessary.

6. Click Done to save any changes and close the workspace.

Edit Current Margin
1. Select how the strategy will apply an increase in margin to a proposed retail:

=  Margin %: Select to have the percent of the cost change added to the basis retail
to determine the proposed retail.

= Change by Cost Change Amount: Select to have the amount of the cost change
added to the basis retail.
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Delete a Pricing Strategy

2. Select how the strategy will apply a decrease in margin to a proposed retail:

= Margin %: Select to have the percent of the cost change subtracted from the basis
retail to determine the proposed retail.

= Change by Cost Change Amount: Select to have the amount of the cost change
subtracted from the basis retail.

3. Click Done to save any changes and close the workspace.

Edit Reference Competitors
Define reference competitors as necessary.

Complete the Margin Price Strategy
1. Click Save + Repeat to commit your changes.

2. Click Done to save any changes and close the workspace.

Delete a Pricing Strategy

Navigate: From Task Pad, select Pricing Strategy > Maintain Pricing Strategy. The

Maintain Pricing Strategy workspace opens.

1. In the Pricing Strategy Search pane, enter criteria as needed to find the pricing
strategy you want to delete.

I(:' Pricing Strategy Search

Price Strategy Id | Tepe Clearance Defaul +
=

Calendar Status |- Select - E‘

| Coiear | Csmamn ]|

Pricing Strategy Search Pane
2. Click Search. The results of your search are listed in the Pricing Strategies List pane.

User Guide 105



Delete a Pricing Strategy

@ Pricing Strategies List

Pricing Strategies List | &
Price Strategy Department I{ Department | Class Id Class Subclass Id | Subclass Zone Group | Zone Group Id Zone 2
Fitker by:| || Filber by:| ||| Fitber by | | Fitber by | T| Fitber by | T|| Fitber by | T[] Fitrer by | M| Fitber By | Fitber by ||| Fitver by T || A

1942 S51|QAz Dept

2001 50(QAl Dept

2022 S50[Qal Dept

1061 50(QAl Dept s0|qal Class 50{QA1 SubCla..

1062 11|izcqa_integr. 1liscqa_inteqgr. 1liscqa_inteqgr.

1 51|QAz Dept S511|qaz Class S5111[0A2 SubCla.

1943 S1|QAZ Dept S511|QAZ Class SEZE|QAZ SubCla..,

2023 50(QAl Dept s0|qal Class 50{QA1 SubCla..,

zo0z 50(QAl Dept s0|qal Class 50{QA1 SubCla..

2003 50(QAl Dept s0|qal Class 50{QA1 SubCla..,

2004 3|testd 1|test3 2|testl

2005 50(QAl Dept s0|qal Class 50{QA1 SubCla..

2041 1414(Activewear 1000|Sports Clath.., 1000(Mens Sparts..,

b

[osiete |[_cax_]|

Pricing Strategies List Pane

Click Yes.

A U S
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Click Done to close the window.

Click Delete. You are prompted to confirm your decision.

From the Pricing Strategies List, select the strategy you want to delete.



6

Worksheets

RPM uses strategies, calendars, and item/location information to automatically generate
worksheets. The Worksheet functionality allows you to maintain the proposed price
changes automatically generated by RPM.

The worksheet may contain many different columns.

Worksheet Detail

The Worksheet Detail workspace allows you to:

Review the auto generated price change proposals.

Review items that met rules or were exceptions.

Make clearance decisions.

Delete the Pricing Worksheet if no price changes need to be made.

Examine the information about price change proposals and make decisions about
which items to change and what retail prices to set.

Modify column values.

Perform what-if analysis on the Worksheet to help you make the best pricing
decisions.

Export the worksheet to a Comma Separated Value (csv) file that can be opened in
other applications such as spreadsheets and work processors.

Worksheet Columns

The worksheet may contain many different columns. See the descriptions and
calculations for each column below.

Column Description Editable | Calculation
% off Regular The percent difference No Price Change Amount divided by
Retail between the basis regular Basis Regular Retail (Before VAT)

retail and the new retail of

Depending on your aggregation
the item.

level settings:
Price Change Amount = Current
Retail - New Retail

Price Change Amount = New Retail
- Current Retail

The zone level regular retail is used
if it exists.
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Worksheet Columns

Column Description Editable | Calculation
% off Basis Retail | The percent difference No Price Change Amount divided by
between the basis retail Basis Retail (Before VAT)
(regular or cliearance.) and Price Change Amount equals the
the new retail of the item. difference between the New Retail
This value is the same as and the Clearance or Regular Retail
% off Regular Retail if
there is no clearance retail. Depending on your aggregation
level settings:
Price Change Amount = Current
Retail - New Retail
Price Change Amount = New Retail
- Current Retail
The zone level clearance retail is
used if it exists.
Base Cost The base cost of the item No When the record is at a zone level,
on the effective date the zone level base cost is used in
(including price change the calculation if one exists.
processing days).
Basis Cost The pricing cost of the No When the record is at a zone level,
item on the effective date the zone level basis cost is used in
(including price change the calculation if one exists.
processing days).
Class ID The class hierarchy ID of [ No
the item's class.
Class Description | The name of the class. No
Clearance Checked and disabled if Yes
Indicator the item is on active
clearance. Unchecked if
the item is not on
clearance.
Clearance Hyperlink that opens a No
window with details on
approved clearances.
"Pending" appears if the
item is on a pending
clearance.
Competitor A "Pass" appears if thereisa | No
Alert competitor A and the
strategy rules is met. "Fail"
appears if the strategy rule
is not met.
Competitor A Competitor A's retail No
Retail price.
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Worksheet Columns

Column Description Editable | Calculation
Competitor B "Pass" appears if thereisa | No
Alert competitor B and the
strategy rules is met. "Fail"
appears if the strategy rule
is not met.
Competitor B Competitor B's retail price. | No
Retail
Competitor C "Pass" appears if thereisa |No
Alert competitor C and the
strategy rules is met. "Fail"
appears if the strategy rule
is not met.
Competitor C Competitor C's retail price. | No
Retail
Competitor D "Pass" appears if thereisa |No
Alert competitor D and the
strategy rules is met. "Fail"
appears if the strategy rule
is not met.
Competitor D Competitor D's retail No
Retail price.
Competitor E "Pass" appears if thereisa | No
Alert competitor E and the
strategy rules is met. "Fail"
appears if the strategy rule
is not met.
Competitor E Competitor E's retail price. | No
Retail
Conflict An exclamation point No When conflict checking is run again
appears if conflicts were or the price change is taken or not
found during conflict taken, the column is reset.
checking.
Cost Changes "Yes" appears if there are | No
During Review approved cost changes
Period that have an effective date
during the review period
of the worksheet.
Current Clearance | The clearance retail for No The zone level clearance retail
Retail today if the item is on appears if it exits.
clearance.
Current Clearance | The unit of measure for No
Retail UOM the item clearance price.
Basis Retail The active retail (regular | No The zone level basis retail appears
or clearance) on the if it exists.
effective date before the
current price change.
Basis Retail UOM | The unit of measure for No

the item basis retail.
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Column Description Editable | Calculation
Basis Retail Multi- | The active multi-unit retail | No The zone level multi-unit retail
units on the effective date before appears if it exists.
the current price change.
Basis Multi-unit The active multi-unit retail | No
Retail on the effective date before
the current price change.
Basis Multi-unit The unit of measure for No
Retail UOM the active multi-unit retail
on the effective date before
the current price change.
Current Cost The pricing cost today. No
Current Cost The cost markup of the No Current Retail (regular or clearance,
Markup %. item based on current cost before VAT) minus Current Cost
and current retail. divided by Current Cost.
The zone level current cost is used
if it exists.
Current Retail The retail markup of the No Current Retail (regular or clearance,
Markup % item based on current cost before VAT) minus Current cost
and current retail. divided by Current Retail.
The zone level current cost is used
if it exists.
Current Multi- The unit value of the No The primary zone current multi-
Units multi-unit retail price. units will appear if it exists.
For example: "2 ea." if
there is a 2 for $5 multi-
unit retail.
Current Multi- The retail value of the No
units Retail multi-unit retail price.
For example: "$5.00" if
there is a 2 for $5 multi-
unit retail.
Current Multi- The unit of measure for No
units UOM the item multi-unit.
Current Regular | The item's regular retail No The zone level current retail
Retail value today. appears if it exists.
Current Retail The selling unit of No
UoOM measure for the current
retail.
Current The regular retail value No Current Retail divided by Package
Retail/UOM per unit of measure in the UOM
package today.
For example: ".05/0z" if
there is a 16 oz. can of
soup that retails for .89.
Diff One The differentiator 1 value | No

for a transaction level
item.
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Worksheet Columns

Column Description Editable | Calculation

Diff Two The differentiator 2 value | No
for a transaction level
item.

Diff Three The differentiator 3 value | No
for a transaction level
item.

Diff Four The differentiator 4 value | No
for a transaction level
item.

Effective Date The date that price change | Yes End of Review Period plus Price
goes into effect. Change Processing Days

New Item An indicator appears if the | No

Location Ind item/location is a new
combination in RPM.

First Received The date this item was No

Date first received into the
location.

Historical Sales The monetary historical No The weekly, monthly, half-yearly,
sales of the item based on or yearly historical sales depending
the locations in the row. on aggregation level setting.

Historical Sales The retail sales of the item | No The weekly, monthly, half-yearly,

Units for the current period. or yearly historical sales depending

on aggregation level setting.

Item Description | The name of the item. No

Item ID The transaction or parent | No
item ID.

Last Cost Change | The date of the last cost No
change.

Note: Place the cursor over
this field to show the
average or highest cost of
the item over the locations
in the zone

Last Price Change | The date of last price No
change.

Note: Place the cursor over
this field to show the items
zone price.

Last Received The date the item was | No

Date last received into the
location.

Link Code The link code assigned to | No

the transaction level item.

A hyperlink opens a link
code information window.
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Column

Description

Editable

Calculation

Proposed Retail
Markdown #.

The markdown number if
there is a proposed
clearance price change.

No

Margin Market
Basket Code

The market basket code
for transaction level items
if one exists.

Cost Markup %.
On New Retail

The cost markup of the
item based on new cost
and new retail.

New Retail minus Basis Cost
divided by Basis Cost

The zone level basis cost is used if it
exists.

New Multi-Units

The unit value of the new
multi-unit retail price.

For example: "2 ea." if
there is a 2 for $5 multi-
unit retail.

Yes

New Multi-units
Retail

The retail value of the new

multi-unit retail price.

For example: "$5.00" if
there is a 2 for $5 multi-
unit retail.

Yes

New Multi-units
UOM

The unit of measure of the
new item multi-unit.

For example: ea. if there is
a 2 for $5 multi-unit retail.

Yes

New Retail

The new proposed retail
value for the effective
date.

Edit this field to override
the proposed price.

Yes

New Retail/UOM

The new retail value per
unit of measure.

For example: ".05/0z" if
there is a 16 oz. can of
soup that retails for .89

New Retail divided by the Unit Of
Measure.

New Retail
Markup %.

The percent retail sales
margin of the item based
on the new retail.

New Retail minus New Cost
divided by New Retail (Before
VAT)

The zone level basis cost if used if it
exists.

New Retail UOM

The unit of measure for
the item's new retail.

If you enter a new retail,
New Retail UOM is
required.

Yes

Original Retail

The original retail of the
item.
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Worksheet Columns

Column Description Editable | Calculation
Out of Stock Date | The out of stock day for Yes Default Out of Stock Days after the
clearance price changes. effective date
You can change this field.
Package Size The package size of the No
item.
Package UOM The package unit of No
measure of the item.
Parent ID The parent item ID if the No
worksheet is at transaction
item level and the item has
a parent.
Parent Item The name of the parent No
Description item.
Pending Cost The date of the earliest No
Changes pending cost change for
the item for the primary
supplier.
A hyperlink opens a link
to a window with more
information.
Price Change The monetary value of the | No New Retail minus Basis Retail at
Amount price change for one unit the location
of that item. Depending on your aggregation
level settings:
Price Change Amount = Basis
Retail - New Retail
Price Change Amount = New Retail
- Current Basis
The zone level basis retail is used if
it exists.
Price Change Select "Take" to accept the | Yes
Indicator proposed price change for

the transaction level item
and lock the row for
editing.

Select "Don't Take" to
reject the proposed price
change and lock the row
for editing.
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Column Description Editable | Calculation
Price Changes A hyperlink "NONE" if no | No
price changes exist during
review period.
A hyperlink "Pending" if
price changes exist during
review period. Click the
hyperlink to view pending
price change records.
Note: During the review
period means between
today's date and the end
of the review period.
Primary "Pass" appears if thereisa |No
Competitor Alert | primary competitor and
the strategy rules is met.
"Fail" appears if the
strategy rule is not met.
Primary "Yes" when a new or No
Competitor Retail | updated competitor retail
Changed Ind is brought into RPM.
Note: If more than one
strategy uses the same
competitor, "Yes" will only
appear in the worksheet
for the first strategy to find
it.
Primary The primary competitor's | No
Competitor Retail | retail.
Primary The items selling unit of No
Competitor Retail | measure for the primary
UOM. competitor.
Primary The unit value of the No
Competitor Multi- | multi-unit retail price on
Units the most recent shop date.
For example: "2" if there is
a 2 for $5 multi-unit retail
Primary The primary competitor's | No
Competitor Multi- | multi-unit retail with the
Unit Retail number of units on the
most recent shop date.
For example: 2 for $5
Primary The items unit of measure |No
Competitor Multi- | for the multi-unit price on
units UOM. the most recent shop date.
Primary Supplier | The primary supplier ID No

for the item.

Note: Place the cursor over
this field to view the
supplier name.
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Column Description Editable | Calculation
Promotions Hyperlink that opens a No
window with details on
approved current or
pending (after the effective
date of the current price
change) promotions.
Proposed Cost The cost markup of the No Proposed Retail minus Basis Cost
Markup %. item based on proposed divided by Basis Cost.
retail and basis cost. The zone level basis cost is used if it
exists.
Proposed Retail The retail on the proposed | No Proposed Effective Date plus Price
effective date. Prior Create Days
Proposed The proposed retail per No Proposed Retail divided by Package
Retail/UOM unit of measure in the UuoOM
package.
For example: ".05/0z" if
there is a 16 oz. can of
soup that retails for .89
Proposed Retail The unit of measure for No
UuoOM the item's proposed retail.
Proposed Retail The retail sales margin of | No Proposed Retail minus Basis Cost
Markup % the item based on the new divided by Proposed Retail (Before
retail. VAT)
The zone level basis cost if used if it
exists.
For zone level records, if a zone
level basis cost exists, use that value
in the calculation
Replenishment "Yes" if the item is on an No
Indicator active replenishment
record.
Reset Date The reset date for the item. | Yes Defaults to Out of Stock Date plus
Enter a date to change the one day
default.
Retail Label Type | The retail label type of the | No
item.
Retail Label Value | The retail label value of No
the item.
Price Zone Group | The price zone group ID | No

ID

for a zone level item.

Note: Place the cursor over
this field to view the price
zone group description.
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Column Description Editable | Calculation
Price Zone ID The price zone ID for a No
zone level item.
Note: The price zone
description is available as
a mouse over.
Rule Binocular icon appears if | No
the item meets rules.
Click the icon to open a
window and view details
of the rules met by the
record.
Projected Sales The smoothed average No Total Sales divided by Total Weeks
Units regular price sales based of Sales
on the number of weeks of
sales that have occurred.
Sales Change The difference between No Depending on your aggregation
Amount the items new retail and level settings:
the basis retail on the Sales Change Amount = Basis
effective date multiplied Retail - New Retail
h i les fi
by the projected sales for a Sales Change Amount = New Retail
week. .
- Current Basis
On Worksheet Status the sum of all
individual records. On Worksheet
Detail per item.
Seasonal Sell Thru | The sell through percent | No Total Sales For the Season divided
% for the current season. by Stock On Hand
Total sales for th.e stores in Depending on your aggregation
tbe zone or location level settings Warehouse Stock On
divided by stock on hand Hand will be included or excluded.
for the zone/location.
Season/Phase Hyperlink opens No
Season/Phase detail
window.
Sell Thru % The sell through percent | No Sales divided by (Stock On Hand
for store locations in the plus Sales)
Zone. Depending on your aggregation
level settings Warehouse Stock On
Hand will be included or excluded.
The type of sales and the amount of
time to be considered is determined
by the Sales Calculation Method.
State The status of the details of | No
the record.
Store On Hand The current stock on hand | No
at store locations.
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Column Description Editable | Calculation
Store On Order The total on order qty for | No
all stores in the price zone.
Note: On order is in the
single unit size of the item,
not case size.
Store total Total inventory for all No Store On Hand plus Store On Order
inventory stores in the zone. plus Store In_Transit + Store
OBNP_INV
Subclass ID The subclass hierarchy ID | No
of the item's subclass.
Note: Place the cursor over
the field to view the
subclass description.
UDA Hyperlink opens UDA No
information for the item if
it exists.
VPN The VPN for the primary | No
supplier of the item.
Weeks of Sales The number of weeks the | No
Exposure item has had sales
exposure (on had at
location).
Weeks Since First | The number of weeks No
Sale since the items first sale.
Total Inventory Total inventory for the No Total Warehouse Inventory plus
item/location. Total Store Inventory
WH Stock On The current stock on hand | No
Hand at warehouse locations in.
Warehouse On Total on order qty forall [ No
Order stores in the price zone.
Note: On order is in the
single unit size of the item,
not case size.
WH total The total inventory for all | No Warehouse On Hand plus
Inventory stores in the zone. Warehouse On Order plus

Warehouse In Transit
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Change the Value in a Cell

Change the Value in a Cell
1. Double click the cell.

2. Enter a value, change a value, or select from a drop-down list.

Change the Values of Multiple cells

1. Press and hold the Ctrl key while selecting cells or column headings to select
multiple cells or columns.

2. Right click on the selected cells or columns. A window appears that allows you to
edit the value for all selected cells.

Price Change Indicator &l

Edited Walus =

| Apply || Cancel |

Example Edit Value Window
3. Enter a value, change a value, or select from a drop-down list.
4. Click OK. The values for all selected cells change.

Maintain Columns

You can edit the worksheet to display only the columns you are concerned with, change
the order the columns display, and change the number of rows that appear.

Hide and Position Columns

1. In the Worksheet Details pane, click the E button.
2. Select Column Display and Ordering... from the drop-down menu. The Column
Display and Ordering window opens.

Column Display and Ordering §|

Hide these columns: Show these columns:

Mew Retail -~
Itern ID

% off Regular Retail El
% off Basis Retail

Base Cost El

Basis Cost

Class 1d
4 I

| Cancel || 0K |

Column Display and Ordering Window
3. To hide columns:
a. Select a column to hide in the Show these columns pane.
b. Click the [ 4! button. The column name appears in the Hide these columns pane.
c. Repeat the steps above to hide additional columns.

* To hide individual columns, right-click on the column heading in the
Worksheet Details pane and select Hide Column from the drop-down menu.
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4. To position columns:

a.
b.

Select a column to re-position in the Show these columns pane.

Click the L] and [ =] buttons as necessary to move the columns. This determines
the position of the columns from left to right.

Repeat the steps above to re-position additional columns.

= To reposition individual columns, click on the column heading in the
Worksheet Details pane and drag it to the desired position.

5. Click OK. The worksheet columns are repositioned to reflect your changes.

Sort the Worksheet

In the Worksheet Details pane, click the E button.

2. Select Sort Table... from the drop-down menu. The Column Display and Ordering
window opens.

3. Set the sort order of the worksheet:

® 20 o

g.

Select a column from the Columns pane.

Click the [» | button. The column name appears in the Priority Column pane.
Repeat the steps above to move additional columns.

Select a column in the Priority Column pane.

Click the [+ and [~ I buttons as necessary to move the columns. This determines
the order by which the worksheet information is sorted.

Clear the Ascending column to have the column sort date in a descending
manner.

Repeat the steps above as necessary.

4. Click OK. The worksheet columns are sorted to reflect your changes.

To sort based on individual columns, right-click on the column heading in the
Worksheet Details pane and select either Make Primary Sort, Ascending or Make
Primary Sort, Descending from the drop-down menu.

Adjust the Size of the Worksheet Content
In the Worksheet Details pane, click the :l” Z | button.

Move the cursor over Size Content.

Select from the drop-down menu:

Smallest
Smaller
Standard
Larger
Largest
Fit All

4. The size of the content on the worksheet is adjusted.
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Adjust Column Sizes

1.

In the Worksheet Details pane, click the E button.

Move the cursor over Column Resizing in the drop-down menu.
Select from the drop-down menu:

=  Adjust Next Column Only

= Adjust Subsequent Columns

* Adjust Last Column Only

= Adjust All Columns

The worksheet columns are adjusted.

To resize individual columns, position the cursor on the right-hand border of the
column heading. The cursor will change to a double arrow. Click and drag right or
left to resize the column.

Set Non-Scrolling Columns

You can set up to seven columns to be locked or non-scrolling. This allows comparison of
values in the locked columns to all other columns in the worksheet.

1.
2

In the Worksheet Details pane, click the E button.

Select Column Locking from the drop-down menu. The Column Locking dialog
opens.

Column Locking P§|

Murnber of colurnns to be locked (0 to 7)) IZI

| Cancel || 0K |

Column Locking Dialog
Enter the number of columns to lock.
Click OK. The columns are locked (non-scrolling).
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Maintain Views

Add a View
1. Click Maintain View. The Maintain View dialog opens.
I,
Default Description Corporate |
Corp | —
Fabarl |
Faberz |
Faber3 1 -
fabers O
ITEM-ZOME | —!
pci firzt 1 d
Maintain View Dialog
Click Add. A new line appears in the list.
Enter a name for the view in the Description field.
Select the Default View checkbox if you would like the view you created to be the
default view.
5. Click Save. The view is saved and is accessible from the drop-down at the top of the
Worksheet Details pane.
Delete a View
1. Select the view you want to delete from the list.
2. Click Delete. The view is removed from the list.
Select a View

Select a saved view from the drop-down list.
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Apply Filters

Apply Filters

Since worksheets may contain many detail records, RPM gives you the ability to filter
those records so you see only the details that need attention. You can perform an ad hoc
filter on any column in the Worksheet Detail or you can create and save an advanced
filter that you can continue to use in the future.

Apply an Ad Hoc Filter

In the Worksheet Details pane, select a value from the Filter by: drop-down above the
column you wish to filter the worksheet by. The worksheet refreshes, with the filter

applied.

Clear an Ad Hoc Filter

In the Worksheet Details pane, select Clear Filter from the Filter by: drop-down above the
column that the filter was applied to. The filter is cleared and the worksheet returns to its
previous state.

Note: Any other filters applied will still be applied to the
worksheet.

Clear All Filters

In the Worksheet Details pane, select Revert to Default from the Filter by: drop-down
above any column. The filters are cleared and the worksheet returns to its original state.

Apply an Advanced Filter

Note: Advanced filters override any ad hoc filters previously
applied to the worksheet.

1. In the Worksheet Details pane, select Advanced Filter from the Filter by: drop-down
above the column you wish to filter the worksheet by. The Advanced Filter dialog

opens.
Advanced Filter E|
Show rows where
Mew Retail |is equal to IEI
| F=|
|(none) IEI
| Cancel || 0K |

Advanced Filter Dialog

Select a condition to apply to the column from the top drop-down in the dialog.
Enter or select a value for the filter to look for in the next drop-down.

You may enter an additional condition and value in the remaining drop-downs.
Select a logical operator (And or Or) in the area between the drop-downs.

Click OK to apply the filter to the worksheet. The worksheet refreshes, with the filter
applied.

I L T
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Maintain Worksheet Detail Filters

In the Worksheet Details pane, click the Filter 'l button. The Worksheet Detail Filter
window opens.

Worksheet Detail Filter 3

Filter [ select- [¥] [ SaueFikeras .. |[ Delate Filter | [ apply Filker |
Column | condition [ vatue ‘
Rermave Al
Filter on a Column ar a Value () Calumn
@ value
Column |- gelect - E‘ Condition |- gelect - E Value “ Add Criteria

Worksheet Detail Filter Window

Note: Click the clear filter button to remove the filter
criteria.

Create a Worksheet Detail Filter

1.

Select Column to have the filter compare the values in two columns.
Or
Select Value to have the filter match a value in a column.

Select a column to filter by from the Column drop-down.
Select a condition to apply to the filter from the Condition drop-down.

Select a column to compare to the previous column in the Column drop-down if you
chose to filter by column above.

Or

Select of Enter a value for the filter to look for in the next field if you chose to filter by
value above.

Click Add Criteria. The criteria is added to the Worksheet Detail Filter table.
Repeat the steps above to continue adding criteria. Continue to the next step.
Click Save As to save the filter.

Enter a name for the filter in the Save Filter dialog.

Apply a Worksheet Detail Filter

1.
2.
3.

Select a filter from the Filter drop-down.
Select criteria from the Worksheet Detail Filter table. You can select multiple criteria.

Click Apply Filter. The Worksheet Detail Filter window is closed and the filter is
applied.
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Delete Worksheet Detail Filter Criteria
1. Select a filter from the Filter drop-down .
2. Select criteria from the Worksheet Detail Filter table.

3. Click Remove Criteria. The criteria is removed from the filter. Click Remove All, to
remove all criteria from the filter.

Delete a Worksheet Detail Filter
1. Select a filter from the Filter drop-down.
2. Click Delete Filter. The filter is removed from the Filter drop-down.
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View Conflict Check Results

The Conflict Check Results workspace allows you to review the results of background
conflict checking for worksheets, price changes, promotions, and clearances. If the
background conflict checking system option is selected, conflict reviews occur in the
background, or when the system is not busy performing other tasks. An alert appears in
the Conflict column of the worksheet, price change, promotion, or clearance maintenance
pane when conflict checking is complete. At that time, follow the procedures below to
view the results of background conflict checking.

When background conflict checking is off the system performs conflict checks
immediately when Conflict Check is clicked from the Price Change, Promotions, or
Clearances workspaces.

View Conflict Check Results

Navigate: From Task Pad, select Conflict Check Results > View Conflict Check Results.
The Conflict Check Results workspace opens.

5 conflict Check Results
I,
Event Type | ID Promotion Co Promotion Col Department | Class Subclass Zone Result Result Date
| Fifker bylzl | Fifter bylzl |F.".*ter bylzl | Fifker bylzl | Fifter bylzl |F."!ter bylzl | Fifker bylzl | Fifter bylzl |F.".*ter bylzl |F."!ter bylzl
Workzheet 1 00 Mo Conflict.,, | 03/01/2005
4 4

Conflict Check Results Workspace.
Select the conflict results you want to view.
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Delete Conflict Check Results
1. Select the conflict results to delete.
2. C(lick Delete.

Worksheet Status

Maintain a Pricing Worksheet

Navigate: From the Task Pad, select Worksheet > Worksheet Status. The Worksheet

Status workspace opens.

%5 worksheet Status

I@ Worksheet Status

Reason | |® Apply
Action [ select - =l
I
Merchandise Level | Merchandise ID Location Level | Location ID Location Status | Conflict| Last Review Date | Reas
Filkar by :I Fitkar by :l Fitkar by :l Filkar by :I Fitkar by :l |F_.lftE Fifks :l Filkay by :l Filkd
Departrment 9 e RIZ == =
Crepartment 2 Zonge g 21 Mew 0z-02-2005
4] 3
Selact All || Unselact All || Wworksheat Datail |

Total Price Change Arnount
Total Price Change SOH
Total Price Change Items

Total Sales Amount

Worksheet Status Workspace

1. Select the worksheet you want to maintain.

Note: You can select multiple worksheets as long as they are
for the same department and currency.

2. Click Worksheet Detail to maintain the details of the worksheet.
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Submit a Pricing Worksheet for Approval

The Pricing Worksheet status must be In Progress to enable the Submit action. To change
the status of the Pricing Worksheet from New or Updated to In Progress, you need to
have at least one row or item selected for price change.

1. Select the worksheet that you want to submit.
2. Review the information in the Worksheet Status window to ensure that it is correct.

3. From the Action drop-down list, click Submit.

Note: The status options that are available from the Action
drop-down list change based on current status of the
worksheet's details.

4. Click Apply. The status is changed to Submitted and the Pricing Worksheet is ready
for approval.

Note: Before the status changes to Submitted, RPM checks
the pricing worksheet to ensure that there are no conflicts.

Approve a Pricing Worksheet

Note: The Pricing Worksheet status must be in either
Submitted or Delete Pending status before you can select the
approve action.

Select the worksheet that you want to approve.

2. When you are ready to approve the submitted or delete pending Pricing Worksheet,
select Approve.

3. Click Apply. The Pricing Worksheet information is saved and applied.

Note: For worksheets in Submitted status, before the status
changes to Approved, RPM checks the Pricing Worksheet to
ensure that there are no conflicts. Delete pending status
worksheets are not conflict checked before being moved to
Deleted status.

When the system option, Dynamic Area Differentials is off,
secondary area worksheets are enabled when the primary
area is approved. When the system option is on, changes to
secondary areas happen dynamically after changes to the
primary area.

User Guide 127



Worksheet Status

Reject a Pricing Worksheet

You can reject a Pricing Worksheet that has a status of Submitted or Delete Pending.
When you reject a submitted or delete pending Pricing Worksheet, its status changes to
Rejected or Delete Rejected.

Note: If you want to work with the Pricing Worksheet when
its status is Rejected, Reset the status of the Pricing
Worksheet (see the procedure below).

Select the worksheet that you want to reject.

2. You can enter a Reason for the rejection in the Reason field. Click the & button to
open an editing window where you can enter a reason up to 250 characters long.

From the Action drop-down list, select Reject.

Click Apply. The status of the Pricing Worksheet changes to Rejected or Delete
Rejected.

Reset the Status of a Pricing Worksheet
Use the Reset action to return the worksheet to its previous status.
1. Select the worksheet that you need to reset the status of.
2. From the Action drop-down list, select Reset.

3. Click Apply. The Worksheet Status window refreshes and the worksheet is returned
to its previous status.

Delete a Pricing Worksheet
1. Select the worksheet that you want to delete.
2. From the Action drop-down list, select Delete.

3. Click Apply. The Pricing Worksheet is moved to Delete Pending status and is ready
to have your deletion approved or rejected.

Note: The options that are available from the Action drop-
down list change based on worksheet's current status.
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Worksheet Detail

Maintain Worksheet Details

Navigate: From the Task Pad, select Worksheet > Worksheet Status. The Worksheet
Status workspace opens.

%9 worksheet Status

I@ Worksheet Status |

Reason | |@ Apply
Adion [ selact - =l
I,
Merchandise Level | Merchandise ID Location Level| Location ID Location Status | Conflict| Last Review Date | Reas
Fifter by :I Fifker by :l i
A= )

Fifker by :l Filke! :l Filker by :l

Crepartment

Crepartment

4] »
Selact All || Unzelect All || Wworksheet Detail

Total Price Change Amount | £n0n

Total Price Change SOH o

Total Price Change Itermns 5

Total Sales Armount £0.00

Worksheet Status Workspace

1. Select the worksheet you want to view the details of. You can select multiple
worksheets or click Select All to select of all the worksheets.

2. Click Worksheet Detail. The Worksheet Details workspace opens.
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%5 worksheet Details
@ Worksheet Details |
Itern Level 'Tran Level lEI
cotin Save View . . . D .
| o | i - =]
I
Item ID Item Description | Historical Salg Historical Sald Seasonal Sell | Sell Thru % | Rule Season/Phasd Store On H
Filker by W\ Filker by || Fitker by :l Filker by :l Fitker by | T\ Filker by | ||| Fitber by | ||| Fitker by | ||| Fitber by
1901 RDP CMLTE 0,00 o i 5]
1910 RDP Item for RPM 0.00 0 i 5]
1911 RDP item for RPM 0.00 0 i 5]
1360 RPD RPM itzm 0.00 o i 5]
1961 RDP RPM itzm 2 0.00 o i 5]
1952 RDP RPM Item 3 0.00 o 5
1370 RDF RPM Item 0.00 o i 5]
[« l »
| Unzelad All || Selack All || Reset Data || What If || Suggest Date ||
Cancel ” Sauve ” Cane I

Worksheet Details Workspace
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Merchandise Extract ltem Deletions

Navigate: From the Task Pad, select Worksheet > Merchandise Extract Item Deletions.
The Worksheet Extract Item Deletions workspace opens.

73 Merchandise Extract Item Deletions

I

Pricing Strategy Merchandise Id Merchandise Level Zone Zone Group Date Item Count

Filker by: [ ||| Fiteer 8- [=]|| Fiteer 2o [ |[Fer s [=]|[ teer sy [l Fiter sy [=]|[Fter by =l
2853 63 Cepartment T45 743 1zf1a/z2002 422
2855 36 Clazs T45 742 1zf1a/z002 1
2858 63 Cepartment T4a 743 1zf1a/z2002 44
2861 &9 Cepartment == T52 1zf1g/2002 2
2e21) 40 Class T4E T4z 1zf1g/2002 B2
2e22 &0 Cepartment T4E T4z 1zf1g/2002 124
2883 72 Diapartrmant =] 753 1zf18/2002 2
2022 219 Subclazs Tag T4 1zf18/2002 1
20232 69 Diapartrmant Tag T4z 1zf18/2002 4
3288 TE Diepartrment TdE T48 i1zf1afz002 T
3344 TE Drepartrment =11 T 1zf1afz002 2
3365 TE Diepartrment 469 455 i1zf1afz002 8
3568 63 Drepartrment =11 T 1zf1afz002 24
2708 40 Class 742 T48 1z2f18fz2002 124
2887 &0 Department 759 T52 1zf18fz2002 S|
aeol 550 Cianavtroant A 4 12018000 I

|
I
Item Location Reason Candidate Rule Name
Fifkey by: E | Fiftey by : lzl |F.l'i‘ter by lzl | Fifkey by : lzl

Merchandise Extract Item Deletions Workspace

1. Double-click on the row on the summary table that you would like to see more detail.
The detail table is populated with the items and information that were excluded from
the resulting worksheet for the particular run of the merchandise extract.

2. Filter the detail results by selecting the appropriate drop-down menus.

Column

Definition

Area Differential Exclusion

Item/location combinations that have been excluded from a
Secondary Area Differential.

Invalid Maintain Margin Cost

The strategy is maintain margin and the item /location does
not have a cost change in the cost review period.

Invalid Secondary Item

Item /locations that meet one of the below:

Does not belong to any link code whereas the same item
belongs to a link code in the primary area.

Does not exist in the primary area AND does not belong
to any link code in the secondary area.

Belongs to a link code that does not exist in the primary
area.
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Column

Definition

Missing Link Item

When one or more item from a item-link code/zone group is
missing the entire group is excluded.

Item /locations that meet one of the below:

= If any one item from a Link code is present in the
worksheet, all items in the same Link code must also be
present in the worksheet.

=  Items sharing the same Link code should have the same
Basis UOM.

*  Items sharing the same Link code should all have the
same Class Vat Indicator settings.

*  For Margin and Maintain Margin Strategies, items
sharing the same Link code should have the same
Margin Market Basket code.

=  For Competitive Margin Strategies, items sharing the
same Link code should have the same Competitive
Market Basket code.

New Item Location

Item/locations that are not present in at the start of a review
period cannot be added in the middle of a review period.

No Cost

No cost could be found for the item/location.

No Retail

No retail could be found for the item/location.

Candidate Rule Exclusion

The item/location meets a exclusion candidate rule.

Variable Link Code The item does not have the same Link Code at all locations in
the zone.
Variable Link MBC The items sharing a market basket code do not have the same

Link Code at all locations in the zone.

Variable Link Selling UOM

The items sharing a link code do not have the same Basis
UOM at all locations in the zone.

Variable Link Vat Indicator

The items sharing a link code do not have the same vat
indicator at all locations in the zone.

Variable Zone Selling UOM

The item does not have the same Basis UOM at all locations
in the zone. The strategy is maintain margin and the
item/location does not have a cost change in the cost review
period.

Edit Proposed Retail Prices

Enter a new retail price in the New Retail field as required for each item.
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Take or Reject Proposed Price Changes

1.
2.

Select the level to view the worksheet at from the Item Level drop-down.

Change the Price Change Indicator field in the appropriate row:

Itarn Level |Tran Leveal lEI
=
Mew Retail UOM | Price Change Indicator | Conflict State Promotion
ﬂ | Filkar by lEI | Fitkar by : E | Filkar by lEI | Filkar by - IEI | Fitkar by -
34| EACH |- Mew
S0) EACH Mew
24| EACH [Faks Mew
Don't Take

88| EACH Mew
0z EACH Mew
39 EACH Mew
52| EACH Mew
01} EACH Mew
ol eary bl

Price Change Indicator Column
Select "Take" to accept the proposed price change for the item.

Select "Don't Take" to reject the proposed price change for the item.

Click Save. Your changes to the worksheet are saved and the Worksheet Status
workspace opens.

See the "Worksheet Columns" for a complete list of the editable columns on the
worksheet.
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View Totals

Navigate: From the Task Pad, select Worksheet > Worksheet Status. The Worksheet

Status workspace opens.

%9 worksheet Status

I@ Worksheet Status

Reaszon | |@
Adion [ selact - =l
I
Merchandise Level | Merchandise ID Location Level| Location ID Location Status | Conflict| Last Review Date | Reas
Filter by W Fidter by Fittar by: ||| Filtar by || Fidter by || Ay | Fitre| || Fitter by ||| Filke
Crepartment
Crepartment 2 Zone =) 21 Mew 03-02-2005
4] »
Select All || Unselec All || Wworksheet Detail

Total Price Change Amount £0.00
Total Price Change SOH o
Total Price Change Items 5
Tatal Sales Armount 0,00

Worksheet Status Workspace

1. Select the worksheet you want to view the details of. You can select multiple
worksheets or click Select All to select of all the worksheets.

2. Click Worksheet Detail. The Worksheet Details workspace opens.
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%5 worksheet Details

I@ Worksheet Details |

Ttern Level 'Tran Level lEI
|c0rin lzl | Save View Diff Type . D

I

Item ID Item Description | Historical Salg Historical Sald Seasonal Sell | Sell Thru % | Rule Season/Phasd Store On H

Filker by W\ Filker by || Fitker by :l Filker by :l Fitker by | T\ Filker by | ||| Fitber by | ||| Fitker by | ||| Fitber by
T 5

1901 ROP CMLTE 0.00 o] ﬂ

1910 RDP Item for RPM 0.00 a H

1911 RDP item for RPM 0.00 a ﬂ

1960 RPD RPM itern 0.00 a H

1961 RDP RPM itern 2 0.00 a H

1962 RDP RPM Itemn 2 0.00 a H

1370 RDP RPM Item 0.00 a H

Kl I 3

| Unzelad All || Selack All || Reset Data || What If || Suggest Date ||

| Cancel Il Save Il Done I

Worksheet Details Workspace
Select the row you want to view totals for by clicking the box :‘ to the left of the
row.

Press and hold the Ctrl key while selecting to select multiple rows. Click Select All to
select all the rows.

Note: If no items are selected, the totals appear for all items
where a price change would occur.
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4. Click the Totals L= button. The Totals window opens.

Price Change Totals| Sales Totals [ Competitive Analysis totals

|

Zone ID Zone Name Price Change Amount| Price Change SOH Price Change Items

Recalculate Total || Dane

Totals Window

View Price Change Totals

1. Select the Price Change Totals tab. The totals for all of the item rows that you selected
appear on the Totals window.

2. Click Done. The Totals window is closed.

View sales totals

1. Select the Sales Totals tab. The totals for the sales for the item rows that you selected
appear on the Totals window.

2. Click Done. The Totals window is closed.

View Competitive Analysis Totals

1. Select the Competitive Analysis Totals tab. The totals for how you are competing in
all retail zones that you have selected appear on the Totals window.

2. Click Done. The Totals window is closed.
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What-If Analysis

Navigate: From the Task Pad, select Worksheet > Worksheet Status. The Worksheet

Status workspace opens.

%9 worksheet Status

I@ Worksheet Status |
Reason | |@ Apply
Adion [ selact - =l
I,
Merchandise Level | Merchandise ID Location Level| Location ID Location Status | Conflict| Last Review Date | Reas
Filter by W Fidter by Fitter by: ||| Filter by || Fitter bpe ||| Ay T | Atk ||| Fidter by || ity
Crepartment
Crepartment 2 Zone =) 21 Mew 03-02-2005
4] »
Select All || Unselec All || Wworksheet Detail
Tatal Price Change Amount |40 0p
Total Price Change SOH o
Total Price Change Items 5
Tatal Sales Armount 0,00

Worksheet Status Workspace

1. Select the worksheet you want to view the details of. You can select multiple
worksheets or click Select All to select all of the worksheets.

2. Click Worksheet Detail. The Worksheet Details workspace opens.
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%5 worksheet Details

@ Worksheet Details

Ttern Level 'Tran Level

=]

|c0rin lzl | Save View Diff Type . D

I

Item ID Item Description | Historical Salg Historical Sald Seasonal Sell | Sell Thru % | Rule Season/Phasd Store On H

Filker by W\ Filker by || Fitker by :l Filker by :l Fitker by | T\ Filker by | ||| Fitber by | ||| Fitker by | ||| Fitber by
T 5
1901 ROP CMLTE 0.00 o] ﬂ
1910 RDP Item for RPM 0.00 a ﬂ
1911 RDP item for RPM 0.00 a ﬂ
1960 RPD RPM itern 0.00 a ﬂ
1961 RDP RPM itern 2 0.00 a ﬂ
1962 RDP RPM Itemn 2 0.00 a H
1370 RDP RPM Item 0.00 a H

Kl I 3

| Unzelad All || Selack All || Reset Data || What If || Suggest Date ||

Cancel Il Save Il Done I

Worksheet Details Workspace

Select the row you want to perform a what-if analysis on by clicking the box :I to
the left of the row.

Press and hold the Ctrl key while selecting to select multiple rows. Click Select All to
select all the rows.
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Perform a What-If Analysis on a Clearance Pricing Strategy
1. Click What If. The What If window opens.

Price Strategy - Clearance @

~Pricing Guides
Current
N S

—Martdown Percents

I
Markdown Number Current Mewr
1 10% 1008
2 209 2095
2 20% 0%
4 < 056 4 055
=1 S0%% SO%
& 60596 055
T TO% TO%
2 209 S09%%5
| Cancel || Resat || Apply |

What If Window
2. Make changes to the following fields to test what happens to the worksheet:
=  Price guide: Select a new price guide from the New drop-down.

* Markdown percent: Enter a markdown percent in the New Markdown Percent
field.

3. Click Apply. The What If window is closed and the data in the Worksheet change to
reflect the changes made in the What If window.

Perform a What-If Analysis on a Competitive Pricing Strategy

1. Click What If. The What If window opens.

2. Make changes to the following fields to test what happens to the worksheet:
=  Price guide: Select a new price guide from the New drop-down.

= Compete type: Select a different compete type for the whole worksheet or by
code by selecting from the New Compete Type drop-downs.

= Compete percent: Enter a new compete percent in the New Compete Percent
field.

3. Click Apply. The What If window is closed and the data in the Worksheet change to
reflect the changes made in the What If window.

Perform a What-if Analysis on a Margin Pricing Strategy

1. Click What If. The What If window opens.

2. Make changes to the following fields to test what happens to the worksheet:
=  Price guide: Select a new price guide from the New drop-down.
= Margin target: Enter a margin target in the New Margin Target field.

3. Click Apply. The What If window is closed and the data in the Worksheet change to
reflect the changes made in the What If window.
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Reset the What-if Data

1.

Click What If. The What If window opens.

2. Click Reset. The values are returned to their original value.
3. Click Apply. The What if window is closed and the data in the Worksheet change
back to their original value.
Export a Worksheet

Export allows you to export the current view of the worksheet to a Comma Separated
Value (csv) file.

Navigate: From the Task Pad, select Worksheet > Worksheet Status. The Worksheet
Status workspace opens.

%5 worksheet Status

I@ Worksheet Status

Reason | |@ Apply
Adion |- selact - 4|
I
Merchandise Leval | Marchandise ID Location Level| Location ID Location Status | Conflict| Last Review Date | Reas
Filker by : :I Fitker by: :l Filter by: :l Filker by : :I Fitker by: :l Iﬁﬂ Filte :l Filker by: :l Fitkd
D epartment Zone Hew 03-01-:
Crepartrnent 2 Zone =) 21 Mew 0z-02-2005
4] 3
Select All || Unseladt All || Wwarkzhesat Datail |

Total Price Change Arnount
Total Price Change SOH
Total Price Change Items

Total Sales Amount

Worksheet Status Workspace

1.

2.

Select the worksheet you want to view the details of. You can select multiple
worksheets or click Select All to select of all the worksheets.

Click Worksheet Detail. The Worksheet Details workspace opens.
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%5 worksheet Details

@ Worksheet Details |

Ttern Level 'Tran Level lEI
|c0rin lzl | Save View Diff Type . D

I

Item ID Item Description | Historical Salg Historical Sald Seasonal Sell | Sell Thru % | Rule Season/Phasd Store On H

Filker by W\ Filker by || Fitker by :l Filker by :l Fitker by | T\ Filker by | ||| Fitber by | ||| Fitker by | ||| Fitber by
T 5

1901 ROP CMLTE 0.00 o] ﬂ

1910 RDP Item for RPM 0.00 a H

1911 RDP item for RPM 0.00 a ﬂ

1960 RPD RPM itern 0.00 a H

1961 RDP RPM itern 2 0.00 a H

1962 RDP RPM Itemn 2 0.00 a H

1370 RDP RPM Item 0.00 a H

Kl I 3

| Unzelad All || Selack All || Reset Data || What If || Suggest Date ||

Cancel Il Save Il Done I

Worksheet Details Workspace

3. Select the row you want to export by clicking the box :‘ to the left of the row.

Press and hold the Ctrl key while selecting to select multiple rows. Click Select All to
select all the rows.

4. Click the Export [®] button. The Save window opens.
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Save

Save In: |[:| Ternp

03 wERC.tmp. dirdn [1 {aShal4e0-7384-11d4-bae7-00409631a2c8}
3 wWERD.trap. dirdD [1 {a8533100-1481-11d4-9731-00c04f22ab 35}
3 WERE.trnp, dir0i [ {abds9912-5d00-11d4-bae7-9367cala7955}
3 WERF.trnp, dir0d [ {CAS32E73-1BB7-11DE-9DEA-00010240CE35)
3 WERF.tmp. dir01 [ {CE303AFF-1BER-1108-906A-00010240CE95])

3 wards.o
3 {o07e1b0s-202d-11d4-9790-00c04f2ecb29]}
3 {46591FF3-F42A-4AE6-B2F2-SCAFD4CCABEL)

4 IP

File Marme: F'r'i-:in-; 445 |

Files of Type: |*.cs-.l lEI

Save || Cancel |

Save Window

Select a location to save the file to from the Save In drop-down.

Enter a name for the file in the File Name field.

Click Save. The file is saved.

Open the file in the program of your choice such as a spreadsheet or word processor.

© N o o
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Price Changes

A price change is the permanent change in the price of an item. You can use the price
guides to move the new price to established price points, round the price, or define price
internals.

The Create Price Change workspace allows you to establish the price changes for an item
or group of items at a location or group of locations. When you open the window, the
Price Change List and Price Change Maintenance containers open. After you create your
price change in the Price Change Maintenance container, it is added to the Price Change
List container.

If you select locations with multiple currencies, you can only choose to create a price
change by percent or to reset the POS price. Additionally, you cannot create multi-unit
pricing across multiple currencies.

Create price change allows you to create the following types of price changes.
* Regular: The price change is occurring at the retailer's initiative.
* Vendor Funded: The supplier is subsidizing a portion of the price change.

* Link codes: Associate items to each other at a location and price them exactly the
same.

When a price change is added to RPM, it must go through a series of checks before it can
be applied to an item/location. Depending on your user role, you may not be able to
move the retail price change to the next status. A change to submitted or approved
status, or from worksheet back to approved, results in a conflict check. A change to
approved status results in the application of area differential strategies for the price
change. A price change may be in any of the following statuses:

Status Definition
Worksheet The price change has been started, but not reviewed or sent out.
Submitted The price change has been completed and is pending review. Conflict

checking has occurred for the price change.

Approved The price change has been reviewed and accepted. The price change is

communicated to the locations for which the price change is effective.
Executed The new prices established are effective for the item/location.
Rejected The price change has been reviewed and declined.

After you create a price change, you can maintain different aspects of the price change.
You can create exceptions to the items and locations that exist on the price change, you
can change the specifics of the price change, and you can copy an existing price change.

The procedures below allow you to navigate and search for price changes through the
Maintain Price Change task on the Task Pad; however, you can accomplish these same
tasks after you create a price change and the price change is displayed in the Price
Change List pane in the Create Price Change workspace.
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Search for a Price Change

Search for a Price Change

Navigate: From the Task Pad, select Price Changes > Maintain Price Change. The
Maintain Price Changes workspace opens.

1. In the Price Change Search pane, enter criteria as necessary to restrict the search to
the price changes you want to maintain.

I-'(: Price Change Search

¥ Departrent l:l B+ * price Change 1d | |
- =
=] Status | Selact - |Z|
Itern Typs [rterm =l S By I:l
Ttern Lavel n [] search On This Level Cnly Create Date | “fl TD| |E|
Effective Date [ =R |=
N —
8
b Lacation
» Advanced Search
| e[|

Price Change Search Pane

Field Criteria

Type Select Regular, Vendor Funded, Link Code, or All price change types.

Status Select Approved, Executed, Rejected, Submitted, or Worksheet status price
changes.

Approved By Enter a username to search for price changes approved by a specific user.

Created By Enter a username to search for price changes created by a specific user.

Reason Code Select reason codes

Deal ID Select deal IDs to search for price changes related to specific deals. First
select Vendor Funded from the Type field.

Deal Detail ID Select deal detail IDs to search for price changes related to specific deal
details. First select Vendor Funded from the Type field, then select a deal
from the Deal ID field.

Price Change ID Select price change IDs to search for specific price changes.

Effective Date Select an effective date to search for price changes with a specific effective
date.

Approved Date Select an approved date to search for price changes with a specific approved
date.

Create Date Select a create date to search for price changes with a specific create date.

Price Guide Select price guides to search for price changes with specific price guides.
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Search for a Price Change

Field

Criteria

Merchandise Level

Zone/Location

Market Basket
Code

Link Code

merchandise level:

Department
Class
Subclass
Item Type
Item Level
Diff Type
Item

Diff

Select criteria in the following fields to search for price changes in a specific

Select Zone Groups, Zones, and Locations to search for price changes from
specific zones or locations.

Select a Market Basket Code to search for price changes with a specific
Market Basket Code.

Select a Link Code to search for price changes with a specific Link Code.

Note: Select the Search on this Level Only checkbox to

restrict the search to the selected level.

Click Search. Your results appear in the Price Change List pane.

I@ Price Change List

Price Change

2

Id Link Code Item Item Descripl Item Level | Diff Id Diff Id Descri| Location Location Desd Location Typd Primary Zon

Fitter by :| Fitter by :| Fitter by :| Fitrer by | ¥\ | Fitrer by | w || Fitrer b | w || Fitrer by | w ||| Fitrer by | w ||| Fiter by | w || Fitver by | T ||| Ftter by | =
a4 100151005 |RPM QA **.. [Transaction ... 3 AUD locatio... [Zone X
921 100151009 |RPM Q& **., | Tranzaction ., & AUD location, |Zone :
202 100118006 |Misty Test L. |Transaction .. 1000000027 |Sydney Store |
201 100118006 |Misty Test L.|Transaction ... 1000000025 |Las Vegas  |$tore

.3

ps 1234

|en

[
E”El Fo to page of 17

scton [[Gaiect— [3]

Select All

Haw I Copy

Price Change List Pane
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Create a Regular Price Change
Navigate: From the Task Pad, select Price Changes > Create Price Change. The Create

Price Change workspace opens.

%5 create Price Change

B e : =
[ Price thange List |
Price Change Wiaw |Standard Colurmnn view| ||| &
1d Link Code | Item Item Descrip Item Level | Diff Id Diff Id Descri| Location Location Desq Location Typd Primary Zon.
Fitcer by [ ¥ ||[ Fitver by [ ¥ ||[ Fitver by [ ¥ || [ Fiter b [ 7| [ Fiter b [ ||| iter v [ 7] [miter x> ||| Fitcer sy [ ||[ Fiteer 8[| [ mitemr [ ]|[ iter b {1
4 »
Select Al
Status Action [ gelac - = T [_cenflict chack ][ suggest Date |
Delate H Meaw Il ZCopy H Loc Exception H Tran Exception ||
I@ Price Change Maintenance |
Type @) Regular Price Guide |:| =]
wendor Funded * Reason Code I:I 8
(0 Link Code
* Effective Date l:l
Change Type |change By Amount B Multi Unit Pricing O
Change Amount | | Multi Units
selling WET B Multi Unit R etail
Ignore Constraints ek a8
~ Location Selection
Zone Group 8 -

cancel |[_save + Repeat |[ rcone |

Create Price Change Workspace
1.
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Create a Regular Price Change

I’F Price Change Maintenance

Type ®) Regular Price Guide l:l
() wendor Funded * Reason Cade I:l =
() Link code
* Effective Date l:“ﬂ
Change Type |Changg By Armaunt E Multi Unit Pricing O
Change Armount | |
=
=
=
Ignaore Constraints =

~ Location Selection

=l

Location Selection [
Level | d Description | Location Type ‘

¥ Itemn Selection

Itern Type  [ttem

&[]

Itern Level  [Transaction Level Item

Ttern +
Price Change Maintenance Pane
2. In the Effective Date field, enter the date the price change should go into effect, or
click the calendar E button and select a date.

Note: The Effective Date you can set depends on the number
of days set in the system option Price Change Processing
Days. The earliest date price changes can be created is
today’s date plus the price change processing days. If you
have emergency price change permission, Price Change
Processing Days will be ignored.

3. In the Price Guide field, enter the ID of the price guide you want to apply to the price
change, or click the LOV & button and select a price guide.

Note: The price guide only applies to the items in the same
department as the price guide and locations that share the
same currency as the currency on the price guide.

4. In the Reason Code field, enter the ID of the reason you are creating the price change,
or click the LOV & button and select a reason code.
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Setup Price Change Type

1.

Select Locations
1.

In the Price Change Type field, select the type of price change that is occurring.

Note: If you selected locations with multiple currencies, you
can only choose to create a price change by percent or to
reset the POS price.

= Change By Percent: A price for an item is changed by a percentage added to or
removed from the basis regular retail. The percent of change is determined by
the percent entered in the Change Amount field.

= Change By Amount: A price for an item is changed by an amount added or
removed from the basis regular retail. The amount of change is determined by
the amount entered in the Change Amount field.

=  Fixed Price: The price for the item will be at a specified retail that will be defined
in the change amount field.

= Reset POS Price: The item will be recognized on a price change but no change to
the retail will occur. When you select Reset POS Price, the Change Amount field
and Selling UOM field will be disabled.

In the Change Amount field, enter an amount.

If appropriate, define the multi-unit pricing for a price change:

a. Select the Multi Unit Pricing check box.

b. In the Multi Units field, enter the number of units that are part of the price
change.

c. In the Multi Unit Retail field, enter the new price for the items.
d. In the Multi Unit UOM field, enter the ID of the unit of measure that applies to
the price change, or click the LOV & button and select a unit of measure.

If appropriate, select the Ignore Constraints box. When unchecked, the promotion
constraints will be taken into account when conflict checking is performed on the

price change. When checked, promotion constraints will be ignored when conflict
checking is performed on the price change.

In the Location Selection area, select how you want to add locations to the price
change.

= Zone Group: Enter the ID of the zone group that contains the locations to add to
the price change, or click the LOV & button and select a zone group.

= Zone: Enter the ID of the zone to add to the price change, or click the LOV B+
button and select a zone.

* Location: Enter the ID of the location that you want to add to the price change, or
click the LOV &+ button and select a location.

Note: You can create price changes at the zone or location
level.

Click Select. The zones and/or locations that meet your criteria are added to the
table in the Location Selection table.
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Create a Regular Price Change

Select Items

2.

In the Price Change Maintenance pane, in the Item Selection area, select items on the
price change using the available fields.

* Item Selection

|
|
[rtem [~

Ttem Level | =]
[
||

Ttem Selection Il
| m Diff ID | Desciption

Item Selection area of Price Maintenance pane

Note: All fields with LOV B+ buttons allow multiple
selections.

To select items from all available items, enter an ID in the Item field, or click the
LOV &+ button and select item.

Enter information in the enabled fields to limit the items available in the Item
field.

In the Department field, enter a department number, or click the LOV B+
button and select a department.

In the Class field, enter a class number, or click the LOV &+ button and
select a class.

In the Subclass field, enter a subclass number, or click the LOV El+ button
and select a subclass.

In the Item Type drop-down, select Item or Item List.

Note: If you select Item List from the Item Type drop-down,
only item lists will be selectable from the Item field. If you
select Item, only single items that conform to the other
criteria specified will be selectable.

In the Item Level drop-down, select Parent Item, Parent Item/Diff, or
Transaction Level Item.

Note: The Diff Type and Diff fields are only enabled if
Parent Item /Diff is selected.

In the Diff Type drop-down, select a diff type.
In the Diff drop-down, select a diff.

In the Item field, click the LOV &+ button and select items.

Click Select. Items that meet your criteria are added to the Item Selection table.
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Create a Vendor Funded Price Change

Complete the Price Change

1. In the Price Change Maintenance pane, click Apply to create price changes. One price
change will be created for each item/location intersection.

Change the status of your price change as appropriate.

Click Done to save your changes and close the workspace.

Create a Vendor Funded Price Change

Navigate: From the Task Pad, select Price Changes > Create Price Change. The Create
Price Change workspace opens.

%5 Create Price Change

I@ Price Change List

Price Change

2

Zene Group

~ Location Selection

S|

d Link Code Item Item Descripfl Item Level Diff Id Diff Id Descri] Location Location Desd Location Type Primary Zom
[Ficer sy [ ¥ ||| Feer sy [ ¥ || [ iteer sy ¥ | [ Fitter sy ] || e oy [ ||| Fitter oy [ || Fitear o] [ Fitear oy || [ Fitr & ] [ Fiter 2y ]| Fier £y 7]
4 »
2 E=
Mew
@ Price Change Maintenance
1= g
Type @ Regular Price Guide I:l g
(01 vendor Funded *Reason Code |:| 8
() Link Code
* Effective Date l:l
Change Type |Change By Armount lz' Multi Unit Pricing O
Change Amount | |
Ignore Constraints 8

R

cancel |[ Save +Repest [[ Dore |

Create Price Change Workspace
1. In the Price Change Maintenance pane in the Type field, select Vendor Funded.
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Create a Vendor Funded Price Change

I-‘(_-"f Price Change Maintenance

Type () Regular
(®) vendor Funded
() Link Code

[ =

* Effective Date

change Type [change By Amount

Change Amount |

|

Partner Type [ select-

*

* Funding Type |

¥ Location Selection

Price Guide

* Reason Code

Multi Unit Pricing

[ 18
L I8

O

I 0 m

Location Selection (=3
Level 1D Description | Location Type ‘
b Item Selection
Item Selection " &
Level jui) Diff ID | Description ‘

|

Price Change Maintenance Pane

In the Effective Date field, enter the date the price change should go into effect, or
click the calendar E button and select a date.

Note: The Effective Date you can set depends on the number
of days set in the system option Price Change Processing
Days. The earliest date price changes can be created is
today’s date plus the price change processing days. If you
have emergency price change permission, Price Change
Processing Days will be ignored.

In the Price Guide field, enter the ID of the price guide you want to apply to the price
change, or click the LOV & button and select a price guide.

Note: The price guide only applies to the items in the same
department as the price guide.

In the Reason Code field, enter the ID of the reason you are creating the price change,
or click the LOV & button and select a reason code.
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Create a Vendor Funded Price Change

Select the Vendor and Deal

1.

In the Price Change Maintenance pane, in the Partner Type drop-down, select the
partner type.

Manufacturer
Distributor
Wholesaler
Supplier

In the Partner field, enter the ID of the partner with the deal, or click the LOV
button and select a partner.

In the Deal ID field, enter the ID of the deal, or click the LOV & button and select a
deal.

In the Deal Detail ID field, enter the ID of the deal details, or click the LOV E button
and select the deal details.

Setup Price Change Type

1.

Select Locations
1.

2.

In the Price Change Type field, select the type of price change that is occurring.

Note: If you selected locations with multiple currencies, you
can only choose to create a price change by percent or to
reset the POS price.

Change By Percent: A price for an item changed by is a percentage added to or
removed from the basis regular retail. The percent of change is determined by
the percent entered in the Change Amount field.

Change By Amount: A price for an item is changed by an amount added or
removed from the basis regular retail. The amount of change is determined by
the amount entered in the Change Amount field.

Fixed Price: The price for the item will be at a specified retail that will be defined
in the change amount field.

Reset POS Price: The item will be recognized on a price change but no change to
the retail will occur. When you select, the Change Amount field and Selling
UOM field will be disabled.

In the Change Amount field, enter an amount.

If appropriate, define the multi unit pricing for a price change:

a.
b.

Select the Multi Unit Pricing check box.

In the Multi Units field, enter the number of units that are part of the price
change.

In the Multi Unit Retail field, enter the new price for the items.

In the Multi Unit UOM field, enter the ID of the unit of measure that applies to
the price change, or click the LOV & button and select a unit of measure.

In the location area of the Price Change Maintenance pane, in the Location field,
enter a location ID, or click the LOV &+ button and select locations.

Note: Only locations on the deal are selectable.

Click Select. Locations are added to the table in the Location Selection table.
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Create a Vendor Funded Price Change

Enter Funding Information

1. In the Price Change Maintenance pane, in the Funding Type drop-down, select
Percent or Amount.

Note: If the selected locations have different currencies, only
Percent is available.

2. In the Funding Amount field, enter an amount.

Select Items

1. In the Item Selection area of the Price Change Maintenance pane, in the Item field,
enter an item ID, or click the LOV B+ button and select items.

Note: Only items on the deal are selectable.

2. Click Select. The items appear in the Item Selection table.

Complete the Price Change
1. In the Price Change Maintenance pane, click Apply to add all your changes.
2. Change the status of your price change as appropriate.

3. Click Done to save your changes and close the workspace.
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Create a Link Code Price Change

Create a Link Code Price Change

Navigate: From the Task Pad, select Price Changes > Create Price Change. The Create
Price Change workspace opens.

%5 Create Price Change
=

I@ Price Change List

2

Diff Id Diff Id Descri] Location Location Desd Location Type Primary Zom

Price Change

d Link Code Item Item Descripfl Item Level

Fitter by | ¥ | Fiter b [ | [ Fiter ty [ ]|[ Fier £y 7]

Fitver by | ||| Fitver by | w||| Fitter by | W) | Fitrer by | wN| Fitver by | wl|| Fitver by | w| | Fitver by ¥

4 »
A  —
Status mction |- select - [conflict check_|[_suagestpat= | || |

[[_Loc Excaption |[ Tran Excsptian ||

Delate | Hew ]| Copy

I@ Price Change Maintenance

Type

* Effective Dats l:l

Change Type [chang= By Amount

lz' Multi Unit Pricing O

Multi Units

Change Amount |

selling Uom . Multi Unit Retail

Igriore Constraints Multi Unit UGM B

¥ Location Selection
Zone Group 8 -
cancel |[ Save +Repest [[ Dore |

Create Price Change Workspace
1. In the Price Change Maintenance pane, select Link Code.

I@ Price Change Maintenance

() Regular Frice Guide B

() Wendar Funded ¥ Reason Code l:l E
® ig
¥ Effective Date l:l

Change Type |

Tupe

E| Multi Unit Pricing [

Multi Units

Change Armount
Selling UQM . Multi Unit Retail

Multi Unit LM .
* Link Code
¥ Link Code l:l E
¥ Currancy usD E Us Dallar
Zone Group .
Zone .+
Lacation .+

| |

Price Change Maintenance Pane
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Create a Link Code Price Change

2.

3.

In the Effective Date field, enter the date the price change is should go into effect, or
click the calendar E button and select a date.

Note: The Effective Date you can set depends on the number
of days set in the system option Price Change Processing
Days. The earliest date price changes can be created is
today’s date plus the price change processing days. If you
have emergency price change permission, Price Change
Processing Days will be ignored.

In the Reason Code field, enter the ID of the reason you are creating the price change,
or click the LOV & button and select a reason code.

Select Link Codes

1.

In the Link Code area of the Price Change Maintenance pane, in the Link Code field,
enter the ID of the link code, or click the LOV & button and select a link code.

In the Currency field, enter the currency code, or click the LOV & button and select
the currency.

In the Zone Group field, enter the ID of the zone group that contains the locations
you want to add to the price change, or click the LOV &+ button and select a zone
group.

In the Zone field, enter the ID of the zone that contains the locations you want to add
to the price change, or click the LOV &+ button and select a zone.

Note: The Zone field is limited by the currency entered in
step 2.

In the Location field, enter the ID of the location that you want to add to the price
change, or click the LOV H+ button and select a location.

Note: You can create price changes at the zone level.
Locations are not required.

Set Up Price Change Type

1.

2.
3.

In the Change Type field, select Fixed Price.

=  Fixed Price: The price for the item will be at a specified retail that will be defined
in the change amount field. Link code price changes can only be setup as fixed
price.

In the Change Amount field, enter an amount.

If appropriate, define the multi unit pricing for a price change:

a. Select the Multi Unit Pricing check box.

b. In the Multi Units field, enter the number of units that are part of the price
change.

c. In the Multi Unit Retail field, enter the new price for the items.

d. In the Multi Unit UOM field, enter the ID of the unit of measure that applies to
the price change, or click the LOV & button and select a unit of measure.

User Guide 155



Change the Status of a Price Change

Complete the Price Change
1. In the Price Change Maintenance pane, click Apply to add all your changes.
2. Change the status of your price change as appropriate.
3. Click Done to save your changes and close the workspace.

Change the Status of a Price Change

Navigate: From the Task Pad, select Price Changes > Maintain Price Changes. The

Maintain Price Changes workspace opens.

1. In the Price Change Search pane, search for and retrieve the price change you want to
maintain. Your results are displayed in the Price Change List pane.

I@ Price thange List |

Price Change Wiew |Standard Column Vlew ” d
Id Link Code Item Item Descripd Item Level | Diff Id Diff Id Descri| Location Location Desq Location Typd Primary Zon
Fiteer by | :| Fiteer by | :| Fiteer by | :| Fiteer by | W\ | Fiteer by | w || Fiteer by | w || Fitrar by | w ||| Fitray by w ||| Fitey by w || Fitber by w ||| Fitper by | #1
941 100151009 [RPM GaA **., [Tranzaction ., 3 AUD locatio.., [Zone b4
Iz1 100151009 |RPM Q& **., [Transaction ., 3 AUD location, |Zone :
202 100118006 |Misty Test L |Transaction .. 1000000027 |Sydney Store
201 100118006 |Misty Test L.|Transaction ... 1000000025 |Las Vegas  |$tore
4 [ 3
hs| 123450kpr] Gotopage [t |of17 E=
Select All
action [ selec - [T
| Mew || Copy |
Price Change List Pane
(@ Price thange Search |
¥ Departrnent l:l B+ ¥ price Change 1d | |
B Type T 5|
B Status [ select - [~
Iten Level  [rvansaction Level ttam|¥] [] S=arch On This Leval Only Crasts Dats [ |8 o |&@
Effactive Date | ‘ To | |
g S —
» Location
» Adwvanced Search
| Coieer | [sman |

Price Change Search Pane

Note: If you are in the Create Price Change workspace your
price changes are displayed in the Price Change List
container when you click Apply. You do not need to open
the Maintain Price Change workspace.

2. Select the price change for which you want to change the status.

= In the table, select a row.
= Click Select All. All records in the Price Change List pane are selected.
3. Inthe Action field, select the status to which you want to move the price change.
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Change the Status of a Price Change

4.
5.

Click Update. You are prompted to confirm your decision.

Click Yes. If the system option, background conflict check, is off and conflicts exist,
the Conlflict Review List window opens.

Conflict Review List X

Conflict Review List " &

I Promotion Componen| Ttem Location Change Type Change Amount Effective Date

Price Change Tyj ID Promotion Comp Date Unit Retail on E{ Selling UDM Multi Units Multi-Unit Retail Multi-Unit Sellin
Price Change 3221 12-04-2004 $26.84 EACH
Price Change 3242 12-01-2005 $35.22 EACH

Conflict Review List Window

Note: See "View Conflict Check Results" for more
information on background conflict checking. When
background conflict check is on, a binocular B4 icon appears
in the conflict column when conflict checking is complete.
Click the icon to open the Conflict Review List workspace.

a. The current price change is displayed in the upper half of the window. Price
changes promotions, and/or clearances for the same item/location are displayed
in the lower half of the window.

b. Click Close to close the Conflict Review List. The "Maintain a Price Change"
procedure contains additional information on how to adjust a price change.

6. Click Done to save any changes and close the window.
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Maintain a Price Change

Maintain a Price Change

Navigate: From the Task Pad, select Price Changes > Maintain Price Change. The
Maintain Price Changes workspace opens.

1. In the Price Change Search pane, search for and retrieve the price change you want to
maintain. Your results are displayed in the Price Change List pane.

Irf‘-W Price Change List |

2

Id Link Code Item Item Descripf Item Level Diff Id Diff Id Descr| Location Location Desqd Location Typd Primary Zon

Fitkar by FA|| Fitter by | ||| Fitver by:| V| Fitter by ||| Fitver by:| ™ )| | Fidber by || Fitter by:| ||| Fitver by:| V|| Fitter by ||| Fitter by | || | Fiitter by | ™

241 100151009 |RPM QA **,,, [Transacrion ... 3 AUD locatio.. [Zone b4
221 100151008 |RPM Q& **., |Tranzaction ., g AU location, |Zone :
20z 100112006 |Misty Test Lo |Transaction ., 1000000027 [Sydney Stare
201 100118006 |Misty Test L.|[Transaction .., 1000000025 [Las Yegas  |Stare

.3

4

[
W [t z2450]kr] Gotopage oF17 =

| Suggest Date |

status  [apcroved action [ gelect - [¥] P [Lcanflict Chack

| | Delete H Mew || Copy || Loc Exception || Tran Exception ||

Price Change List Pane

(@ price thange Search

¥ Departrent l:l B+ * price Change 1d |

Subclass B+ Status [ setect -

Itern Type ‘Itam lzl Created By I:l 8
Ttamn Level [Jsearch on This Level Gnly Creste Date [ & e [=]

Ll

Diff Type Cselect- 54| Bieine Ben | |& o =
S S—]

oiff B

} Location

» Advanced Search

| |

Price Change Search Pane
2. From the list of results, select the price change you want to maintain. The price
change details appear in the Price Change Maintenance pane.
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Maintain a Price Change

I@ Price Change Maintenance

* i =
Effective Date 0zf02/2009
Change Type [change ey Amount [~ Multi Unit Pricing [ ]

Change Amount |200,00 |

a8
8

Location Selection " &
Level | juil ‘ Description | Location Type
Store | 1000000000 | Farga | Store
Item Selection " &;
Level | i ‘ Diff 1D | Description
Parent Item | 100163000 | |CN*1

| |
Price Change Maintenance Pane
If necessary, change the status of the price change to Worksheet.

Edit the enabled fields as necessary.

Note: You cannot change the items and locations on a price
change.

Click Apply to add all any changes.
Click Done to save any changes and close the window.
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Maintain a Price Change

Copy a Price Change
1. From the list of results, select the price change you want to copy.
2. Click Copy. The price change details appear in the Price Change Maintenance pane.

I(: Price Change Maintenance |

* Effective Date nzfozfzo0s (B
Change Type |(;|-.ange By Amount |E| Multi Unit Pricing [

Change Armount |200,gg |

8
Location Selection " .{2
Level | 1D ‘ Description | Location Type
Store | 1000000000 | Fargo | Store
Item Selection (=4
Level | i Diff 1D | Description
Parent Item | 100163000 | |CN-1

| oo |

Price Change Maintenance Pane

Edit the enabled fields as necessary.
Click Apply to add all any changes.
5. Click Done to save any changes and close the window.

Note: Effective dates, exceptions, and status are not copied
when copying a price change.

Delete a Price Change

From the list of results, select the price change you want to delete.
Click Delete. You are prompted to confirm your decision.

Click Yes. The price change is deleted.

o Dbd =

Click Done to close the window.

Note: Only price changes with a status of Worksheet can be
deleted.
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Maintain a Price Change

Check for Conflicts

1.
2.

Suggest a Date
1.
2.

From the list of results, select the price change you want to check.

Click Conflict Check. If the system option, background conflict check, is on and
conflicts exist, the Conflict Review List window is displayed.

Conflict Review List

Conflict Review List " &

I Promotion Componen| Ttem Location Change Type Change Amount Effective Date

Change By Percent  15%

Price Change Tyj ID Promotion Comp Date Unit Retail on E4 Selling UOM Multi Units Multi-Unit Retai| Mult-Unit Selling

Price Change 2221 12-04-2004 §26.24 EACH

Price Change 3243 12-01-2005 §35.22 EACH

Conflict Review List Window
= If no conflicts exist, click OK.

= If conflicts exist, you must adjust the details of your price change before you can
move the price change to the next status.

Note: See View conflict check results for more information
on background conflict checking.

Click Done to save any changes and close the window.

From the list of results, select the price change you want to suggest a date for.

Click Suggest Date. The system runs a check of promotion constraints, then
calculates an appropriate date and places it in the effective date field.

Click Done to save any changes and close the window.

Create a Location Exception

1.
2.

Note: Location exceptions can only be created for Zone Level
price changes

From the list of results, select the price change.

Click Location Exceptions. The locations selection area of the Price Change
Maintenance pane is enabled.
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(@ Price Change Maintenance

¥ Effective Date nzfozizons |[E
Change Type [change ey Amount [~

Change Amount |200,00 |

Price Guide

—

¥ Resson Code

Multi Unit Pricing ]

Location Selection Il &
Level | juil ‘ Description | Location Type
Store | 1000000000 | Farga | Store
Item Selection Il 52
Level | i ‘ Diff 1D | Description
Parent Item | 100163000 | |CN*1

| Apply |

Price Change Maintenance Pane

In the Location field, enter the ID of the location where items are different than the
zone on the price change, or click the LOV & button and select a location in the zone.

In the enable price change fields, enter information about the price change for the

item/location.
Click Apply to add any changes.

Click Done to save any changes and close the window.

Create Iltem Exceptions at the Transaction Level

Note: Item exceptions at the transaction level can occur only
when the price change was created at the item parent or item

parent/diff level.

From the list of results, select the price change.
Click Tran Exceptions. The item selection area of the Price Change Maintenance pane

is enabled.
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I@ Price Change Maintenance

* i =
Effective Date 0zf02/2009
Change Type [change ey Amount [~ Multi Unit Pricing [ ]

Change Amount |200,00 |

a8
8

Location Selection " &
Level | juil ‘ Description | Location Type
Store | 1000000000 | Farga | Store
Item Selection " &;
Level | i ‘ Diff 1D | Description
Parent Item | 100163000 | |CN*1

| Coam |

Price Change Maintenance Pane

In the Item field, enter the ID of the item for which items are different than the parent
item on the price change, or click the LOV B button and select an item.

In the enable price change fields, enter information about the price change for the
item.

Click Apply to add any changes.
Click Done to save any changes and close the window.
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Create Price Changes for Area Differential

Navigate: From Task Pad, select Price Changes> Price Changes for Area Differentials.
The Price Changes for Area Differentials pane opens.

B3 price Changes for Area Differentials

(@ Price thanges for Area Differentials
Department Id | Department Class Id Class Subclass Id Subclass Zone Group Zone Group Id | Zone Zone Id Price Guide
1234| Glassware RPM-INT-ZG1 18|22 ad
1414 Activewear All Locations 1| USD locations *
1414 Activewear All Locations 1| USD locations 1
Zone Id Zone Name Differential Percent Auto Approve Price Guide Create Price Chan{ Effective Date Create Date State
[ create Price changes Effective Date | |@ [_aeely_|

Price Changes for Area Differentials Pane
1. Select Primary area from the top Multi-Record Block.

2. Secondary areas for the Primary area will appear in the bottom Multi-Record Block.
Select the secondary area you want to create price changes for.

3. Click Create Price Changes.
Enter an Effective Date.
Click Apply.
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Clearances

A clearance is designed to move out of date and slow selling merchandise out of a store.
A clearance is considered a permanent price change, and inventory is consequently
revalued. Once the reset date for a clearance has passed, the item’s price and inventory
value is returned to the regular price. The following clearances can be created.

* Regular: The clearance is occurring at the retailer's initiative.
* Vendor Funded: The supplier is subsidizing a portion of the clearance.

When a clearance is added to RPM, it must go through a series of checks before it can be
applied to an item/location. Depending on your user role, you may not be able to move
the clearance to the next status. A clearance may be in any of the following statuses:

Status Definition
Worksheet The clearance has been started, but not reviewed or sent out.
Submitted The clearance has been completed and is pending review. Conflict

checking has occurred for the price change.

Approved The clearance has been reviewed and accepted. The clearance is
communicated to the locations for which the clearance is effective.

Executed The clearance prices established are effective for the item/location.

Rejected The clearance has been reviewed and declined.

After you create a clearance, you can maintain different aspects of the clearance. You can
create exceptions to the items and locations that exist on the clearance, you can change
the specifics of the clearance and you can copy an existing clearance.

There are procedures you can use to navigate and search for clearances through the
Maintain Clearances task on the Task Pad; however, you can accomplish these same
tasks after you create a clearance and the clearance opens in the Clearance List pane in
the Create Clearance workspace.
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Search for a Clearance

Navigate: From the Task Pad, select Clearances > Maintain Clearances. The Maintain
Clearances workspace opens.

I@ Clearance Search

* Departrnent
Class
Subclass
Itern Type
Itern Level
Diff Type

* Itern

Diff

} Location

[ I8+
B
B8+

[eem

=]

ransaction Level Item|[¥| [ $2arch @n This Level Only

- Select -

[ I8+
B

b Advanced Search

=

* Clearance 1d |

|
&
Il

Status [ seleet-

Creste Dste |

& | |5

Effective Date |

|& 7o [=]

Maintain Clearances Workspace
1. Enter criteria as necessary to restrict the search to the clearances you want to

maintain.
2. Click Search. Your results appear in the Clearance List pane.

I@ Clearance List

2

SE1(100022004  [Ariel sle

epe., |Parent Item

Clearance
Id Item Item Descrip Item Lewvel Diff Id Diff Id Descri| Location Location Desg Location Typd Primary Zone| Exnception Ind Parg
Fitrer by | W Fitear by | ||| Ficer sy | ¥ ||| Fitcer by | | Fitrar by | w ||| Fitter by | ¥ ||| Fiver ty | ¥ ||| Fitrer | wl| Fitrar by | w || Fiter by | ¥ ||| Fitrer ty | w ||| Fite

11 Test ClrZon.., [Zone

542|100000016& |Test Item 1. [Transaction .

1000000014 |Baltimore Store

541(100000016 |[Test Itern 1. [Tranzaction ..

1000000014 (Baltimore

Stare

524|100025213 MM Fachion ..[Tranzaction .

1000000001 [Minneapalis

Store

4

»

D [@W[123450]p] cotopage [L |af7

Status

Approved action [ select - [7] Update

Conflict Check

[ Delate

Hew I Copy

| Loz Exception ][ Tran Exception ||

Clearance List Pane
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Create a Regular Clearance

Navigate: From the Task Pad, select Clearances > Create Clearance. The Create Clearance
workspace opens.

%5 Create Clearance

Iff—W Clearance List

view g oo w5 | 4,

Location Location Desd Location Typa Primary Zone | Exception In

Id Item Ttem Descripy Item Level Diff 1d Diff Id Descril

Fitker by | W[ Fitter sy [ ¥ ||| Fter oy | wl|| Fitter by 7| Ftter 6y |+

riteer by | ¥ ||[ Fiteer by [ ¥ ][ Fiter by [ ¥ || Fiter sy [ ¥ ][ Fiter sy [ ¥ ]| Fiter 8¢ ] 7

4 2
S| =
B e -
Delete | Hew ]| Copy |[_Lac Exception ][ Tran Exception ||
IrfJ tlearance Maintenance

Type

eqular Frice Guide l:l =]

) wendor Funded

* Effactiva Date l:l

Change Type [arnount off = Out Of Stack Date l:l
Change Amount | Resat Date l:l

Eatliest Reset Date

Latest Reset Date

apply Subclass Defsults [

~* Location Selection

Zone Group %
Create Clearance Workspace

1. In the Clearance Maintenance pane in the Type field, select Regular.
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((=1 Clearance Maintenance
[E

Type (@) Regular Prica Guide l:l
() vendar Funded * Reason Code |:| =
¥ Effective Date l:IE
Change Type s cunt off Out O Stock Date l:IEI
Change Amaount | ‘ Reset Date l:l@

Apply Subclass Defaults  [7]

* Location Selection

Location Selection " &;
Level | d Description ‘ Location Type |

* Item Selaction

Itemn Type  [Item

]

Itern Level |Transaction Level Itern

Clearance Maintenance Pane

In the Effective Date field, enter the date the clearance is enabled, or click the
calendar E button and select a date.

Note: The Effective Date you can set depends on the number
of days set in the system option Price Change Processing
Days. The earliest date clearances can be created is today’s
date plus the price change processing days, unless you have
emergency privileges.

In the Price Guide field, enter the ID of the price guide you want to apply to the
clearance, or click the LOV El button and select a price guide.

Note: The price guide only applies to the items in the same
department as the price guide and locations that share the
same currency as the currency on the price guide.

In the Reason Code field, enter the ID of the reason you are creating the clearance, or
click the LOV El button and select a reason code.

In the Out of Stock Date field, enter the date you expect the inventory to be
consumed, or click the calendar B button and select a date.

Note: Depending on your system settings the date may
default.

In the Reset Date field, enter the date the price of the item returns to regular price, or
click the calendar B button and select a date.
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Note: Depending on your system settings the date may
default.

Select Apply Subclass Defaults to attach a Clearance Defaults Pricing Strategy to the

clearance.

Note: Set up a Clearance Pricing Strategy before creating a
clearance. See the Clearance Defaults section of the Maintain
Price Strategies chapter for complete information on setting
up a Clearance Defaults pricing strategy.

Setup Clearance Type

1. In the Price Change Type field, select the type of clearance that is occurring.

Note: If you selected locations with multiple currencies, you
can only choose to create a clearance by percent.

Change By Percent: A price for an item changed by is a percentage added to or
removed from the basis retail price. The percent of change is determined by the
percent entered in the Change Amount field.

Change By Amount: A price for an item is changed by an amount added or
removed from the basis retail price. The amount of change is determined by the
amount entered in the Change Amount field.

Fixed Price: The price for the item will be at a specified retail that will be defined
in the change amount field.

2. In the Change Amount field, enter the amount, percent, or fixed amount for the
clearance.

Select Locations

1. In the Location Selection area, select how you want to add locations to the clearance.

Select Items

Note: There is no need to enter a negative sign before the
number entered in the Change Amount field. A clearance
can only exist as a decrease in price.

Zone Group: Enter the ID of the zone group that contains the locations to add to
the clearance, or click the LOV &l button and select a zone group.

Zone: Enter the ID of the zone to add to the clearance, or click the LOV &l button
and select a zone.

Location: Enter the ID of the location to add to the clearance, or click the LOV
button and select a location.

2. Click Select. Locations that meet your criteria are added to the table in the Location
Selection area.

1. In the Clearance Maintenance pane, in the Item Selection area, select items on the
clearance using the available fields.
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¥ Item Selection

Item Type  [itemn =
Item Lavel | =]
-]
=]
Item Selection |l
Level | D Diff ID | Description

Item Selection Area of Clearance Maintenance Pane

Note: All fields with LOV &l buttons allow multiple items to
be selected.

= To select items from all available items, enter an ID in the Item field, or click the
LOV El button and select item.

a. Enter information in the enabled fields to limit the items available in the Item
field.

In the Department field, enter a department number, or click the LOV
button and select a department.

In the Class field, enter a class number, or click the LOV &l button and select
a class.

In the Subclass field, enter a subclass number, or click the LOV &l button and
select a subclass.

In the Item Type drop-down, select Item or Item List.

Note: If you select Item List from the Item Type drop-down,
only item lists will be selectable from the Item field. If you
select Item, only single items that conform to the other
criteria specified will be selectable.

In the Item Level drop-down, select Parent Item, Parent Item /Diff, or
Transaction Level Item.

Note: The Diff Type and Diff fields are only enabled if
Parent Item/Diff is selected.

In the Diff Type drop-down, select a diff type.
In the Diff drop-down, select a diff.

b. In the Item field, click the LOV E! button and select items.

2. Click Select. Items that meet your criteria are added to the table in the Item Selection

area.

Complete the Clearance
1. Click Apply to add any changes.
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Create a Vendor Funded Clearance

2. Change the status of your clearance as needed.
3. Click Done to save any changes and close the workspace.

Create a Vendor Funded Clearance

Navigate: From the Task Pad, select Clearances > Create Clearance. The Create Clearance

workspace opens.

B3 cCreate Clearance
N
(B claaranca tist =
tlearance views [standard Colurnn view[7] || &
1d Ttem Item Descripl] Ttem Level | Diff Id Diff Id Descri] Location Location Desq Location Typd Primary Zone| Exception In
[ Fitter by | ¥ ||| Fiter by {7 ||| Fiter by {7 ||| Fiter by {7 ||| Fiter {7 ||| Fiter [ ¥ ||| Fiter ¥ ||| Fiter | ¥ ||| Fiter {7 ]|[ Fiter by {7 ]|[ Fiter £y ]+
4 ]
9 ==
I@ clearance Maintenance |
Type (®) Regular Price Guide |:| 8
() wender Funded * Reason Code |:| 8
* Effective Date I:I
Change Type [armaurnt off =] Out Of Stock Date l:l
EherEn Are | | R Bt [ =
Apply Subclass Defaults 7]
~ Location Selection
Fane Graoup % EI

Create Clearance Workspace

1. In the Clearance Maintenance pane in the Type field, select Vendor Funded.
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((=1 Clearance Maintenance
[E

Type (@) Regular Prica Guide l:l
() vendar Funded * Reason Code |:| =
¥ Effective Date l:IE
Change Type s cunt off Out O Stock Date l:IEI
Change Amaount | ‘ Reset Date l:l@

Apply Subclass Defaults  [7]

* Location Selection

Location Selection " &;
Level | d Description ‘ Location Type |

* Item Selaction

Itemn Type  [Item

]

Itern Level |Transaction Level Itern

Clearance Maintenance Pane

In the Effective Date field, enter the date the clearance is enabled, or click the
calendar E button and select a date.

Note: The Effective Date you can set depends on the number
of days set in the system option Price Change Processing
Days. The earliest date clearances can be created is today’s
date plus the price change processing days, unless you have
emergency privileges.

In the Price Guide field, enter the ID of the price guide you want to apply to the
clearance, or click the LOV El button and select a price guide.

Note: The price guide only applies to the items in the same
department as the price guide and locations that share the
same currency as the currency on the price guide.

In the Reason Code field, enter the ID of the reason you are creating the clearance, or
click the LOV El button and select a reason code.

In the Out of Stock Date field, enter the date you expect the inventory to be
consumed, or click the calendar B button and select a date.

Note: Depending on your system settings the date may
default.

In the Reset Date field, enter the date the price of the item returns to regular price, or
click the calendar B button and select a date.
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Create a Vendor Funded Clearance

Note: Depending on your system settings the date may
default.

7. Select Apply Subclass Defaults to attach a Clearance Defaults Pricing Strategy to the
clearance.

Select the Vendor and Deal

1. In the Clearance Maintenance pane, in the Partner Type drop-down, select the
partner type.

= Manufacturer
= Distributor
=  Wholesaler
= Supplier
2. In the Partner field, enter the ID of the partner with the deal, or click the LOV
button and select a partner.

3. Inthe Deal ID field, enter the ID of the deal, or click the LOV El button and select a
deal.

4. In the Deal Detail ID field, enter the ID of the deal details, or click the LOV El button
and select the deal details.

Select Locations
1. In the location area of the Clearance Maintenance pane, in the Location field, enter a
location ID, or click the LOV El * button and select locations.

Note: Only locations on the deal are selectable.

2. Click Select. Locations are added to the table in the Location Selection table.

Enter Funding Information

1. In the Clearance Maintenance pane, in the Funding Type drop-down, select Percent
or Amount.

Note: If the selected locations have different currencies, only
Percent is available.

2. In the Funding Amount field, enter an amount.

Select Items
1. In the Item Selection area of the Clearance Maintenance pane, in the Item field, enter
an item ID, or click the LOV El* button and select items.

Note: Only items on the deal are selectable.

2. Click Select. The items appear in the Item Selection table.

Complete the Clearance
1. Click Apply to add any changes.
2. Change the status of your clearance as appropriate.
3. Click Done to save any changes and close the workspace.
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Change the Status of a Clearance

Navigate: From the Task Pad, select Clearances > Maintain Clearances. The Maintain
Clearances workspace opens.

I'/C-j tlearance Search

* Departrnent l:l B+ * Clearance 1d | |
= =
B Status [ seleet- =l
ltarn Type [t=m =] Created By l:l 8
Themn Level [ 5earch on This Lewel Only Create Date [ |& 7o | |E
Effective Date | | To | |
R E—] -
8
b Location
b Advanced Search
| [otear | searn |

Maintain Clearances Workspace

1. Search for and retrieve the clearance you want to maintain. Your results appear in
the Clearance List pane.

(= clearance List

Clearance View [Markup Column view [=] || &#

[remm [ wimm Descried Toem tovel [ oeffrd | oiffrd pescr] Locason [ Location 0eed tocation Tvpd Primary zona| Exception 10d Pard

Ftrer Sy : suter by | || Forer 2 [ ||| Fmirer sr [ ||| miter s [ ||| mtver 20 | | [ miver a0 [ || mrer ax [ || mter o0 [ || eer 20 [ 2| Fiter 20 [ || s

sci1fio00z2z004 . |zene

saz[1o000001e Srare

sa1f1o00o001e Srare

sz4[100025212 1000000001 [Minnespali=  |Store

S
= 123235 [rer] sste paas | E
Salmct Al

N

| T— 10 —

Clearance List Pane

Note: If you are in the Create Clearance workspace, your
clearances appear in the Price Change List container when
you click Apply. You do not need to open the Maintain Price
Change workspace.

2. Select the price change for which you want to change the status:
a. In the table, select a row.
b. Click Select All. All records in the Clearance List pane are selected.

3. In the Action field, select the status to which you want to move the clearance.
Click Update. You are prompted to confirm your decision.

Click Yes. If the system option, background conflict check, is off and conflicts exist,
the Conflict Review List window is displayed.
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Conflict Review List

Conflict Review List

Promotion Componen| Ttem Location Change Type Change Amount Effective Date

Fixed Price $25.35 12-01-2005

3410 EACH

| #
qe 1z 14§

EACH

Conflict review list window

Note: See View conflict check results for more information
on background conflict checking. When background conflict

check is on, a binocular 4 icon appears in the conflict
column when conflict checking is complete. Click the icon to
open the Conflict Review List workspace.

The current clearance opens in the upper half of the window. Price changes, promotions,
and clearances affecting the same item/location appear in the lower half of the window.

Click Close to close the conflict review list. The Maintain a clearance procedure contains
additional information on how to adjust a clearance.

6. Click Done to save any changes and close the window.

Maintain a Clearance

Navigate: From the Task Pad, select Clearances > Maintain Clearances. The Maintain
Clearances workspace opens.

I@ Clearance Search

* Departrnent l:l B+ * Clearance 1d | |
Class E"’ Type lz'
Subclass B+ status [ seleet- [~
Themn Level [ 5earch on This Lewel Only Create Date [ |& 7o | |E
Ciff Type [ select - Effective Date | | To | |

e ]
Diff B+

b Location

b Advanced Search

Maintain Clearances Workspace
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1. Search for and retrieve the clearance you want to maintain. Your results appear in
the Clearance List pane.

I@ Clearance List

2

Location Desq Location Typd Primary Zone| Exception Ind Parg
il

tlearance

Id Item Item Descrip Item Lewvel Diff Id Diff Id Descri| Location
Fitrer by | w || Fitver by | ¥ ||| Fiver | w ||| Fitrer by | w | Fitrar by | ||| Ficer sy | >

Fitrer by | w ||| Fitver by | ¥ ||| Fiver | ¥ ||| Fitrer | w || Fitrar by |+

1000000014

SE1(100022004 |Ariel sleepe., [Parent Item 11 Test ClrZon.., [Zone

542|100000016& |Test Item 1. [Transaction . 1000000014 |Baltimore Store

541(100000016 |[Test Itern 1. [Tranzaction .. 1000000014 (Baltimore Store

524|100025213 MM Fachion ..[Tranzaction . 1000000001 (Minneapalis  [Stare

3

4 [
b= Eiéiiém Go to page DF7 E

Haw I Capy [[ LocException ][ Tran Excaption ||

Status | approved Action |- gelect - |E|

| [ Calate

Clearance List Pane
2. From the list of results, select the clearance you want to maintain. The clearance

details appear in the Clearance Maintenance pane.

I@ tlearance Maintenance
Tvps @ Regular Price Guide -]
(Orvendor Funded ¥ Reazon Code B8
¥ Effective Date 1o/o1/zo0s | @

Change Type [Fixed Price = Qut Of Stock Date l:l
Change Amount 10,00 Reset Date 10/02/ 2008

Eatliest Reset Date
Latest Reset Date

Apply Subdass Defaults [

b Location Selection

[ clear |[ pelete | [ seleet |
Location Selection Il ¢
Level | 1d | Description | Location Type
Store |1000000020 |Or|ando |Stare
» Item Selection

[_clear | [_pelete [[_select |
Item Selection Il ¢
Level | 1d | Diff 1d | Description
Item |9999E| | |F‘L Regular Item 99990

| |

Clearance Maintenance Pane
3. If necessary, change the status of the price change to Worksheet.

4. Edit the enabled fields as necessary.

Note: You cannot change the items and locations on a
clearance.

5. Click Apply to add all any changes.
6. Click Done to save any changes and close the window.
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Copy a Clearance
1. From the list of results, select the clearance you want to copy.
2. Click Copy. The clearance details appear in the Clearance Maintenance pane.

(@ tlearance Maintenance

Qut OF Stock Date l:lEl

Apply Subclass Defsults  []
Location Selection | ¢
Level ‘ 1d ‘ Description | Location Type
Stare |1000000020 |Or|ando |Stwe
Item Selection Il ¢
Level | 14 | if 14 | Description
Item |99990 | |PL Regular Item 33930
| Apply |

Clearance Maintenance Pane

3. Edit the enabled fields as necessary.

4. Click Apply to add all any changes.

5. Click Done to save any changes and close the window.

Delete a Clearance

1. From the list of results, select the clearance you want to delete.
2. Click Delete. You are prompted to confirm your decision.

Note: Only clearances in worksheet status can be deleted.

3. C(lick Yes. The clearance is deleted.
4. C(Click Done to close the window.

Check for Conflicting Clearance
1. From the list of results, select the clearance you want to check.

2. Click Conflict Check. If the system option, background conflict check, is on and
conflicts exist, the Conflict Review List window opens.
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Conflict Review List

Conflict Review List

Promotion Componen| Item Location Change Type

Fixed Price

12-10-2004 $26.06 EACH

12-10-2004 $5.06 EACH

Conflict Review List Window
= If no conflicts exist, click OK.

= If conflicts exist, you must adjust the details of your clearance before you can
move the clearance to the next status.

Note: See View conflict check results for more information
on background conflict checking.

3. Click Done to save any changes and close the window.

Create a Location Exception

Note: Location exceptions can only be created for Zone Level
clearances.

1. From the list of results, select the clearance.

2. C(Click Location Exceptions. The locations selection area of the Clearance Maintenance
pane is enabled.
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If(: Clearanca Maintanance

Sut of Stock Date

Faset Dats

Apply Subdass Defaults

=
[rorozrznee]m

|

a
=

Location Selection (-2
Level |14 | Description [ Location Type [
Srore [to0a0a0020 [ortanda [
Item Selection I
Level ‘ 1d ‘ Diff 1d | O |
Item [s9990 [ |PL Regular teem 95590

| |

Clearance Maintenance Pane
3. In the Location field, enter the ID of the location where items are different than the
zone on the clearance, or click the LOV El button and select a location.

4. In the enabled clearance fields, enter information about the clearance for the

item/location.
5. Click Apply to add any changes.

Click Done to save any changes and close the window.

Create Item Exceptions at the Transaction Level

Note: Item exceptions at the transaction level can occur only
when the clearance was created at the item parent or item
parent/diff level.

1. From the list of results, select the clearance.

2. Click Tran Exceptions. The item selection area of the Clearance Maintenance pane is

enabled.
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(& tlearance Maintanance

B ]
=

Sut Of Stock Date =

Apply Subdass Defaults []

Location Selection I <2

Level |14 | Description [ Location Type [

Stare |1nﬂnnnﬂn20 |Or|ando |Stm’e

Item Selection I

Level ‘ 1d ‘ Diff 1d | O |

Irem |99990 | |DL Regular Item 93990

| o]
Clearance Maintenance Pane
3. In the Item field, enter the ID of the item for which items are different than the parent
item on the clearance, or click the LOV El button and select an item.

4. In the enabled clearance fields, enter information about the clearance for the
item/location.

5. Click Apply to add any changes.
Click Done to save any changes and close the window.

Create Clearance Resets

Navigate: From the Task Pad, select Clearances > Create Clearance Resets. The Create
Clearance Resets workspace opens.
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3 Create Clearance Resets
~ l
(@ treate Clearance Resets
+ Ttem Selection
Itern Type [itemn =
ttern Level  [Tranzaction Level Itemn =]
AR —]
Item Selection 3
Level 1 Diff 1d Description
~ Location Selection
Location selection 73
Level 14 Description Location Type
]

Create Clearance Resets Workspace

1. In the Reset Date field, enter the date to specify the day that the item or location’s
unit retail should be reset to its regular unit retail, or click the calendar 21 button and
select a date.

2. In the Item Selection area, select items on the clearance reset using the available
fields.

¥ Item Selection

L]
8
Item Type |Itam IE‘
Item Level | =
B
L]
Item Selection Il
Level | n Diff ID | Desciption

Item Selection area of Clearance Resets pane

Note: All fields with LOV B+ buttons allow multiple
selections.

= To select items from all available items, enter an ID in the Item field, or click the
LOV B+ button and select the item.

a. Enter information in the enabled fields to limit the items available in the Item
field.

In the Department field, enter a department number, or click the LOV
B+ button and select a department.
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8.

In the Class field, enter a class number, or click the LOV El* button and
select a class.

In the Subclass field, enter a subclass number, or click the LOVE&+
button and select a subclass.

In the Item Type drop-down, select Item or Item List.

Note: If you select Item List from the Item Type drop-down,
only item lists will be selectable from the Item field. If you
select Item, only single items that conform to the other
criteria specified will be selectable.

In the Item Level drop-down, select Parent Item, Parent Item /Diff, or
Transaction Level Item.

Note: The Diff Type and Diff fields are only enabled if
Parent Item/Diff is selected.

In the Diff Type drop-down, select a diff type.
In the Diff drop-down, select a diff.
b. In the Item field, click the LOV E1* button and select the items.

Click Select. Items that meet your criteria are added to the Item Selection table.

In the Location Selection area, select how you want to add locations to the clearance

reset.

=  Zone Group: Enter the ID of the zone group that contains the locations to add to
the clearance reset, or click the LOV & button and select a zone group.

= Zone: Enter the ID of the zone to add to the clearance reset, or click the LOVElT
button and select a zone.

= Location: Enter the ID of the location that you want to add to the clearance reset,
or click the LOV E1* button and select a location.

Note: You can create clearance resets at the zone or location
level.

Click Select. The zones and/or locations that meet your criteria are added to the
table in the Location Selection table.

In the Clearance Resets pane, click Apply to create clearance resets. One clearance
reset will be created for each item/location intersection.

Change the status of your clearance reset as appropriate.
Click Done to save your changes and close the workspace.

Clearance Resets Inquiry

Navigate: From the Task Pad, select Clearances > Clearance Resets Inquiry. The
Clearance Resets Inquiry workspace opens.
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%3 clearance Resets Inquiry

(@ clearance Resets Inquiry |d
8 8
B B —.
Ttem Type  [Itern =
Ttem Level  [Transaction Level tam
A —
8
Glear || Retrieve Clearance Resate |
Clearance Resets List I &
Ttem 14 [ 1tem Description [[oifrza [ Location [ Location Description [pate
Filker by [+ ][ Fiter 2y [ ][ =ter oy [+ ][ Fier s [ ]| Fier [ v ][ zer oy [~]
-

Create Clearance Resets Workspace

1. In the Filter section, select items on the clearance reset inquiry using the available

fields.
] ]
B e [
Itern Type  [ltem ]
Itern Level  fransa, ction Level Item ]
N —
8

Clesr || Ratrisus Clearance Resats

Item Selection area of Clearance Resets pane

Note: All fields with LOV &1 buttons allow multiple

selections.

= To select items from all available items, enter an ID in the Item field, or click the

LOV El* button and select the item.

a. Enter information in the enabled fields to limit the items available in the Item

field.

In the Department field, enter a department number, or click the LOV

* button and select a department.

In the Class field, enter a class number, or click the LOV E1 1 button and

select a class.

In the Subclass field, enter a subclass number, or click the LOV E1*

button and select a subclass.

In the Item Type drop-down, select Item or Item List.
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Note: If you select Item List from the Item Type drop-down,
only item lists will be selectable from the Item field. If you
select Item, only single items that conform to the other
criteria specified will be selectable.

In the Item Level drop-down, select Parent Item, Parent Item /Diff, or
Transaction Level Item.

Note: The Diff Type and Diff fields are only enabled if
Parent Item /Diff is selected.

In the Diff Type drop-down, select a diff type.
In the Diff drop-down, select a diff.

b. In the Item field, click the LOV E1t button and select the items.
2. Select how you want to add locations to the clearance reset inquiry.

= Zone Group: Enter the ID of the zone group that contains the locations to add to
the clearance reset inquiry, or click the LOV =l button and select a zone group.

=  Zone: Enter the ID of the zone to add to the clearance reset inquiry, or click the
LOV E* button and select a zone.

= Location: Enter the ID of the location that you want to add to the clearance reset
inquiry, or click the LOV & * button and select a location.

3. Click Retrieve Clearance Resets. Your results appear in the Clearance Resets Results
table.
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Promotions

A promotion is a temporary reduction in price. In addition, you can track sales at one or
more locations for a given time period as well as track the sales of merchandise with no
price reductions, at given locations for a set time period.

Updates can be made to the details of an existing promotion and promotion components
can be added to an existing promotion.

Promotion Components

= Simple Component - A simple promotion component consists of an item, item
group, or merchandise level that receives a discount at a specific location or group of
locations when the customer purchases an item.

= Threshold Component - A threshold promotion component consists of an item, item
group, or merchandise level that receives a discount at a location or group of
locations when the customer purchases a quantity or a amount of an item. You must
define the threshold levels before you can create the threshold component.

* Buy/Get Component - A buy/get promotion component consists of an item, item
group, or merchandise level allows you to define which items must purchased by the
customer in order to receive a discount for an additional item.

Changes can be made to the details of a promotion component, and new details can be
added to promotion components.

In the Promotion Component Detail Maintenance pane, records that contain
item/location exceptions or exclusions are indicated by a down arrow. Records that are
item/location exceptions or exclusions are indicated by an up arrow.

Existing promotion components can be copied into a new promotion.

Add Funding Information to a Promotion

Funding is added to a promotion at the component level so that you can indicate the
vendor that is contributing to the promotion. If you choose to create deals, based on the
funded component, you must indicate the billing information for the deal. If the
promotion is associated with an existing deal, the billing information defaults from the
existing deal.

Promotion Event

A promotion event is a method of grouping promotions that occur during a period of
time. Each event can be associated with many promotions, but a promotion can only be
associated with one event.

Updates can be made to the details of existing promotion events.

Threshold Definition

A threshold is a discount that a customer receives for purchasing a pre-determined
amount of an item. You must define the levels that exist in the threshold, then associate
the threshold definition to the threshold component.
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Vendor Funding Defaults

When an item is on promotion at a retailer, part of the discount a customer receives may
be contributed by the vendor. When you set up a promotion, you can define the vendor's
contribution.

You can create billing information defaults at the vendor level, which allows you to
apply the information to any deal that is created through the promotions dialog that is
associated with the vendor

Promotion Constraint

The Maintain Promotion Constraint workspace allows you to maintain promotion
constraints. You set up promotion constraints at the department, class, or subclass level
for a particular zone or location. A warning will appear if a price change or promotion is
created that would fall a certain number of days before or during another approved
promotion or price change. The number of days before the promotion is the promotion
constraint.

Create a Promotion

Navigate: From the Task Pad, select Promotion > Create Promotion. The Create
Promotion workspace opens.

OR

From the Maintain Promotion Events workspace, click New Promotion. The Create
Promotion workspace opens.

3 create Promotion

(@ Promotion Header

+: * Comnrment s @ * Start Dats

Desoiption o End Date l:l
I
* Currenc Y ey =]

* valid Departrents l:l B8+
Referenced Deals | Referenced Geals: Hone

(O |

Component1d () Component Name Type Status Secondary Application Conflicts

Add Gompanent | [ Greate from Existing

|

-]

[T p——— r—

In the field to the left of the Promotion field, enter the name of the promotion.
In the Description field, enter additional information as necessary.

In the Start Date field, enter the day the promotion begins.

Db

In the End Date field, enter the day the promotion stops.
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5. In the Event field, enter the ID of the event you want to associate with the promotion,
or click the LOV button and select an event.

6. Update the Currency field as necessary.

Select Secondary Application of Discounts as necessary.

8. In the Valid Department field, enter the departments for the promotion, or click the
LOV button and select the departments.

Associate a Deal to a Promotion
1. Click Referenced Deals. The Referenced Deals window opens

Referenced Deals

Available Deals

Deal ID Deal Type Yendor Name | Status Active Date Close Date Currency |

9802 Promational *Marmo Dry 5. Approved 08-31-2001 | 08-31-Z008 | euro . |

QE03 Prorotional WISE POTA,., | Approved 0%-21-2001 05-21-2008 | euro

Q204 Promotional LIGUORE MA,., | Approved 0%-21-2001 05-21-2008 | euro

203 Promotional LIGUOR MA.., | Approved 0%-21-2001 05-21-2008 | euro

Q207 Promotional *Marmo Cry 5. Approved 0g-29-2001 0g-23-2002 UKD

Q209 Prornotional *Mamo Cey S| Approved 0g-29-2001 0g-27-2002 EUFD

9811 Prornotional *Momo Dry 5. &pproved 08-29-2001 | 08-22-2008 | US Dollar

3515 Promational *Marmo Dry S..| &pproved 05-29-2001 | 08-31-2007 | US Dollar

Q216 Promational FAST FOOD .| Approved 0%-21-2001 08-21-2008 | auro

9517 Promatinnal LTS O B8 Snnrnusd Os-=1-20n01 Os-=1-200 LIS Dinllar vI
[=][a]

Linked Deals

Deal ID Deal Type Yendor Name | Status | Active Date Close Date Currency |

=]}

Cancel || Select |

Referenced Deals Window

Select the deals you want to add to the promotion.

Click Select. The window closes.

4. Click Done to save any changes and close the workspace.
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Add Components to a Promotion

1. In the Promotion Components pane, click Add Component. The Create Component
workspace opens.

%3 create Component

‘-‘(—“ Promotion Component

* Gompanert Tvpe[umpls[7]

Create Component Workspace

2. Add the appropriate type of component to the promotion to:
= Create a simple component
= Create a threshold component

= Create a buy/get component

Add a Component from an Existing Component
1. Click Create from Existing. The Copy Promotion Component window opens.

-,

~
E Copy Promotion Component 1)
Py P

* -

Start Date 0z/zefz001 |[E End Date  |pgzfzorzool |E

Copy Promotion Component

2. In the Promotion field, enter the ID the component is associated with, or click the
LOV E button and select the promotion.

3. In the Component field, enter the ID of the component you want to copy, or click the
LOV & button and select the promotion.

Update the Start and End Date fields as necessary.
5. Click Copy. The component is added to the Promotion Component table.
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Search for a

Promotion

Navigate: From the Task Pad, select Promotions > Maintain Promotion. The Promotions
Search workspace opens.

%5 Promotions Search

I@ Promotion Search Criteria

Prornotion |

Start Date: After l:l
End Date: After l:l
o | 8|

k Location

» Advanced Search

O E—
Status l:l 8+
Bafars |:|
Before |:|

|
I@ Promotion Search Results |

Promotions Search Workspace

1.

Expand the Promotion Search Criteria pane.
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(@ Promotion Search Criteria

Pramation l:l =
Start Date: After l:l
End Data: After l:l

Itemn | |E|

* Location

R E—

Division =]
N
Created By l:l %
vendor Funding [ gelect [7]

O —
e[ 18
e L 18
Regen L 18
pens [ 18
Therne |
it I
8
|
Create Date l:l

Deal ID

[ 18

[Refesh |[searen ]|

Promotion Search Criteria Pane

Enter or select the criteria to limit your search.

Click Search. Promotions that match these criteria appear in the Promotion Search

Results pane.
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Maintain a Promotion

Navigate: From the Task Pad, select Promotions > Maintain Promotion. The Promotions
Search workspace opens.

%5 Promotions Search

I@ Promotion Search Criteria

Prormotion | Evert l:l 8
Currency l:l S| Status l:l 8+
Start Date: After l:l Before l:l

End Date: After l:l Before l:l

Ttem | |8 |

k Location

» Advanced Search

|
I@ Promotion Search Results |

Promotions Search Workspace

1. Search for a promotion.

2. In the Promotion Search Results pane, select the promotion you want to edit.
3. Click Edit. The Maintain Promotion workspace opens.
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B3 Maintain Promotion

(@ Promotion Header

Fefarencad Deal: | Refersnced Deals: None
*
Valid Departments |1002)200;2456 1| B+ |Multiple values

* i *
Pramation |74z ¥ sumrner toys Comments £ Start Date 11/15/z001 || 1200 Am
Description P © End Date
Event = Status Approved *
* Currency Uso B [us pollar Total Markup 36 [jyia

Secondary Application of Discounts

@ Promotion Components

I &
Component Id (}) Component Name Type Status Secondary Application Conflicts
2043 ETS threshold copy Threshold WWarksheet O
541 buy getfunded Buy/Get Warksheet |
a1 buy getfunded Buy/Get Approved O
222 Apprud buy get Buy/Geat approved ]
conflict check | [_add component ] [ create from Existing | [ Delete component |[_Edit

Component Id

Component Name

Type

Status Action [~ gelect - |Z|

Secondary Application of Discounts

| canflicts || Manage gueraps [ _cancel |[_Done

Maintain Promotion Workspace

4. In the Promotion Header pane, edit the enabled fields as necessary.
5. Click Done to save any changes and close the workspace.
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Check for Conflicts

From the Promotion Components pane, select the promotion component you want to
check.

I@ Promotion Components |

I ]
Component ID m Component Name Type Status Secondary Application Conflicts
+ 941 simple

055 Crefect 941 buyfget BuyfGet Worksheet O
3087 Defect 941 threzhold Threzhold Worksheet O

Conflick Check || Add Component || Delete Component || Edit |
Campanent 1D 082
Component Mame Defect 941 zimple
Type Simple
Status SEHRE e action [ select -[7]

Secondary Application of Discounts

Update

Promotion Components Pane

Click Conflict Check. If the system option, background conflict check, is off and
conflicts exist, the Conflict Review List window is displayed.

conflict Review List " &;
I Promotion Componen| Ttem Location Change Type Change Amount Effective Date
Price Change Tyy ID Promotion Comp Date Unit Retail on E4 Selling UOM Multi Units Multi-Unit Retai| Mult-Unit Selli
Price Change 3221 12-04-2004 $26.84 EACH

Price Change 3242 12-01-2005 $35.22 EACH

Conflict Review List Window
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Note: See View conflict check results for more information
on background conflict checking. When background conflict
check is on, a binocular 88 icon appears in the conflict
column when conflict checking is complete. Click the icon to
open the Conflict Review List workspace.

= Jf no conflicts exist, click OK.

= If conflicts exist, you must adjust the details of your promotion before you can
move the promotion to the next status.

3. Click Done to save any changes and close the window.

Add a Component

1. Click Add Component. The Create Component workspace opens.

%9 create Component

‘-‘(—“ Promotion Component

*Compensnt Type  [simplz |7

Create Component Workspace

2. Add the appropriate type of component to the promotion to:
= Create a simple component
= Create a threshold component

= Create a buy/get component

Add a Component from an Existing Component
1. Click Create from Existing. The Copy Promotion Component window opens.

= =
=l Copy Promotion Component
=

Start Date nzfzefz001 |6 End Date  |pzfzofzool |[E

Copy Promotion Component

2. In the Promotion field, enter the ID the component is associated with, or click the
LOV E button and select the promotion.

3. In the Component field, enter the ID of the component you want to copy, or click the
LOV & button and select the promotion.

Update the Start and End Date fields as necessary.
5. Click Copy. The component is added to the Promotion Component table.
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Associate a Deal to a Promotion
In the Promotion Search Results pane, select the promotion you want to edit.

1.
2.

3.

Click Edit. The Maintain Promotion workspace opens.

%5 Maintain Promotion

I@ Promotion Header
* N *
Pramation ] pm————r— Comments () Start Date 1171572001 |B[12:00 Am
Description toy promo (= End Date 11f29fz001 |‘12:nn AM
Event B Status Approved *
* Currency usD B [us voller Total Markup % [l
Referenced Deals Referenced Deals: Mone seemmelr Appilieion 6l Eieeeumis
*
Valid Departments  |1002;200;3456;:) B+ |Multiple Values
= 5
(@ Promotion Components \
| &
Component Id (5 Component Name Type Status Secondary Application Conflicts
2043 ETS threshold copy Threzhald Worksheat J
541 buy getfunded Buy/Get Worksheet |
=21 buy getfundad Buy/Get Approved O
222 Appred buy get Buy/Get Approved |
conflict check || add compenant || creste from Existing || Delete component || Edic |
Gompenent I1d
Component Hams
Tepe
Status Action | gelact - =
Secondary Application of Discaunts
Updata
| cenflics || mansge cueraps [ cancel |[_Done

Maintain Promotion Workspace
Click Referenced Deals. The Referenced Deals window opens
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Referenced Deals

Awvailable Deals

Deal ID Deal Type ¥endor Name | Status Active Date Close Date Currency |
9802 Promational FMomo Dry S..| Approved 08-31-2001 |02-31-2008 | euro b |
Q803 Promatianal WISE POTA.., | Approved 0f-231-z2001 0&-31-Z00%8 | euro
2804 Promational LIGUCRE MA... | Approved 0g-z1-2001 0g8-31-200%8 BUFD
Q803 Promatianal LIGUOR MA... | Approved 0&-31-z001 0&-31-Z00%8 | euro
2807 Promational *FMormo Dry S..| Approved 0g-29-2001 0g-28-200%8 BUFD
Q9809 Promatianal *Momo Dy S, Approved 0&-29-2001 0f-27-Z00%8 | euro
9811 Promational *FMomo Dry S..| Approved 0g8-29-2001 | 08-28-2008 | US Caollar
9815 Promatianal *Moma Dy S, Approved 08-29-2001 | 0%-31-2007 | US Dallar
Q816 Promational FAST FOOD .| Approved 0g-z1-2001 0s8-31-200%8 BUFD
== | Erormotinnal [ C N D] = - Annrnued O5-31-2001 O5-31-200 115 Cinllar vI
=l [a]
Linked Deals
Deal ID Deal Type ¥endor Name | Status | Active Date Close Date Currency
|l
=]
Cancel || Select |

Referenced Deals Window
4. Select the deals you want to add to the promotion.
5. Click Select. The window closes.

6. Click Done to save any changes and close the workspace.
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Add a department to a promotion

Use this procedure to add departments to a promotion after the promotion has been
created.

Navigate: From the Task Pad, select Promotions > Add Department to a Promotion. The
Add Department to Promotion workspace opens.

%5 Add Department to Promotion

I'/C; Promotion Search Criteria

¥ Start Date: After l:l ¥ pefore l:l

Itern

End Date: After l:l Befare l:l

b Location

b Advanced Search

__Clear __Search |
I-/(_ﬂ Promotion Search Results |
Ih_n Add Department |

Add Department to Promotion Workspace
1. Enter or select the criteria to limit your search.

Note: You must enter a Start Date range.

2. Click Search. Promotions that match these criteria appear in the Promotion Search
Results pane. The Add Department pane opens.

I'/C._-j Add Department

8

Add Department Pane
3. Select the promotion to add departments to.

4. In the Department field, enter the Department number or click &+ (LOV) and select
from the list of values.

5. Click Add.

Click Done. The workspace closes, and the departments are added to the promotion.
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Promotion Components

Create a Simple Component

Navigate: From the Task Pad, select Promotions > Create Component. The Create
Component workspace opens.

OR

From the Create Promotion workspace, click Add Component in the Promotion
Components pane. The Create Component workspace opens.

%3 create Component

‘-"(2 Promotion Component

* Desari ption
* Component Type  [Gimple 7]

cancel |[ save |[ save +Repest |[ Dene

Create Component Workspace

1. In the Promotion field, enter the ID the promotion is associated with, or click the
LOV & button and select the promotion.

In the Description field, enter a description of the component.
In the Component Type field, select Simple.
Click Next. The Promotion Component - Simple pane opens.
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I(: Promotion Component - Simple |
=
=
=
=
¥ Item Selection
Item Selection " y;
Level 1] Diff ID | Description |
» Location Selection
Location Selection " y;
Level 1 Description | Location Type |
* change Trpe Ceeier - o
=
=
¥ Start Date & Time |01.-'01.-'2006 |E||12:00 A0 |
End Date & Time |12.-‘31.-‘2006 |E||11:59 P |
* Apply To Caen [
Price Guide | | H
| | Apply & Repeat || Apply || Clear ||

Promotion Component - Simple Pane

Add Items and Locations to a Promotion Component

1.

In the Item Selection area, enter the criteria you want to use to select the items on
promotion, or click the LOV & button and select the criteria.

Click Select. The items are added to the Item Selection table.

In the Location Selection area, select how you want to add locations to the
promotion, or click the LOV E button and select the criteria.

Click Select. The locations are added to the Location Selection table.

In the Change Type field, select the price change that occurs during the promotion:

* Change By Percent: A price for an item is changed by a percentage removed
from the original price. The percent of change is determined by the percent
entered in the Change Amount field.

= Change By Amount: A price for an item is changed by an amount removed from
the original price. The amount of change is determined by the amount entered in
the Change Amount field.

=  Fixed Price: The price for the item will be at a specified retail that will be defined
in the change amount field.
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= No Change: The price of the item is not changed. For reporting purposes, the
item is recognized as being on promotion.

* Exclude: The item will not be affected by price changes that occur as a result of
the promotion.

6. In the Change Amount field, enter the amount, percent, or fixed amount the price
changes.

Note: There is no need to enter a negative sign before the
number entered in the Change Amount field. A promotion
can only exist as a decrease in price.

7. In the Selling UOM field, enter the unit of measure for the items, or click the LOV
button and select the selling UOM.

8. Update the Start and End Date & Time fields as necessary.

9. In the Apply To fields, select the types of item pricing that you want to apply the
promotion.

10. Click Apply. The promotion opens in the Promotion Component Detail Maintenance
pane.

11. Click Done to save any changes and close the workspace.

Add Funding to a Simple Component
1. Create a simple component
2. Expand the Funding pane.

‘(-‘ Funding

Corporste Funding Percent

Create Deals
Vendor Type [supplier =
Contribution % |w

I

¥endor Type | ¥endor ID Contribution % Deal ID Deal Comp ID Use Deal Locations ‘ Use Deal Ttems

Funding Pane for Simple Components

3. In the Corporate Funding Percent field, enter the percent that the retailer contributes
to the promotion.

4. Select the Create Deals check box to create a deal based on this promotion
component and funding.

5. In the Vendor Type field, select the type of vendor that is funding the component.

In the Vendor field, enter the ID of the vendor, or click the LOV & button and select a
vendor.

7. In the Deal ID field, enter the deal the promotion is associated with, or click the LOV
button and select a deal.
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8. In the Deal Comp ID, enter the ID of the deal component field, or click the LOV
button and select a deal component.

Note: The Deal and Deal ID field are disabled if you selected
the Create Deals check box.

9. In the Contribution % field, enter the percentage that this vendor contributes to the
promotion component.

10. Select the Use Deal Locations check box to indicate that the locations on the deal
should be used for the promotion.

11. Select the Use Deal Items check box to indicate that the items on the deal should be
used for the promotion.

Note: The Use Deal Locations and Use Deal Items check
boxes are disabled if the promotion component already has
items or locations.

12. If you selected the Create Deals check box, add billing information for a deal to a
funded component.

13. Click Apply to add your changes to the table.
14. Click Done to save any changes and close the workspace.

Create a Threshold Component

Navigate: From the Task Pad, select Promotions > Create Component. The Create
Component workspace opens.

OR

From the Create Promotion workspace, click Add Component in the Promotion
Components pane. The Create Component workspace opens.

%3 create Component

f = Promotion Component

* Desai ption
* component Type  Eimplz 7]

cancel || save |[ save + Repeat |[ pane

Create Component Workspace

1. In the Promotion field, enter the ID the promotion is associated with, or click the
LOV & button and select the promotion.

In the Description field, enter a description of the component.
In the Component Type field, select Threshold.
Click Next. The Promotion Component - Threshold pane opens.
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I(:' Promotion Component - Threshold

¥ Item Selection

Clear Select

Item Selection |

Level I Diff ID | Description |

¥ Location Selection

Clear Select

Location Selection " &
Level I Description | Location Type |
* Start Date & Time |01.|'01.|‘2006 |E| |12:00 A |
End Date & Time |12.-‘31.-‘2006 |E||11:59 PM |
*pely To [eeea- o]
| Apply 8 Repeat || Apply [ Clear ||

Promotion Component - Threshold Pane

Add Items and Locations to a Promotion Component

1. In the Item Selection area, enter the criteria you want to use to select the items on
promotion, or click the LOV & button and select the criteria.

Click Select. The items are added to the Item Selection table.

In the Location Selection area, select how you want to add locations to the
promotion, or click the LOV & button and select the criteria.

Click Select. The locations are added to the Location Selection table.

In the Threshold field, select the threshold you want to associate with the promotion,
or click New Threshold to create a threshold definition.

Update the Start and End Date & Time fields as necessary.

7. In the Apply To fields, select the types of item pricing that you want to apply the
promotion.

8. Click Apply. The promotion opens in the Promotion Component Detail Maintenance
pane.

9. Click Done to save any changes and close the window.
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Add Funding to a Threshold Component

1.
2.

10.

11.

12,

Create a threshold component.
Expand the Funding pane.

I"(ﬂ Funding

Corporate Funding Percent 10, nanc)

~ Threshold Uptake %

1 |

‘ Selling UDM | Uptake %

109 )

Uptake %

Creste Desls

Vendor Type [Manufscturer =l
L]
Contribution % |w

| 12

Yendor Type

Suppliar

Edit Dalets

Funding Pane for a Threshold Component

In the Corporate Funding Percent field, enter the percent that the retailer contributes
to the promotion.

Select a threshold.

In the Uptake % field, enter the percentage of customers that you expect to take
advantage of the promotion at this threshold.

Click Apply to add your changes to the table.

Select the Create Deals check box to create a deal based on this promotion
component and funding.

In the Vendor Type field, select the type of vendor that is funding the component.

In the Vendor field, enter the ID of the vendor, or click the LOV & button and select a
vendor.

In the Deal ID field, enter the deal the promotion is associated with, or click the LOV
button and select a deal.

In the Deal Comp ID, enter the ID of the deal component field, or click the LOV
button and select a deal component.

Note: The Deal and Deal ID field are disabled if you selected
the Create Deals check box.

In the Contribution % field, enter the percentage that this vendor contributes to the
promotion component.
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13. Select the Use Deal Locations check box to indicate that the locations on the deal
should be used for the promotion.

14. Select the Use Deal Items check box to indicate that the items on the deal should be
used for the promotion.

Note: The Use Deal Locations and Use Deal Items check
boxes are disabled if the promotion component already has
items or locations.

15. If you selected the Create Deals check box, add billing information for a deal to a
funded component.

16. Click Apply to add your changes to the table.
17. Click Done to save any changes and close the workspace.

Create a Buy/Get Component

Navigate: From the Task Pad, select Promotions > Create Component. The Create
Component workspace opens.

OR

From the Create Promotion workspace, click Add Component in the Promotion
Components pane. The Create Component workspace opens.

%9 create Component

“(—“ Promotion Component

* Descr ptian
* Component Type  [Gimpl= 7]

Cancel || save |[ Save + Repeat |[ Dane

Create Component Workspace

1. In the Promotion field, enter the ID the promotion is associated with, or click the
LOV & button and select the promotion.

In the Description field, enter a description of the component.
In the Component Type field, select Buy/Get.
Click Next. The Promotion Component - Buy Get pane opens.
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I(: Promotion Component - Buy Get

Buy Item Get Item
Type oAl * Change Type =
'Q'Any
=
*startDate & Time  [oy/01/2006 |@[12:00 am |
End Date & Time |12.-'31.-'2006 |E||11:59 PM |
* Item Selection
=
=
=
=
Itermn Type [reerm [~
Itern Level 'Transaction Level Ttern lzl
=
Buy Items & ||cet tems (14
Ttem | Description | Them Description |

¥ Location Selection

Promotion Component - Buy Get Pane

Define the Buy/Get Terms
1. In the Buy Item area, select how the items on the list of buy items must be purchased.
= All: All the items on the Buy Items list must be purchased in order to receive the

discount

= Any: Any of the items on the Buy Items list must be purchase in order to receive
the discount.
2. In the Quantity field, enter the number of items that need to be purchased in order to
receive the discount.
3. In the Get Item area, select the type of discount received when the qualifying items
and quantity is purchased.
= Percent Off: A price for an item is changed by a percentage removed from the
original price. The percent of change is determined by the percent entered in the
Change Amount field.
= Amount Off: A price for an item is changed by an amount removed from the
original price. The amount of change is determined by the amount entered in the
Change Amount field.
*  Fixed Price: The price for the item will be at a specified retail that will be defined
in the change amount field.
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6.

In the Selling UOM field, enter the unit of measure for the items, or click the LOV
button and select the selling UOM.

In the Change Amount field, enter the amount, percent, or fixed amount the price
changes.

Note: There is no need to enter a negative sign before the
number entered in the Change Amount field. A promotion
can only exist as a decrease in price.

Update the Start and End Date & Time fields as necessary.

Add Items and Locations to a Promotion Component

Note: You may have to expand the Item Selection and
Location Selection area to view the criteria

In the Item Selection area, enter the criteria you want to use to select the items on
promotion, or click the LOV & button and select the criteria.

Add the items to the Buy Items or Get Items table.

* C(lick Add to Buy Items to add items to the list of items that qualify the
purchaser for the discount.

= (Click Add to Get Items to add items to the list of items that receive the discount.

Note: Depending on the system setting for Allow Buy/Get
Cycles you may be prohibited from entering the same item
in the buy and get lists. If cycles are permitted, then multiple
identical items may be added to both the buy and get lists.

In the Location Selection area, select how you want to add locations to the
promotion, or click the LOV E button and select the criteria.

Click Select. The locations are added to the Location Selection table.

In the Apply To field, select the types of item pricing that you want to apply the
promotion.

Click Apply. The promotion opens in the Promotion Component Detail Maintenance
pane.

Click Done to save any changes and close the window.
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Add Funding to a Buy/Get Component

1.
2.

10.

11.

12.

13.
14.

Create a buy/get component.

Expand the Funding pane.
(@ Funding
Corporate Funding Percent
Uptake %
Creste Deals
Vendor Type [Manafactarer =l
| |
=
Contribution % ‘10
e

[E4

¥endor Type ¥endor ID Contribution %o Deal ID Deal Comp 1D ‘ Use Deal Locations

Funding Pane - Buy/Get Component

In the Corporate Funding Percent field, enter the percent that the retailer contributes
to the promotion.

In the Uptake % field, enter the percentage of customers that you expect to take
advantage of the promotion at this threshold.

Select the Create Deals check box to create a deal based on this promotion
component and funding.

In the Vendor Type field, select the type of vendor that is funding the component.

In the Vendor field, enter the ID of the vendor, or click the LOV E button and select a
vendor.

In the Deal ID field, enter the deal the promotion is associated with, or click the LOV
button and select a deal.

In the Deal Comp ID, enter the ID of the deal component field, or click the LOV
button and select a deal component.

Note: The Deal and Deal ID field are disabled if you selected
the Create Deals check box.

In the Contribution % field, enter the percentage that this vendor contributes to the
promotion component.

Select the Use Deal Locations check box to indicate that the locations on the deal
should be used for the promotion.

Note: The Use Deal Locations check boxes are disabled if the
promotion component already has locations.

If you selected the Create Deals check box, add billing information for a deal to a
funded component.

Click Apply to add your changes to the table.
Click Done to save any changes and close the workspace.
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Add Billing Information for a Deal to a Funded Component
1. Click Deal Billing. The Deal Billing window opens.
2. Select the information about the deal that you require:
= Deal Reporting Level: The frequency that the deal is reported.
= Bill Back Method: The type of invoice that is created for the supplier. Select the
appropriate option.
= Bill Back Period:The frequency that the vendor is charged for the bill back.
Select when to charge the vendor.

= Invoice Processing Logic:The method used to create invoices. Invoices are
created automatically, manually, or not at all depending on the option selected.

* Include VAT in Deal Billing: Select the check box to indicate that VAT should
be included in the invoice information.

= Include Deal Income in Stock Ledger: Select the check box to indicate that deal
income accrual should be written to the stock ledger.

3. Click Done to save any changes and close the window.

Maintain a Promotion Component

Navigate: From the Task Pad, select Promotion > Maintain Component. The Maintain
Component workspace opens.

3 Maintain Component

W T TG .

L
i Prametien l:l =
=]

S

Cancel || Save || Done

Maintain Promotion Component Workspace

1. In the Promotion field, enter the ID of the promotion that the component is
associated with, or click the LOV E button and select a promotion.

2. In the Component field, enter the ID of the component you want to maintain, or click
the LOV & button and select a component.

3. Click Next. Additional component maintenance panes are displayed.

Note: Collapse and expand areas and panes to view the
information needed to complete the task.

Maintain Component Details

1. In the Promotion Component Detail Maintenance pane, edit the name of the
component as necessary.

2. Enter the consignment rate used for the item while it is on promotion, if necessary.
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N o a &

To edit a specific record, select a record, or click Select All to make changes to all
records on the table.

Click Edit.
Edit the enabled fields as necessary.
Click Apply.

Click Done to save any changes and close the workspace.

Delete Component Details

1.

o kN

In the Promotion Component Detail Maintenance pane, select the record you want to
delete:

= To edit a specific record, select a record

=  Click Select All to make changes to all records on the table.
Click Delete.

You are prompted to confirm your decision.

Click Yes. The item location is removed from the table.

Click Done to save any changes and close the workspace.

Define Item Exceptions and Exclusions

1.

5.

In the Promotion Component Detail Maintenance pane, select the record for which
you want to create an item exception or exclusion. The Item Exceptions and
Exclusion pane opens.

In the Location field, enter a location ID, or click the LOV & button and select a
location.

Note: You can only create item exceptions or exclusions for
items above the transaction level.

Create the exception or exclusion:
= C(Click Create Exceptions to create an exception to the selected record.
*  Click Create Exclusion to create an exclusion.

The pane closes. In the Promotion Component Detail Maintenance pane exceptions
and exclusions are indicated in the Exclusion/Exception Indicator column:

* A down arrow indicates that the item/location records contains an exception or
exclusion.

* Anup arrow indicates that the item/location records is an exception or
exclusion.

Click Done to save any changes and close the pane.

Define Location Exceptions and Exclusions

1.

In the Promotion Component Detail Maintenance pane, select the record for which
you want to create a location exception or exclusion. The Location Exceptions and
Exclusion pane opens.

In the Location field, enter a location ID, or click the LOV & button and select a
location.

Note: You can only create location exceptions or exclusions
for locations at the zone level.
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3. Create the exception or exclusion:
= Click Create Exceptions to create an exception to the selected record.
= C(Click Create Exclusions to create an exclusion.

4. The pane closes. In the Promotion Component Detail Maintenance pane exceptions
and exclusions are indicated in the Exclusion/Exception Indicator column:

* A down arrow indicates that the item/location records that contain an exception
or exclusion.

*  Anup arrow indicates that the item/location records that is an exception or
exclusion.

5. Click Done to save any changes and close the pane.
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Promotion Events

Create a Promotion Event

Navigate: From the Task Pad, select Promotion Events > Create/Maintain Events. The
Maintain Promotion Events workspace is displayed.

%3 Maintain Promotion Events

((—1 Maintain Promotion Events

l Events
Event 1d Event Description Theme Start Date & Time End Date & Time
Fall Event | ‘App\e ‘ ‘10]14/2004 “12:00 A1 ‘ ‘10]15/2004 “11:59 Pr ‘

Event1d Event Description Theme Start Date End Date

&7 The Mever Ending Event 10-31-2004 10-31-2005
73 RF 21 testing I Don't Know 10-19-2004 10-31-2004
74 alli Event 11-01-2004 12-01-2005
6% smm pramo event event 08-02-2005 08-31-2005
66 Starts taday Fun 10-01-2004 10-23-2004

[ Delete |[_new promation |

cancel || save + Repest [[ pons |

Maintain Promotion Events Workspace

1. In the Promotion Events section, click New.

2. In the Event Description field, enter a name for the event you are creating.

3. In the Theme field, enter any additional informative information about the event.
4. In the Start Date and Time fields:

a. In the first field, enter the date the event starts, or click the LOV B button and
select a date.

b. In the second field, enter the time the event starts.
5. In the End Date and Time fields:

a. In the first field, enter the date the event ends, or click the LOV B button and
select a date.

b. In the second field, enter the time the event ends.
6. Click Apply. The promotion event is added to the table.
7. Click Done to save any changes and close the window.
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Add a Promotion to an Event

1. In the Maintain Promotion Events pane, click Add Promotion. The Create Promotion
workspace is displayed.

E Create Promotion
Al
(@ Promation Header =
¥prarmotion’ [13947 *D Commentz () ¥ tart Date l:l
Event l:l Status o ant
* Valid Departments I:l + sacondary Application of Discounts
Referenced Deals | Referenced Deals: Hone
((—W Promation Components |
14
Component 4 Component Name Type Status Secondary Application Confiicts
.| [ Add companent | [ creste from xisting. || Delete Camponent || et |
[+
b

Create Promotion Workspace
2. Add the appropriate details to create a promotion.
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Maintain a Promotion Event

Navigate: From the Task Pad, select Promotion Events > Create/Maintain Events. The
Maintain Promotion Events workspace opens.

%5 Maintain Promotion Events

((—‘ Maintain Promotion Events

Event 1d Event Description Theme Start Date & Time End Date & Time
Fall Event | ‘App\e ‘ ‘10!14/2004 “12:00 A ‘ ‘10!15/2004 “11:59 [ ‘

Event Id Event Description Theme Start Date End Date

&7 The Mever Ending Event 10-21-2004 10-21-2005
73 RF 21 testing I Don't Know 10-13-2004 10-31-2004
74 alli Event 11-01-2004 12-01-2005
68 smm prome svent uent 08-02-2005 08-31-2005
&6 Starts today Fun 10-01-2004 10-23-2004

Delete |[_new Promation |

cancel |[_save +Repeat |[_Done |

Maintain Promotion Events Workspace

1. Select the event you want to maintain from the table.

2. In the Promotion Events area, edit the enabled fields as necessary.

3. Click Apply. Your changes are added to the promotion event and appear on the table
4. Click Done to save any changes and close the window.

Delete a Promotion Event

1. Select the event you want to delete from the table.

2. Click Delete. You are prompted to confirm your decision.
3. Click Yes. The record is removed from the table.

4. Click Done to close the window.

User Guide 213



Threshold Definition

Threshold Definition

Create a Threshold Definition

Navigate: From the Task Pad, select Promotion Threshold > Create Threshold. The
Create Threshold workspace opens.

%3 create Threshold

(@ Threshold treate

Threshold Type Diseoun t Type

selling Uom

* Narme

*

* Qualification Type |- selact -

L] L1

*Thrashold Type [ salect -

ET|ET|ET

* Discound t Type [ setact -

cancel |[_save + Repeat [[_Done

Create Threshold Workspace

1.
2

8.
9.

In the Name field, enter a description of the threshold you are creating.

In the Currency field, enter the ID of the appropriate currency, or click the LOV
button and select a currency.

In the Qualification Type field, select how the threshold is met:

= Threshold Level: All items on the promotion can be counted together to meet the
terms of the threshold and have the promotion applied.

* Item Level: Each item on the promotion must meet the threshold to have the
discount applied.

In the Threshold Type field, select the measure that indicates how the threshold is

met:

* Quantity: A number of units of an item must be purchased by the customer from
the retailer.

* Amount: A value of the item must by purchased by the customer from the
retailer.

In the Discount Type field, select the method used to determine the new price of the

item.

= Percent Off: A price for an item is changed by a percentage removed from the
original price. The percent of change is determined by the percent entered in the
Change Amount field.

= Amount Off: A price for an item is changed by an amount removed from the
original price. The amount of change is determined by the amount entered in the
Change Amount field.

=  Fixed Price: The price for the item will be at a specified retail that will be defined
in the change amount field.

If you choose Fixed Price in the Discount type field, you must enter the Selling UOM

for the item.

In the threshold area on the right, enter the amount or quantity that needs to be

purchased in the Threshold Type field.

In the Discount Type field, enter the percent off, amount off, or fixed price received.
Press Tab to add additional threshold levels.

10. Click Done to save any changes and close the window.
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Vendor Funding Defaults

Create Vendor Funding Defaults

Navigate: From the Task Pad, select Vendor Funding Defaults > Create Defaults. The
Create Defaults workspace opens.

%3 create Defaults

I(:' Yendor Funding Defaults Creation

¥ vendar Type - Seledt - lEI

| Cancel || Save + Repeat || Lone

Create Defaults Workspace

1.

In the Vendor Type field, select the type of vendor that is contributing to the
promotion.

In the Vendor field, enter the ID of the vendor, or click the LOV E button and select a
vendor.

In the Deal Reporting Level field, select the frequency of deal reporting.
In the Bill Back Method field, select the type of invoice that is created for the supplier.

In the Bill Back Period field, select the frequency that the vendor is charged for the
bill back.

In the Invoice Processing Logic field, select the method used to create invoices.
Invoices are created automatically, manually, or not at all depending on the option
selected.

Select the Include VAT in Deal Billing check box to indicate that VAT should be
included in the invoice information.

Select the Include Deal Income in Stock Ledger check box to indicate that deal
income accrual should be written to the stock ledger.

Click Done to save any changes and close the window.
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Its

Edit Vendor Fu

nding Defaults

Navigate: From the Task Pad, select Vendor Funding Defaults > Maintain Defaults. The
Maintain Defaults workspace opens.

I@ Maintain ¥endor Funding Defaults

Supplier GE Capital Manth Debit Mote Week Autamatic &l
Supplier ESS Supplier ... [Manth Cradit Mote Manth Automatic All..
Supplier prada fazhion [Manth Credit Mote Annual Automatic All..
Supplier Glazzware Pr., [Month Cradit Mote Annual Auternatic All.., O |
Supplier James Hardie ...|Manth Credit Mote Annual Autarmatic All., I:‘ D
Supplier Super Sonic Manth Credit Mote Manth Ma Inwaice Pr. I:l :
|

* Deal Reparting Level lzl

* Tnvaice Processing Logic |Aut0|'natic Al walues lzl

* Bill Back Method |Credit Mote lzl

* pill Back Period |Annua| IEI

Include WAT in Deal Billing D

Include Deal Income in Stock Ledger D

Maintain Vendor Funding Defaults Workspace

1. On the table, select a vendor. The details area is enabled.
2. Update the enabled fields as necessary.

3. Click Apply to add your changes to the table.

4. Click Done to save any change and close the window.

Delete a Vendor Funded Default

1.  On the table, select a vendor.

2. Click Delete. You are prompted to confirm your decision.
3. Click Yes.

4. Click Done to save any change and close the window.
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Promotion Constraints

Maintain a Promotion Constraint

Search for a Promotion Constraint

Navigate: From the Task Pad, select Promotion Constraints > Maintain Promotion
Constraints. The Promotion Constraints workspace opens.

%5 Maintain Promotion Constraints

I@ Promotion Constraint Search

Clazs

Subclass

a8+
8+

B+

Zone

Location

[ &

o] [

Cancel

Maintain Promotion Constraints Workspace

1. Enter or select the criteria to limit your search.

2. Click Search. Your results appear in the Promotion Constraints List.

I@ Promotion Constraints

| B
8+

Clazs

Subclass

Zone

B+

* Constraint

Promotion Contraint List | &

Department Id Department Class Id Class Subclass Id Subclass Location Id Location Constraint

Fiteer bp: | ¥ |[Fiteer bp: [w||[Fnerop: [¥|[Amer s ¥ v [w)[rner s [F)|[Fwerop: [¥][Aner sy [ [Fer b [+]
1005 RPM QA Test D..[1015 RPM QA **Ple.., (1025 REM G4 **Ple.. (1000000007  |Fresno e
1005 RPM QA Test D..[1015 RPM QA **Ple.., (1025 REM QA **Ple.,. (1000000005  |Cakland EN
1005 RPM QA TestD...[1015 RPM QA **Ple., (1025 RPM Q& **Ple,. (1000000002 Madizon - Inclu.. 5
1005 RPM QA Test D..[1015 RPM QA **Ple.., (1025 REM QA **Ple.. (1000000021 |Duluth 5
1005 RPM QA Test D..[1015 RPM QA **Ple.., (1025 REM G4 **Ple.. (1000000020  |Grlando 5
1005 RPM QA TestD...|1015 RPM QA **Ple., (1025 RPM Q& **Ple,. (1000000013 Buffalo - Includi. 5
1005 RPM QA Test D..[1015 RPM QA **Ple.., (1025 REM QA **Ple.. (1000000001  |Minnespolis 5
1005 RPM QA Test D..[1015 RPM QA **Ple.., (1025 REM G4 **Ple.. (1000000022  [Omsha 5
1005 RPM G Test D 1015 RPM QA **Ple., 1025 RPM @A **Ple., 1000000008 [Boston - largere.., 5
1005 RPM G Test D[ 1015 RPM QA **Ple., 1025 RPM QA **Ple., 1000000013 [Jacksonville 5
1005 RPM G Test D 1015 RPM QA **Ple., 1025 RPM QA **Ple., 1000000018 [Gharleston 5
1005 RPM G Test D[ 1015 RPM QA **Ple., 1025 RPM @A **Ple. 1000000017 [charlotte 5
1005 RPM G Test D 1015 RPM QA **Ple., 1025 RPM @A **Ple., 1000000000 |Fargo 5
1005 RPM G Test D 1015 RPM QA **Ple., 1025 RPM QA **Ple,. 1000000004  [Sious Falls E
1005 RPM G Test D 1015 RPM QA **Ple., 1025 RPM @A **Ple., 1000000003 |Pearis 5
1234 Glassware 1001 Decoration 1005 sifts 1111111113 [Cent. Web YWH 8 3
1234 Glassware 1001 Decoration 1005 sifts s Gent, Catalag Yo 3
1234 Glassware 1001 Decoration 1005 sifts 2222222224 |W. Web VWH 12 3
1234 Glassware 1001 Decoration 1005 sifts i W, ValuzMart Yo, 3 +]
1 »

Promotion Constraints List
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Maintain a Promotion Constraint
1. Search for a Promotion Constraint.

2. Enter the ID of the merchandise level the promotion constraint should apply to, or
click the LOV B+ button and select the appropriate merchandise level

3. In the Location Selection area, select the locations the promotion constraint should

apply to.

=  Zone Group: Enter the ID of the zone group the constraint should apply to, or
click the LOV B button and select a zone group.

= Zone: Enter the ID of the zone the constraint should apply to, or click the LOV
B+ button and select a zone.

= Location: Enter the ID of the location the constraint should apply to, or click the
LOV B+ button and select a location.

In the Constraint field, enter the number of days for the promotion constraint.
Click Apply. A row is added to the table.

Delete a Promotion Constraint
1. In the Promotion Constraints table, select the row you want to delete by clicking the

box j to the left of the row. Press and hold the Ctrl key while selecting to select
multiple rows. Click Select All to select all the rows.

I
Department ID | Department Class Id Class Subclass ID Subclass Location ID Location Constraint
Fiftar by | Fitker by lzl |F.l'!ter by lzl | Fitkar by lzl | Fifkar by lz‘ |Fﬂ'!te.v by lzl |F.l'!ter by lzl | Filker by | Fitker by lz‘
22 Lol warking de.| 1 Dl Test Clas., |1 test subclass 1 | 1000001002 Mall of America ZZ
1414 Activewear 1000 Sports Clothes | 1000 Mens Sports ... | 1000000000 Fargo 2
1414 Activewaar 1000 Sports Clothes | 1000 Mens Sports .. (1000000001 Minneapolis 2
1414 Activewear 1000 Sports Clothes | 1000 Mens Sports o, | 1000000002 | Madison z
1000 1000 2
1414 Activewear 1000 Sports Clothes | 1000 Mens Sports .. [ 1000000007 Fresno 2z
1414 Activewear 1000 Sports Clothes | 1000 Mens Sports .. | 1000000014 | Baltirmore 2
1414 Activewear 1000 Sports Clothes | 1000 Mens Sports o, (1000001000 Edina 2
20 Merch Extract.,, [ 201 Merch Ext 1 2001 Merch Ext Sub,.[ 1000000000 Farga 10
20 Merch Extract., | 201 Merch Ext 1 2001 Merch Ext Sub..,| 1000000001 Minneapolis 10
20 Merch Extract., | 201 Merch Ext 1 2001 Merch Ext Sub..| 1000000002 [ Madizon 1o
20 Merch Extract.. | 201 Merch Ext 1 2001 Merch Ext Sub...| 1000000007 Fresno 10
20 Merch Extract., | 201 Merch Ext 1 z001 Merch Ext Sub..| 1000000014 | Baltimore 1o
20 Merch Extract.. | 201 Merch Ext 1 200z Merch Ext Sub...| 1000000000 Farga 10
zo Merch Extract., | 201 Merch Ext 1 zooz Merch Ext Sub..,| 1000000001 Minneapolis 10
20 Merch Extract... | 201 Merch Ext 1 200z Merch Ext Sub...| 1000000002 Madizan 10
20 Merch Extract., | 201 Merch Ext 1 zooz Merch Ext Sub,..| 1000000007 Fresno 10
20 Merch Extract.., | 201 Merch Ext 1 2002 Merch Ext Sub..| 1000000014 | Baltimore 10
20 Merch Extract,., | 202 Merch Ext 2 priufuic) Merch Ext Sub,.| 1000000000 Farga 10|
[4] 3

Promotion Constraints Table

2. Click Delete. You are prompted to confirm your decision.

3. Click Yes.
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#

# Days Rejects Held: The number of days, set in system options, after the effective date
of a rejected price change or clearance that it is purged from the system.

A

Allow Complex Promotions: When selected in system options, indicates all promotion
types are available. When cleared, the RPM user will only be allowed to create/maintain
simple promotions.

Apply Promo Change Type First: Allows you to indicate which type of promotion
should be applied first.

Area Differential: Area differential pricing allows you to set prices for items at a
particular zone or zone group differently than another zone or zone group.

Auto Approve: When selected on a pricing strategy, indicates price changes created
should be created in approved status.

B

Background Conflict Check: When selected in system options, indicates conflict
checking for worksheets, price changes, promotions, and clearances will be performed in
the background, or when the system is idle. When cleared, conflict checking will occur
real-time.

Buy/Get Component: A component for which the items at specific locations are
promoted at a percent off, amount off, or fixed price, based on the purchase of other
items.

C

Candidate Rule: A set of criteria that is compared to each item/location processed by the
merchandise extract program to determine if the item/location meets one or more
conditions. RPM uses two types of candidate rules, inclusion or exclusion

Class: The fifth level in the merchandise hierarchy. The class breaks down the
merchandise hierarchy. A class can belong to one department.

Clearance: A clearance is designed to move out of date and slow selling merchandise out
of a store. A clearance is considered a permanent price change, and inventory is
consequently revalued. Once the reset date for a clearance has passed, the items price
and inventory value is returned to the regular price.

Clearance/Promotions Overlap: When selected in system options, indicates an
item/location can be on clearance and promotion at the same time.
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Component: The details of a promotion. A component can be simple, threshold, or
buy/get.

Cost Calculation Method: The way cost is determined for the zone. Choose Highest
Location Cost or Average Location Cost.

Cost Change Forward Days: The number of days into the next review period that a
maintain margin pricing strategy will consider cost changes when proposing price
changes. Cost change forward days should not exceed the length of a review period.

Currency: On System Defaults, the primary currency used in RPM. In other areas of
RPM, the currency for a particular task

D

Deal: The agreement between a retailer an a vendor for rebates or discounts applied to
an item when ordered from the supplier or sold to the customer in certain quantities.

Default Out of Stock Days: The number of days, set in system options, that should be
added to a the effective date of a clearance in order to calculate the Out of Stock date. The
default is applied to generate the out of stock date when the clearance is first created.

Default Reset Date: When selected in system options, indicates that a reset date should
be defaulted when a clearance is created. The reset date is defaulted to one day greater
than the out of stock date.

Department: Belongs to a group in the merchandise hierarchy and provides a way to
define the areas of a group. A department is the fourth division in the merchandise
hierarchy.

Diff: A characteristic of an item that distinguishes it from another item. An item may
have up to four diffs.

Diff Type: The category to which a diff belongs.

Dynamic Area Differentials: When selected in system options, allows the worksheet to
dynamically update secondary locations based on changes to the primary location.

E

Effective Date: The date on which a event becomes available or active in the system.
End Date: The last day an element is effective in the system.

Ends In Digits for Zero Decimal Currencies: The number of digit fields, set in system
options, that are available in the Ends In definition area. This field is used for currencies
that do not contain a place after the decimal point. For currencies that contain places after
the decimal point, the digit fields that are available.

Event: The top level of a promotion, used to group several promotions together.

Event ID Required: When selected in system options, a promotion event must be
assigned to the promotion.

Exact Deal / Funded Promotion Dates: When selected in system options, indicates that
the dates of a deal associated with a vendor funded promotion must match exactly.
When selected, only deals with the same begin and end dates as the promotion
component being created will appear in the deal
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Exclusion Candidate Rule: When the exclusion rule is met, the item/zone will not be
brought into the worksheet for review

External Prices Allowed: When selected, RPM will accept pricing events created in other
systems.

Inclusion Candidate Rule: When the inclusion rule is met, the item is flagged by the
system in the worksheet for a pricing review

Item: The merchandise received from a supplier. In the system, the item field or column
will display the item number, the item description, or both.

Item Level: The level of an item in an item group.

L

Link Code: Link codes are used to associate items to each other at a location and price
them exactly the same.

Location: The store or warehouse involved in an event. In the system, the location field
or column will display the location number, the location description, or both.

Location Move Lead Time: The number of days, set in system options, required before a
location can be moved between zones in RPM.

Location Move Purge Days: The number of days RPM will retain location moves that
have either successfully completed or are the same number of days past the scheduled
effective date but have had no action taken on them.

Location Price Exception: When selected in system options, exceptions should populate
the Zone Location Retail Exception container for items where the current retail at a given
location is not equal to the current retail for the zone.

M

Market Basket Code: A market basket code is a mechanism for grouping items within a
hierarchy level in order to apply similar pricing rules.

Markup: An amount added to the cost price to determine the selling price.

Multiple Item/Location Promotions: When selected in system options, an item/location
can exist on more than one promotion (and more than one component within the
promotion).

o)

Open Zone Use: When selected in system options, indicates a zone can be used across
different types of pricing, regardless of zone type.

Out of Stock Date: The date when the inventory is expected to be exhausted.
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P

Partner: A person or entity that has an association with your organization in various
areas of the procurement process. Partners can include those involved in transporting
goods, escheatment, providing credit, and providing services. A partner does not
provide items to a retailer.

Price Change: The permanent change in the price of an item.

Price Change Diff Type: A default indicator to define the diff type that will be displayed
when the user enters the price change and clearance dialogs. This default will only be
applied in the price change/clearance dialogs when the Item level default is set to Parent
/ Diff Type.

Price Change Item Level: Indicates the item level that is displayed when the user enters
the price change and clearance dialogs.

Price Change Processing Days: The number of days, set in system options, between the
creation date of a price change and the first date it can become effective. It allows the
retailer to insure that price changes are created with enough advance timing that stores
and other process areas can react.

Price Change Type: On System Defaults, indicates the price change type that will be
displayed when the user enters the price change and clearance dialogs. The options for
the drop down list are:

Price Change/Promotions Overlap: When selected in system options, indicates an
item/location can have a price change occur during the middle of an active promotion.

Price Guide: A price guide allows you to create a uniform price strategy. You can use
them to maintain a consistent price points. You can determine if the prices in a guide
should be rounded in the same manner or if they should all end in the same digits.

Pricing Strategy: A pricing strategy allows you to decide how item retails will be
proposed when pricing worksheets are generated.

Primary Zone Group: The primary zone group is used to determine:how to items are
initially priced in the merchandising system. which zone structure to store regular zone
retails against when creating price changes. When you create a primary zone group, you
identify the merchandise hierarchy level, the zone group, the markup percent, the
markup type, and the price guide. The merchandise hierarchy assigned to a new item in
merchandising system will determine the primary zone group definition in RPM used to
initially price the item. Based on the information associated with the primary zone group
and the cost of the item, as entered in merchandising system, prices will be proposed.

Promotion: A promotion is a temporary reduction in price. In addition, you can track
sales at one or more locations for a given time period as well as track the sales of
merchandise with no price reductions, at given locations for a set time period.

Promotion # Days Rejects Held: The number of days, set in system options, after the end
date (or start date for promotions with no end date) of a rejected promotion that it is
purged from the system.

Promotion Constraint: A warning will appear if a price change or promotion is created
that would fall a certain number of days before or during another approved promotion
or price change. The number of days before the promotion is the promotion constraint.
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Promotion History Months: The number of months, set in system options, after a
promotion is completed that is purged. This parameter is also used to purge cancelled
promotions.

R

Reason code: The resolution or reason that is applied to an event that occurs within a
system.

Rule Variable: The portion of the candidate rule conditions that allows a rule value to
vary at the department level

S

Sales Calculation Method: The method used by the merchandise extract program to
populate the Projected Sales column in the worksheet.

Simple Component: A component for which the items at specific locations are promoted
at a percent off, amount off, or fixed price.

Start Date: The first day an element is effective in the system.

T

Threshold Component: A component for which the items at specific locations are
promoted by achieving a specific purchasing level.

Z

Zone: A zone is a group of locations that are priced the same within a zone group.
Locations within a zone must have the same currency. Not all locations must be assigned
to a zone.

Zone Group: Zone groups are a collection of zones. You can define multiple zone groups
that are suited to your business. After you define the zone group, you can define the
zones in the zone group. Multiple currencies may exist within a zone group.

Zone Parent Ranging: When selected, RPM should perform ranging checks for price
changes, promotions, and clearances that are created at a higher level than
transaction/location. If the indicator is set to yes, the system will not let you create a
price change at the parent or zone level if none of the transaction item/location
combinations are ranged. If the indicator is set to no, the system will let you create a price
change at the parent or zone level even if none of the transaction item/location
combinations are ranged.
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